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1 Getting Started

Fuzzy Logic Toolbox Product Description

Design and simulate fuzzy logic systems

Fuzzy Logic Toolbox provides MATLAB® functions, apps, and a Simulink® block for analyzing,
designing, and simulating systems based on fuzzy logic. The product guides you through the steps of
designing fuzzy inference systems. Functions are provided for many common methods, including
fuzzy clustering and adaptive neurofuzzy learning.

The toolbox lets you model complex system behaviors using simple logic rules, and then implement
these rules in a fuzzy inference system. You can use it as a stand-alone fuzzy inference engine.
Alternatively, you can use fuzzy inference blocks in Simulink and simulate the fuzzy systems within a
comprehensive model of the entire dynamic system.

Key Features

* Fuzzy Logic Design app for building fuzzy inference systems and viewing and analyzing results
* Membership functions for creating fuzzy inference systems

* Support for AND, OR, and NOT logic in user-defined rules

* Standard Mamdani and Sugeno-type fuzzy inference systems

* Automated membership function shaping through neuroadaptive and fuzzy clustering learning
techniques

» Ability to embed a fuzzy inference system in a Simulink model
* Ability to generate embeddable C code or stand-alone executable fuzzy inference engines

1-2



What Is Fuzzy Logic?

What Is Fuzzy Logic?

Description of Fuzzy Logic

In recent years, the number and variety of applications of fuzzy logic have increased significantly. The
applications range from consumer products such as cameras, camcorders, washing machines, and
microwave ovens to industrial process control, medical instrumentation, decision-support systems,
and portfolio selection.

To understand why use of fuzzy logic has grown, you must first understand what is meant by fuzzy
logic.

Fuzzy logic has two different meanings. In a narrow sense, fuzzy logic is a logical system, which is an
extension of multivalued logic. However, in a wider sense fuzzy logic (FL) is almost synonymous with
the theory of fuzzy sets, a theory which relates to classes of objects with unsharp boundaries in which
membership is a matter of degree. In this perspective, fuzzy logic in its narrow sense is a branch of
FL. Even in its more narrow definition, fuzzy logic differs both in concept and substance from
traditional multivalued logical systems.

In Fuzzy Logic Toolbox software, fuzzy logic should be interpreted as FL, that is, fuzzy logic in its
wide sense. The basic ideas underlying FL are explained in “Foundations of Fuzzy Logic” on page 1-
7. What might be added is that the basic concept underlying FL is that of a linguistic variable, that
is, a variable whose values are words rather than numbers. In effect, much of FL may be viewed as a
methodology for computing with words rather than numbers. Although words are inherently less
precise than numbers, their use is closer to human intuition. Furthermore, computing with words
exploits the tolerance for imprecision and thereby lowers the cost of solution.

Another basic concept in FL, which plays a central role in most of its applications, is that of a fuzzy if-
then rule or, simply, fuzzy rule. Although rule-based systems have a long history of use in Artificial
Intelligence (AI), what is missing in such systems is a mechanism for dealing with fuzzy consequents
and fuzzy antecedents. In fuzzy logic, this mechanism is provided by the calculus of fuzzy rules. The
calculus of fuzzy rules serves as a basis for what might be called the Fuzzy Dependency and
Command Language (FDCL). Although FDCL is not used explicitly in the toolbox, it is effectively one
of its principal constituents. In most of the applications of fuzzy logic, a fuzzy logic solution is, in
reality, a translation of a human solution into FDCL.

A trend that is growing in visibility relates to the use of fuzzy logic in combination with
neurocomputing and genetic algorithms. More generally, fuzzy logic, neurocomputing, and genetic
algorithms may be viewed as the principal constituents of what might be called soft computing.
Unlike the traditional, hard computing, soft computing accommodates the imprecision of the real
world. The guiding principle of soft computing is: Exploit the tolerance for imprecision, uncertainty,
and partial truth to achieve tractability, robustness, and low solution cost. In the future, soft
computing could play an increasingly important role in the conception and design of systems whose
MIQ (Machine IQ) is much higher than that of systems designed by conventional methods.

Among various combinations of methodologies in soft computing, the one that has highest visibility at
this juncture is that of fuzzy logic and neurocomputing, leading to neuro-fuzzy systems. Within fuzzy
logic, such systems play a particularly important role in the induction of rules from observations. An
effective method developed by Dr. Roger Jang for this purpose is called ANFIS (Adaptive Neuro-Fuzzy
Inference System). This method is an important component of the toolbox.
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Fuzzy logic approximates human reasoning and does a good job of balancing the tradeoff between
precision and significance. For instance, when warning someone of an object falling toward them,
being precise about the exact mass and speed is not necessary.

Precision and Significance in the Real World I

A 1500 kg mass ‘ ‘
is approaching
your head at
453 m's
g

Precision Significance

Fuzzy logic is a convenient way to map an input space to an output space. Mapping input to output is
the starting point for everything. Consider the following examples:

* With information about how good your service was at a restaurant, a fuzzy logic system can tell
you what the tip should be.

* With your specification of how hot you want the water, a fuzzy logic system can adjust the faucet
valve to the right setting.

» With information about how far away the subject of your photograph is, a fuzzy logic system can
focus the lens for you.

* With information about how fast the car is going and how hard the motor is working, a fuzzy logic
system can shift gears for you.

A fuzzy system behaves like a black box that maps an input space to an output space. For example,
you can map the input space of all possible restaurant service ratings to all possible tip values.

Input Space Output Space
tal!:lmf:rt:f:t ;n:r:}ne (all possible tips)

Black
tonight's servca Box

quality

the "right" tip
for tonight

An inputfoutput map for the tipping problem:
“Given the quality of service, how much should | tip?”



What Is Fuzzy Logic?

Determining the appropriate amount of tip requires mapping inputs to the appropriate outputs.
Between the input and the output, the preceding figure shows a black box that can contain any
number of things: fuzzy systems, linear systems, expert systems, neural networks, differential
equations, interpolated multidimensional lookup tables, or even a spiritual advisor, just to name a few
of the possible options. Clearly the list could go on and on.

Of the dozens of ways to make the black box work, it turns out that fuzzy is often the very best way.
Why should that be? As Lotfi Zadeh, who is considered to be the father of fuzzy logic, once remarked:
"In almost every case you can build the same product without fuzzy logic, but fuzzy is faster and
cheaper."

Why Use Fuzzy Logic?
Here is a list of general observations about fuzzy logic:
* Fuzzy logic is conceptually easy to understand.

The mathematical concepts behind fuzzy reasoning are very simple. Fuzzy logic is a more intuitive
approach without the far-reaching complexity.

» Fuzzy logic is flexible.

With any given system, it is easy to layer on more functionality without starting again from
scratch.

» Fuzzy logic is tolerant of imprecise data.

Everything is imprecise if you look closely enough, but more than that, most things are imprecise
even on careful inspection. Fuzzy reasoning builds this understanding into the process rather than
tacking it onto the end.

» Fuzzy logic can model nonlinear functions of arbitrary complexity.

You can create a fuzzy system to match any set of input-output data. This process is made
particularly easy by adaptive techniques like Adaptive Neuro-Fuzzy Inference Systems (ANFIS),
which are available in Fuzzy Logic Toolbox software.

» Fuzzy logic can be built on top of the experience of experts.

In direct contrast to neural networks, which take training data and generate opaque, impenetrable
models, fuzzy logic lets you rely on the experience of people who already understand your system.

» Fuzzy logic can be blended with conventional control techniques.

Fuzzy systems don't necessarily replace conventional control methods. In many cases fuzzy
systems augment them and simplify their implementation.

* Fuzzy logic is based on natural language.

The basis for fuzzy logic is the basis for human communication. This observation underpins many
of the other statements about fuzzy logic. Because fuzzy logic is built on the structures of
qualitative description used in everyday language, fuzzy logic is easy to use.

The last statement is perhaps the most important one and deserves more discussion. Natural
language, which is used by ordinary people on a daily basis, has been shaped by thousands of years of
human history to be convenient and efficient. Sentences written in ordinary language represent a
triumph of efficient communication.

1-5



1 Getting Started

1-6

When Not to Use Fuzzy Logic

Fuzzy logic is not a cure-all. When should you not use fuzzy logic? The safest statement is the first
one made in this introduction: fuzzy logic is a convenient way to map an input space to an output
space. If you find it's not convenient, try something else. If a simpler solution already exists, use it.
Fuzzy logic is the codification of common sense — use common sense when you implement it and you
will probably make the right decision. Many controllers, for example, do a fine job without using fuzzy
logic. However, if you take the time to become familiar with fuzzy logic, you'll see it can be a very
powerful tool for dealing quickly and efficiently with imprecision and nonlinearity.

What Can Fuzzy Logic Toolbox Software Do?

Using Fuzzy Logic Toolbox software, you can:

* Create and edit fuzzy inference systems using command-line functions or the Fuzzy Logic
Designer app.

* Automatically generate fuzzy systems using clustering or adaptive neuro-fuzzy techniques.

» Automatically tune the parameters of a fuzzy logic system using optimization methods such as
genetic algorithms and particle swarm optimization. For more information, see “Tuning Fuzzy
Inference Systems” on page 3-2.

* Simulate your fuzzy system within a Simulink model using the Fuzzy Logic Controller block.

* Automatically generate code for evaluating fuzzy inference systems. For more information, see
“Deploy Fuzzy Inference Systems” on page 6-2.

See Also

More About

. “Foundations of Fuzzy Logic” on page 1-7
. “Fuzzy vs. Nonfuzzy Logic” on page 1-33
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Foundations of Fuzzy Logic

Overview

The point of fuzzy logic is to map an input space to an output space, and the primary mechanism for
doing this is a list of if-then statements called rules. All rules are evaluated in parallel, and the order
of the rules is unimportant. The rules themselves are useful because they refer to variables and the
adjectives that describe those variables. Before you can build a system that interprets rules, you must
define all the terms you plan on using and the adjectives that describe them. To say that the water is
hot, you need to define the range within which the water temperature can be expected to vary as well
as what you mean by the word hot.

In general, fuzzy inference is a method that interprets the values in the input vector and, based on
some set of rules, assigns values to the output vector.

This topic guides you through the fuzzy logic process step-by-step by providing an introduction to the
theory and practice of fuzzy logic.

Fuzzy Sets

Fuzzy logic starts with the concept of a fuzzy set. A fuzzy set is a set without a crisp, clearly defined
boundary. It can contain elements with only a partial degree of membership.

To understand what a fuzzy set is, first consider the definition of a classical set. A classical set is a
container that wholly includes or wholly excludes any given element. For example, the set of days of
the week unquestionably includes Monday, Thursday, and Saturday. It just as unquestionably excludes
butter, liberty, and dorsal fins, and so on.

Shoe .
Polish Monday Liberty
Thursday
Saturday Dorsal
Butter Fins

Days of the week

This type of set is called a classical set because it has been around for a long time. It was Aristotle
who first formulated the Law of the Excluded Middle, which says X must either be in set A or in set
not-A. Another version of this law is:

Of any subject, one thing must be either asserted or denied.

To restate this law with annotations: "Of any subject (say Monday), one thing (a day of the week)
must be either asserted or denied (I assert that Monday is a day of the week)." This law demands that
opposites, the two categories A and not-A, should between them contain the entire universe.
Everything falls into either one group or the other. There is no thing that is both a day of the week
and not a day of the week.

Now, consider the set of days comprising a weekend. The following diagram attempts to classify the
weekend days.

Most would agree that Saturday and Sunday belong in the weekend set, but what about Friday? It
feels like a part of the weekend, but somehow it seems like it should be technically excluded.
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Therefore, Friday "straddles the fence." Classical sets do not tolerate this kind of classification. Either
something is in a set or it is out of a set. Human experience suggests something different, however,
straddling the fence is part of life.

Shoe Liberty
Polish
Eteilliclzly Friday Thursday
Monday
Sunday
Dorsal
Butter Fins

Days of the weekend

Of course, individual perceptions and cultural background must be taken into account when you
define what constitutes the weekend. Even the dictionary is imprecise, defining the weekend as the
period from Friday night or Saturday to Monday morning. You are entering the realm where sharp-
edged, yes-no logic stops being helpful. Fuzzy reasoning becomes valuable exactly when you work
with how people really perceive the concept weekend as opposed to a simple-minded classification
useful for accounting purposes only. More than anything else, the following statement lays the
foundations for fuzzy logic.

In fuzzy logic, the truth of any statement becomes a matter of degree.

Any statement can be fuzzy. The major advantage that fuzzy reasoning offers is the ability to reply to
a yes-no question with a not-quite-yes-or-no answer. Humans do this kind of thing all the time (think
how rarely you get a straight answer to a seemingly simple question), but it is a rather new trick for
computers.

How does it work? Reasoning in fuzzy logic is just a matter of generalizing the familiar yes-no
(Boolean) logic. If you give true the numerical value of 1 and false the numerical value of 0, this value
indicates that fuzzy logic also permits in-between values like 0.2 and 0.7453. For instance:

Q: Is Saturday a weekend day?

A: 1 (yes, or true)

Q: Is Tuesday a weekend day?

A: 0 (no, or false)

Q: Is Friday a weekend day?

A: 0.8 (for the most part yes, but not completely)
Q: Is Sunday a weekend day?

A: 0.95 (yes, but not quite as much as Saturday).

The plot on the left shows the truth values for weekend-ness if you are forced to respond with an
absolute yes or no response. On the right is a plot that shows the truth value for weekend-ness if you
are allowed to respond with fuzzy in-between values.

s
o
-
=

weekend-ness
weekend-ness

Thursday Friday Saturday  Sunday  Monday Thursday  Friday Saturday Sunday  Monday

ﬂ
u
I

Days of the weekend two-valued membership Days of the weskand multivalued membership
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Technically, the representation on the right is from the domain of multivalued logic (or multivalent
logic). If you ask the question "Is X a member of set A?" the answer might be yes, no, or any one of a
thousand intermediate values in between. Thus, X might have partial membership in A. Multivalued
logic stands in direct contrast to the more familiar concept of two-valued (or bivalent yes-no) logic.

To return to the example, now consider a continuous scale time plot of weekend-ness shown in the
following plots.

waakand-nass

=
=

Thursday Friday Saturday Sunday Manday Thursday Friday Saturday Sunday Manday

Days of the weskend twa-valued mambarship Days of the weskand multivalued meambarship

By making the plot continuous, you are defining the degree to which any given instant belongs in the
weekend rather than an entire day. In the plot on the left, notice that at midnight on Friday, just as
the second hand sweeps past 12, the weekend-ness truth value jumps discontinuously from 0 to 1.
This is one way to define the weekend, and while it may be useful to an accountant, it may not really
connect with your own real-world experience of weekend-ness.

The plot on the right shows a smoothly varying curve that accounts for the fact that all of Friday, and,
to a small degree, parts of Thursday, partake of the quality of weekend-ness and thus deserve partial
membership in the fuzzy set of weekend moments. The curve that defines the weekend-ness of any
instant in time is a function that maps the input space (time of the week) to the output space
(weekend-ness). Specifically, it is known as a membership function. See “Membership Functions” on
page 1-9 for a more detailed discussion.

As another example of fuzzy sets, consider the question of seasons. What season is it right now? In
the northern hemisphere, summer officially begins at the exact moment in the earth's orbit when the
North Pole is pointed most directly toward the sun. It occurs exactly once a year, in late June. Using
the astronomical definitions for the season, you get sharp boundaries as shown on the left in the
figure that follows. But what you experience as the seasons vary more or less continuously as shown
on the right in the following figure (in temperate northern hemisphere climates).

10 Spri summer fall winter 10 spring summer fall winter
degree degree
of of
member- member-
ship ship
0.0 0.0

Mareh June Saptember Decamber  March Mareh June September Dacambar  March
Time of the Time of the
year year

Membership Functions
A membership function (MF) is a curve that defines how each point in the input space is mapped to a

membership value (or degree of membership) between 0 and 1. The input space is sometimes
referred to as the universe of discourse, a fancy name for a simple concept.
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One of the most commonly used examples of a fuzzy set is the set of tall people. In this case, the
universe of discourse is all potential heights, say from three feet to nine feet, and the word tall would
correspond to a curve that defines the degree to which any person is tall. If the set of tall people is
given the well-defined (crisp) boundary of a classical set, you might say all people taller than six feet
are officially considered tall. However, such a distinction is clearly absurd. It may make sense to
consider the set of all real numbers greater than six because numbers belong on an abstract plane,
but when we want to talk about real people, it is unreasonable to call one person short and another
one tall when they differ in height by the width of a hair.

excellent!
.

You must be
taller than
this line to
be
considered
TALL

If the kind of distinction shown previously is unworkable, then what is the right way to define the set
of tall people? Much as with the plot of weekend days, the figure following shows a smoothly varying
curve that passes from not-tall to tall. The output-axis is a number known as the membership value
between 0 and 1. The curve is known as a membership function and is often given the designation of
u. For example, the following figure shows both crisp and smooth tall membership functions. In the
top plot, the two people are classified as either entirely tall or entirely not-tall. In the bottom plot, the
smooth transition allows for different degrees of tallness. Both people are tall to some degree, but
one is significantly less tall than the other. The taller person, with a tallness membership of 0.95 is
definitely a tall person, but the person with a tallness membership of 0.3 is not very tall.

10 p———— | tall (u=1.0
sharp-edged C )
membership
degree of function for
membership, p TALL
0.0 | not tall (i1 = 0.0)
height
* .
1.0 - definitely a tall
continuous
membership person (= 0.95)
degree of function for
membership, g TALL
really not very
tall at all (= 0.30)
0.0

height

b

Subjective interpretations and appropriate units are built right into fuzzy sets. If you say "She's tall,"
the membership function tall should already take into account whether you are referring to a six-year-
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old or a grown woman. Similarly, the units are included in the curve. Certainly it makes no sense to
say "Is she tall in inches or in meters?"

Membership Functions in Fuzzy Logic Toolbox Software

The only condition a membership function must really satisfy is that it must vary between 0 and 1.
The function itself can be an arbitrary curve whose shape we can define as a function that suits us
from the point of view of simplicity, convenience, speed, and efficiency.

A classical set might be expressed as
A={x|x>6}

A fuzzy set is an extension of a classical set. If X is the universe of discourse and its elements are
denoted by x, then a fuzzy set A in X is defined as a set of ordered pairs.

A{x, pa(¥) |x € X}
A= {x, ,u(¥) | x €X}

Ua(x) is called the membership function (or MF) of x in A. The membership function maps each
element of X to a membership value between 0 and 1.

The toolbox includes 11 built-in membership function types. These 11 functions are, in turn, built
from several basic functions:

* Piece-wise linear functions

* Gaussian distribution function

* Sigmoid curve

* Quadratic and cubic polynomial curves

For detailed information on any of the membership functions mentioned next, see the corresponding
reference page.

The simplest membership functions are formed using straight lines. Of these, the simplest is the
triangular membership function, and it has the function name trimf. This function is nothing more
than a collection of three points forming a triangle. The trapezoidal membership function, trapmf,
has a flat top and really is just a truncated triangle curve. These straight line membership functions
have the advantage of simplicity.

1 1
ava 075
a5 a5
025 025

a a

a 2 4 [ a 10 a 2 4 & a U]

simi, P = [3 68] tmapmi, P =157 a]
trimf trapmf

Two membership functions are built on the Gaussian distribution curve: a simple Gaussian curve and
a two-sided composite of two different Gaussian curves. The two functions are gaussmf and
gauss2mf.
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The generalized bell membership function is specified by three parameters and has the function name
gbellmf. The bell membership function has one more parameter than the Gaussian membership
function, so it can approach a non-fuzzy set if the free parameter is tuned. Because of their
smoothness and concise notation, Gaussian and bell membership functions are popular methods for
specifying fuzzy sets. Both of these curves have the advantage of being smooth and nonzero at all
points.

o 2 Ed i o 2 10 o 2

4 [ 4 & 4 [}
PP =[25 S SETE Fe[133 4] pbclt, F = [2 4]

gaussmf gauss2mf gbellmf

Although the Gaussian membership functions and bell membership functions achieve smoothness,
they are unable to specify asymmetric membership functions, which are important in certain
applications. Next, you define the sigmoidal membership function, which is either open left or right.
Asymmetric and closed (i.e. not open to the left or right) membership functions can be synthesized
using two sigmoidal functions, so in addition to the basic sigmf, you also have the difference
between two sigmoidal functions, dsigmf, and the product of two sigmoidal functions psigmf.

1 1 1
ans| o.7s) om
(13 (=3 as|

0% 025 o=

o o Q
o 2 4 -] & 0 o z a4 E
SamLP =[24] Eigel. P =525 7]

E o o ES E =)

4 &
rEomLP=[22-58]

sigmf dsigmf psigmf

Polynomial based curves account for several of the membership functions in the toolbox. Three
related membership functions are the Z, S, andPi curves, all named because of their shape. The
function zmf is the asymmetrical polynomial curve open to the left, smf is the mirror-image function
that opens to the right, and pimf is zero on both extremes with a rise in the middle.

i

om o7 a7
oS oS os

[} =3 [e}-]

o o ]
g 10 -] 2

-3 10 o 2

4 & 4 &
Cml P=M1 4510 selP=[18]

zmf pimf smf

There is a very wide selection to choose from when you're selecting a membership function. You can
also create your own membership functions with the toolbox. However, if a list based on expanded
membership functions seems too complicated, just remember that you could probably get along very
well with just one or two types of membership functions, for example the triangle and trapezoid
functions. The selection is wide for those who want to explore the possibilities, but expansive
membership functions are not necessary for good fuzzy inference systems. Finally, remember that
more details are available on all these functions in the reference section.
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Summary of Membership Functions

» Fuzzy sets describe vague concepts (for example, fast runner, hot weather, weekend days).

* A fuzzy set admits the possibility of partial membership in it. (for example, Friday is sort of a
weekend day, the weather is rather hot).

* The degree an object belongs to a fuzzy set is denoted by a membership value between 0 and 1
(for example, Friday is a weekend day to the degree 0.8).

* A membership function associated with a given fuzzy set maps an input value to its appropriate
membership value.

Logical Operations

Now that you understand the fuzzy inference, you need to see how fuzzy inference connects with
logical operations.

The most important thing to realize about fuzzy logical reasoning is the fact that it is a superset of
standard Boolean logic. In other words, if you keep the fuzzy values at their extremes of 1 (completely
true), and 0 (completely false), standard logical operations will hold. As an example, consider the
following standard truth tables.

AorB not A

o =

- - Do >
- 0 = 0 g
- - 0 o0 >
- O = O m
- -

AND OR NOT

Considering that, in fuzzy logic, the truth of any statement is a matter of degree, can these truth
tables be altered? The input values can be real numbers between 0 and 1. What function preserves
the results of the AND truth table (for example) and also extend to all real numbers between 0 and 1?

One answer is the min operation. That is, resolve the statement A AND B, where A and B are limited
to the range (0,1), by using the function min(A,B). Using the same reasoning, you can replace the OR
operation with the max function, so that A OR B becomes equivalent to max(A,B). Finally, the
operation NOT A becomes equivalent to the operation 1 — A. The previous truth table is completely
unchanged by this substitution.

A B min(A,B) A B max(A,B) A 1-A
0 0 0 0 0 0 1
0 1 0 0 1 1 0
1 0 0 1 0 1
1 1 1 1 1 1

AND OR NOT

Moreover, because there is a function behind the truth table rather than just the truth table itself, you
can now consider values other than 1 and 0.
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The next figure uses a graph to show the same information. In this figure, the truth table is converted
to a plot of two fuzzy sets applied together to create one fuzzy set. The upper part of the figure
displays plots corresponding to the preceding two-valued truth tables, while the lower part of the
figure displays how the operations work over a continuously varying range of truth values A and B
according to the fuzzy operations you have defined.

A A A
Two-valued 8 B —
logic
AorB
A and B not A
N N /
Multivalued
|DgiC Aor B
t A
. B/\ M \
AND OR NOT
min(A,B) max(A,B) (1-A)

Given these three functions, you can resolve any construction using fuzzy sets and the fuzzy logical
operation AND, OR, and NOT.

Additional Fuzzy Operators

In this case, you defined only one particular correspondence between two-valued and multivalued
logical operations for AND, OR, and NOT. This correspondence is by no means unique.

In more general terms, you are defining what are known as the fuzzy intersection or conjunction
(AND), fuzzy union or disjunction (OR), and fuzzy complement (NOT). The classical operators for
these functions are: AND = min, OR = max, and NOT = additive complement. Typically, most fuzzy
logic applications make use of these operations and leave it at that. In general, however, these
functions are arbitrary to a surprising degree. Fuzzy Logic Toolbox software uses the classical
operator for the fuzzy complement as shown in the previous figure, but also enables you to customize
the AND and OR operators.

The intersection of two fuzzy sets A and B is specified in general by a binary mapping T, which
aggregates two membership functions as follows:

Ha n B(X) = T(pa(x), up(x))
For example, the binary operator T may represent the multiplication of u,(x) and pg(x). These fuzzy
intersection operators, which are usually referred to as T-norm (Triangular norm) operators, meet the

following basic requirements:

A T-norm operator is a binary mapping T(.,.) with the following properties:

* Boundary — T(0,0) =0, T(q,1) =T(1,a) = a

1-14
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* Monotonicity — T(a,b) < T(c,d)ifa<cand b =d

* Commutativity — T(a, b) = T(b, a)

* Associativity — T(a, T(b, ¢)) = T(T(a, b), ¢)

The first requirement imposes the correct generalization to crisp sets. The second requirement
implies that a decrease in the membership values in A or B cannot produce an increase in the
membership value in A intersection B. The third requirement indicates that the operator is indifferent

to the order of the fuzzy sets to be combined. Finally, the fourth requirement allows us to take the
intersection of any number of sets in any order of pair-wise groupings.

Like fuzzy intersection, the fuzzy union operator is specified in general by a binary mapping S:
Ha v B(X) = S(na(x), up(x))

For example, the binary operator S can represent the addition of u,(x) and pup(x). These fuzzy union
operators, which are often referred to as T-conorm (or S-norm) operators, must satisfy the following
basic requirements:

A T-conorm (or S-norm) operator is a binary mapping S(.,.) with the following properties:

* Boundary — S(1,1) =1, S(a,0) = 5(0,a) = a

* Monotonicity — S(a,b) = S(c,d)ifa<cand b =d

* Commutativity — S(a, b) = S(b, a)

* Associativity — S(a, S(b, ¢)) = S(S(a, b), ¢)

Several parameterized T-norms and dual T-conorms have been proposed in the past, such as those of

Yager [10], Dubois and Prade [1], Schweizer and Sklar [7], and Sugeno [8]. Each of these provides a
way to vary the gain on the function so that it can be very restrictive or very permissive.

If-Then Rules

Fuzzy sets and fuzzy operators are the subjects and verbs of fuzzy logic. These if-then rule statements
are used to formulate the conditional statements that comprise fuzzy logic.

A single fuzzy if-then rule assumes the form
IfxisA, thenyis B

where A and B are linguistic values defined by fuzzy sets on the ranges (universes of discourse) X and
Y, respectively. The if-part of the rule "x is A" is called the antecedent or premise, while the then-part
of the rule "y is B" is called the consequent or conclusion. An example of such a rule might be

If service is good then tip is average

The concept good is represented as a number between 0 and 1, and so the antecedent is an
interpretation that returns a single number between 0 and 1. Conversely, average is represented as a
fuzzy set, and so the consequent is an assignment that assigns the entire fuzzy set B to the output
variable y. In the if-then rule, the word is gets used in two entirely different ways depending on
whether it appears in the antecedent or the consequent. In MATLAB terms, this usage is the
distinction between a relational test using "==" and a variable assignment using the "=" symbol. A
less confusing way of writing the rule would be

If service == good, then tip = average

1-15
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In general, the input to an if-then rule is the current value for the input variable (in this case, service)
and the output is an entire fuzzy set (in this case, average). This set will later be defuzzified,
assigning one value to the output. The concept of defuzzification is described in the next section.

Interpreting an if-then rule involves two steps:

» Evaluation of the antecedent — Fuzzifying the inputs and applying any necessary fuzzy operators.
* Application of the result to the consequent.

The second step is known as implication. For an if-then rule, the antecedent, p, implies the
consequent, ¢q. In binary logic, if p is true, then q is also true (p = q). In fuzzy logic, if p is true to
some degree of membership, then q is also true to the same degree (0.5p = 0.5¢q). In both cases, if p
is false, then the value of g is undetermined.

The antecedent of a rule can have multiple parts.
If sky is gray and wind is strong and barometer is falling, then ...

In this case all parts of the antecedent are calculated simultaneously and resolved to a single number
using the logical operators described in the preceding section. The consequent of a rule can also have
multiple parts.

If temperature is cold, then hot water valve is open and cold water valve is shut

In this case, all consequents are affected equally by the result of the antecedent. How is the
consequent affected by the antecedent? The consequent specifies a fuzzy set be assigned to the
output. The implication function then modifies that fuzzy set to the degree specified by the
antecedent. The most common ways to modify the output fuzzy set are truncation using the min
function (where the fuzzy set is truncated as shown in the following figure) or scaling using the prod
function (where the output fuzzy set is squashed). Both are supported by the toolbox, but you use
truncation for the examples in this section.
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If serviceis excellent or  food is delicious then tip = generous
excellent delicious
opute g= —‘:]
P food (crisp)
H(service==excellent) = 0 .0 H(food==delicious) = 0 .7

If ( 00 or then tip = generous
2. Apply
OR operator '
(max)

max(0.0, 0.7) = 0.7

If ( 0.7 ) then tip = generous
3. Apply |
implication o o
operator (min) generous |

min(0.7, generous)

Antecedent Consequent

e e, | e e

Summary of If-Then Rules

Interpreting if-then rules is a three-part process. This process is explained in detail in the next
section:

1

Fuzzify inputs: Resolve all fuzzy statements in the antecedent to a degree of membership
between 0 and 1. If there is only one part to the antecedent, then this is the degree of support for
the rule.

Apply fuzzy operator to multiple part antecedents: If there are multiple parts to the
antecedent, apply fuzzy logic operators and resolve the antecedent to a single number between 0
and 1. This is the degree of support for the rule.

Apply implication method: Use the degree of support for the entire rule to shape the output
fuzzy set. The consequent of a fuzzy rule assigns an entire fuzzy set to the output. This fuzzy set
is represented by a membership function that is chosen to indicate the qualities of the
consequent. If the antecedent is only partially true, (i.e., is assigned a value less than 1), then the
output fuzzy set is truncated according to the implication method.

In general, one rule alone is not effective. Two or more rules that can play off one another are
needed. The output of each rule is a fuzzy set. The output fuzzy sets for each rule are then
aggregated into a single output fuzzy set. Finally the resulting set is defuzzified, or resolved to a
single number. “Build Fuzzy Systems Using Fuzzy Logic Designer” on page 2-14 shows how the
whole process works from beginning to end for a particular type of fuzzy inference system called a
Mamdani type.

1-17



1 Getting Started

1-18

References

[1] Dubois, D. and H. Prade, Fuzzy Sets and Systems: Theory and Applications, Academic Press, New
York, 1980.

[2] Kaufmann, A. and M.M. Gupta, Introduction to Fuzzy Arithmetic, V.N. Reinhold, 1985.

[3] Lee, C.-C., "Fuzzy logic in control systems: fuzzy logic controller-parts 1 and 2," IEEE Transactions
on Systems, Man, and Cybernetics, Vol. 20, No. 2, pp 404-435, 1990.

[4] Mamdani, E.H. and S. Assilian, "An experiment in linguistic synthesis with a fuzzy logic
controller," International Journal of Man-Machine Studies, Vol. 7, No. 1, pp. 1-13, 1975.

[5] Mamdani, E.H., "Advances in the linguistic synthesis of fuzzy controllers," International Journal of
Man-Machine Studies, Vol. 8, pp. 669-678, 1976.

[6] Mamdani, E.H., "Applications of fuzzy logic to approximate reasoning using linguistic synthesis,"
IEEE Transactions on Computers, Vol. 26, No. 12, pp. 1182-1191, 1977.

[7] Schweizer, B. and A. Sklar, "Associative functions and abstract semi-groups," Publ. Math
Debrecen, 10:69-81, 1963.

[8] Sugeno, M., "Fuzzy measures and fuzzy integrals: a survey," (M.M. Gupta, G. N. Saridis, and B.R.
Gaines, editors) Fuzzy Automata and Decision Processes, pp. 89-102, North-Holland, NY,
1977.

[9] Sugeno, M., Industrial applications of fuzzy control, Elsevier Science Pub. Co., 1985.
[10] Yager, R., "On a general class of fuzzy connectives," Fuzzy Sets and Systems, 4:235-242, 1980.

[11] Yager, R. and D. Filev, "Generation of Fuzzy Rules by Mountain Clustering," Journal of Intelligent
& Fuzzy Systems, Vol. 2, No. 3, pp. 209-219, 1994.

[12] Zadeh, L.A., "Fuzzy sets," Information and Control, Vol. 8, pp. 338-353, 1965.

[13] Zadeh, L.A., "Outline of a new approach to the analysis of complex systems and decision
processes," IEEE Transactions on Systems, Man, and Cybernetics, Vol. 3, No. 1, pp. 28-44,
Jan. 1973.

[14] Zadeh, L.A., "The concept of a linguistic variable and its application to approximate reasoning,
Parts 1, 2, and 3," Information Sciences, 1975, 8:199-249, 8:301-357, 9:43-80.

[15] Zadeh, L.A., "Fuzzy Logic," Computer, Vol. 1, No. 4, pp. 83-93, 1988.

[16] Zadeh, L.A., "Knowledge representation in fuzzy logic," IEEE Transactions on Knowledge and
Data Engineering, Vol. 1, pp. 89-100, 1989.

See Also

More About
. “What Is Fuzzy Logic?” on page 1-3
. “Fuzzy Inference Process” on page 1-20



Foundations of Fuzzy Logic

“Fuzzy vs. Nonfuzzy Logic” on page 1-33

1-19



1 Getting Started

Fuzzy Inference Process

1-20

Fuzzy inference is the process of formulating the mapping from a given input to an output using fuzzy
logic. The mapping then provides a basis from which decisions can be made, or patterns discerned.
The process of fuzzy inference involves all the pieces that are described in “Membership Functions”
on page 1-9, “Logical Operations” on page 1-13, and “If-Then Rules” on page 1-15.

This section describes the fuzzy inference process and uses the example of the two-input, one-output,
three-rule tipping problem from “The Basic Tipping Problem” on page 2-16. The fuzzy inference
system for this problem takes service and food quality as inputs and computes a tip percentage using
the following rules.

1 [f the service is poor or the food is rancid, then tip is cheap.

2 If the service is good, then tip is average.

3 If the service is excellent or the food is delicious, then tip is generous.

Dinner for Two
a 2 input, 1 output, 3 rule system

Rule 1 If service is poor or food is rancid,

then tip is cheap.
Input 1
Service (0-10)

Rule 2 If service is good, then tip is average.

AN
Input 2 /

Output
Tip (5-25%)

Food (0-10)

Rule 3 [fservice is excellent or food is
delicious, then tip is generous.

The inputs are crisp All rules are The results of the The resultis a
(non-fuzzy) evaluated in paralle! rules are combined crisp (non-fuzzy)
numbers limited to a using fuzzy and distilled number.

specific range. reasoning. (defuzzified).

The parallel nature of the rules is an important aspect of fuzzy logic systems. Instead of sharp
switching between modes based on breakpoints, logic flows smoothly from regions where one rule or
another dominates.

The fuzzy inference process has the following steps.

» Fuzzification of the input variables on page 1-21

» Application of the fuzzy operator (AND or OR) in the antecedent on page 1-21
* Implication from the antecedent to the consequent on page 1-22

* Aggregation of the consequents across the rules on page 1-23

» Defuzzification on page 1-23

A fuzzy inference diagram on page 1-24 displays all parts of the fuzzy inference process — from
fuzzification through defuzzification.
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Fuzzify Inputs

The first step is to take the inputs and determine the degree to which they belong to each of the
appropriate fuzzy sets via membership functions (fuzzification). In Fuzzy Logic Toolbox software, the
input is always a crisp numerical value limited to the universe of discourse of the input variable (in
this case, the interval from 0 through 10) . The output is a fuzzy degree of membership in the
qualifying linguistic set (always the interval from 0 through 1). Fuzzification of the input amounts to
either a table lookup or a function evaluation.

This example is built on three rules, and each of the rules depends on resolving the inputs into
several different fuzzy linguistic sets: service is poor, service is good, food is rancid, food is delicious,
and so on. Before the rules can be evaluated, the inputs must be fuzzified according to each of these
linguistic sets. For example, to what extent is the food delicious? The following figure shows how well
the food at the hypothetical restaurant (rated on a scale from 0 through 10) qualifies as the linguistic
variable delicious using a membership function. In this case, we rate the food as an 8, which, given
the graphical definition of delicious, corresponds to u = 0.7 for the delicious membership function.

1. Fuzzify
inputs. delicious Result of
fuzzification

food is delicious ‘

food =8

input

In this manner, each input is fuzzified over all the qualifying membership functions required by the
rules.

Apply Fuzzy Operator

After the inputs are fuzzified, you know the degree to which each part of the antecedent is satisfied
for each rule. If the antecedent of a rule has more than one part, the fuzzy operator is applied to
obtain one number that represents the result of the rule antecedent. This number is then applied to
the output function. The input to the fuzzy operator is two or more membership values from fuzzified
input variables. The output is a single truth value.

As described in “Logical Operations” on page 1-13, any number of well-defined methods can fill in for
the AND operation or the OR operation. In the toolbox, two built-in AND methods are supported: min
(minimum) and prod (product). Two built-in OR methods are also supported: max (maximum) and
probor (probabilistic OR). The probabilistic OR method (also known as the algebraic sum) is
calculated according to the equation:

probor(a,b) =a + b - ab

In addition to these built-in methods, you can create your own methods for AND and OR by writing
any function and setting that to be your method of choice. For more information, see “Build Fuzzy
Systems Using Custom Functions” on page 2-40.

The following figure demonstrates the OR operator max by evaluating the antecedent of the third rule
of the tipping calculation. For the given service and food ratings, the two elements of the antecedent

1-21



1 Getting Started

1-22

(service is excellent and food is delicious) produce the fuzzy membership values 0.0 and 0.7,
respectively. The fuzzy OR operator selects the maximum of the two values, 0.7. The probabilistic OR
method would still result in 0.7.

1. Fuzzify 2. Apply
inputs. OR operator (max).
excellent 0.7
0.7
delicious 0.0 result of
fuzzy operator
service is excellent food is delicious

service=3 food =8

input 1 input 2

Apply Implication Method

Before applying the implication method, you must determine the rule weight. Every rule has a weight
(a number from 0 through 1), which is applied to the number given by the antecedent. Generally, this
weight is 1 (as it is for this example) and thus has no effect on the implication process. However, you
can decrease the effect of one rule relative to the others by changing its weight value to something
other than 1.

After proper weighting has been assigned to each rule, the implication method is implemented. A
consequent is a fuzzy set represented by a membership function, which weights appropriately the
linguistic characteristics that are attributed to it. The consequent is reshaped using a function
associated with the antecedent (a single number). The input for the implication process is a single
number given by the antecedent, and the output is a fuzzy set. Implication is implemented for each
rule. Two built-in methods are supported, and they are the same functions that are used by the AND
method: min (minimum), which truncates the output fuzzy set, and prod (product), which scales the
output fuzzy set.

Antecedent Consegquent
_AL A
r N r )
1. Fuzzfy 2. Apply 3. A;lnplyl
. OR Implication
inputs. operator (max) operdtor (min)
senvios is excslent or food is deldous then | result of
implication

service = 3 food = 8

input 1 input 2

Note Sugeno systems always use the product implication method.
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Aggregate All Outputs

Since decisions are based on testing all the rules in a FIS, the rule outputs must be combined in some
manner. Aggregation is the process by which the fuzzy sets that represent the outputs of each rule
are combined into a single fuzzy set. Aggregation only occurs once for each output variable, which is
before the final defuzzification step. The input of the aggregation process is the list of truncated
output functions returned by the implication process for each rule. The output of the aggregation
process is one fuzzy set for each output variable.

As long as the aggregation method is commutative, then the order in which the rules are executed is
unimportant. Three built-in methods are supported.

* max (maximum)

* probor (probabilistic OR)

* sum (sum of the rule output sets)

In the following diagram, all three rules are displayed to show how the rule outputs are aggregated
into a single fuzzy set whose membership function assigns a weighting for every output (tip) value.

2 A 3. Apply
1. Fuzzify inputs. fuzz'?,p r‘_v ::Tgr:ﬁ:{{?n,:m)
l (OR max)

I L] poor rancid ] cheap

Q
| If service is poor or food is rancid then tip= cheap
| | - average
2 L rule 2 has
no dependency
good | on input 2 |
E
30% 30%
‘ If service is good then tnp average
-
excellent
3. y
delicious generous
i 309 30% 4.Apply
| It service isexeellent  or food is delicious then tlp generous fnysglffg;g::x)
service =3 food =8

input 1 input 2 ’_/-\F\

¢ Result of 0%
aggregation

Note Sugeno systems always use the sum aggregation method.

Defuzzify

The input for the defuzzification process is the aggregate output fuzzy set and the output is a single
number. As much as fuzziness helps the rule evaluation during the intermediate steps, the final
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desired output for each variable is generally a single number. However, the aggregate of a fuzzy set
encompasses a range of output values, and so must be defuzzified to obtain a single output value
from the set.

There are five built-in defuzzification methods supported: centroid, bisector, middle of maximum (the
average of the maximum value of the output set), largest of maximum, and smallest of maximum.
Perhaps the most popular defuzzification method is the centroid calculation, which returns the center
of the area under the aggregate fuzzy set, as shown in the following figure.

5. Defuzzify the

aggregate output

0 309  (centroid).

tip = 16.7%

Result of

defuzzification
While the aggregate output fuzzy set covers a range from 0% though 30%, the defuzzified value is

between 5% and 25%. These limits correspond to the centroids of the cheap and generous
membership functions, respectively.

Fuzzy Inference Diagram

The fuzzy inference diagram is the composite of all the smaller diagrams presented so far in this
section. It simultaneously displays all parts of the fuzzy inference process you have examined.
Information flows through the fuzzy inference diagram as shown in the following figure.

—
ﬁ

Interpreting the
fuzzy inference
diagram

input 1 input 2

output
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In this figure, the flow proceeds up from the inputs in the lower left, across each row, and then down
the rule outputs to the lower right. This compact flow shows everything at once, from linguistic
variable fuzzification all the way through defuzzification of the aggregate output.

The following figure shows the actual full-size fuzzy inference diagram for the basic tipping problem.
Using a fuzzy inference diagram, you can learn a lot about how the system operates. For instance, for
the particular inputs in this diagram, you can see that the implication method is truncation with the
min function. The max function is used for the fuzzy OR operation. Rule 3 (the bottom-most row in the
diagram shown previously) has the strongest influence on the output. The Rule Viewer described in
“The Rule Viewer” on page 2-27 is an implementation of the fuzzy inference diagram.

2. Apply
fuzzy 3. Appl
1. Fuzzify inputs. operation fmpi?é.;ﬁon
{OR max). method (min).
|
1 . poor rancid ‘ ] cheap
I_\_ |
0 0 30% 0% 30%
If service is poor or food is rancid then tip = cheap
‘ ‘ average, |
/\ rule 2 has ] ’ \ ’ \ |
no dependency
oninput 2 | ‘
0% 30% 0% 30%
service is good then tip = average
|
excellent
generous \
delicious ‘
0% 30% 0% 30% , Apply
| If  service is excellent or food is delicious then tip = generous aggregation
method (max).
service = 3 food = 8
input 1 input 2
G (5 Defu?jz]ify
centroid).
tip = 16.7% 0% 30%
output
See Also
More About
. “Foundations of Fuzzy Logic” on page 1-7
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Membership Function Gallery

This example shows how to display 11 membership functions supported in the Fuzzy Logic Toolbox4.

Define membership functions.

fismf('dsigmf',[5 -3 1 5])
fismf('pimf',[0 7 11 15])
fismf('sigmf',[2 15])

1;

mf =1[...

fismf('trapmf',[-19 -17 -12 -7])
fismf('gbellmf',[3 4 -8])
fismf('trimf',[-9 -1 2])
fismf('gaussmf',[3 5]) ...
fismf('gauss2mf',[3 10 5 13])
fismf('smf',[11 17])
fismf('zmf',[-18 -10])
fismf('psigmf',[2 -11 -5 -4])

(

(

(

For more information on the different membership functions and their parameters, see their
respective function reference pages.

Evaluate the membership functions.

X
y

linspace(-20,20,201);
evalmf(mf,x);

Plot the evaluated membership functions with labels.

subplot(2,1,1);
plot(x,y(1:6,:)"');
axis([min(x) max(x) 0 1.21);
text((mf(1l).Parameters(2)+mf(1l).Parameters(3))/2,1.1,mf(1).Type,...
"horizon', 'center');
text(mf(2).Parameters(3),1.1,mf(2).Type, ...
"horizon', 'center');
text(mf(3).Parameters(2),1.1,mf(3).Type, ...
"horizon', 'center');
text(mf(4).Parameters(2),1.1,mf(4).Type, ...
"horizon', 'center');
text ((mf(5).Parameters(2)+mf(5).Parameters(4))/2,1.1,mf(5).Type, ...
"horizon', 'center');
text(mf(6).Parameters(2), 1.1,mf(6).Type,...
"horizon', 'center');
h gca = gca;
h gca.XTick = [];

subplot(2,1,2);

plot(x,y(7:11,:)"');

axis([min(x) max(x) 0 1.21);

text(mf(7).Parameters(1l),1.1,mf(7).Type, ...
"horizon', 'center');

text ((mf(8).Parameters(2)+mf(8).Parameters(4))/2,1.1,mf(8).Type, ...
"horizon', 'center');

text ((mf(9).Parameters(2)+mf(9).Parameters(4))/2,1.1,mf(9).Type, ...
"horizon', 'center');
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text((mf(10).Parameters(2)+mf(10).Parameters(3))/2,1.1,mf(10).Type, ...
"horizon', 'center');

text(mf(1ll).Parameters(2),1.1,mf(11).Type,...
"horizon', 'center');

h gca = gca;

h gca.XTick = [];

1 trapmf gbellmf trirnf gaussmf gaussZmf  smf
0.5t .
0 Y L
1 zmf psigmf dsigmf pirnf sigmf
0.5t .
0
See Also
More About
. “Foundations of Fuzzy Logic” on page 1-7
. “Fuzzy Inference Process” on page 1-20
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Defuzzification Methods

This example describes the built-in methods for defuzzifying the output fuzzy set of a type-1 Mamdani
fuzzy inference system.

Consider the following output fuzzy set, which is an aggregation of three scaled trapezoidal
membership functions.

X =0:0.1:20;

mfl = trapmf(x,[0 2 8 12]);
mf2 = trapmf(x,[5 7 12 14]);
mf3 = trapmf(x,[12 13 18 19]);

mf = max(0.5*mf2,max(0.9*mfl,0.1*mf3));

figure('Tag', 'defuzz')
plot(x,mf, 'LineWidth"',3)
h_gca = gca;

h gca.YTick = [0 .5 1] ;
ylim([-1 1])

Fuzzy Logic Toolbox™ software supports five built-in methods for computing a single crisp output
value for such a fuzzy set.

* Centroid
e Bisector
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* Middle of maximum
* Smallest of maximum
* Largest of maximum

You can also define your own custom defuzzification method. For more information, see “Build Fuzzy
Systems Using Custom Functions” on page 2-40.

Centroid

Centroid defuzzification returns the center of gravity of the fuzzy set along the x-axis. If you think of
the area as a plate with uniform thickness and density, the centroid is the point along the x-axis about
which the fuzzy set would balance. The centroid is computed using the following formula, where p(x;)

is the membership value for point x; in the universe of discourse.

xCentroid = 206X

2iH(xi)
Compute the centroid of the fuzzy set.
xCentroid = defuzz(x,mf, 'centroid');

Indicate the centroid defuzzification result on the original plot.

hCentroid = line([xCentroid xCentroid],[-0.2 1.2],'Color','k");
tCentroid = text(xCentroid,-0.2,"' centroid', 'FontWeight', 'bold");
0.5 T

0 \—

centroid
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Bisector

The bisector method finds the vertical line that divides the fuzzy set into two sub-regions of equal
area. It is sometimes, but not always, coincident with the centroid line.

xBisector = defuzz(x,mf, 'bisector');
Indicate the bisector result on the original plot, and gray out the centroid result.

hBisector line([xBisector xBisector],[-0.4 1.2], 'Color','k');
tBisector text(xBisector,-0.4,' bisector', 'FontWeight', 'bold");
gray = 0.7*[1 1 1];

hCentroid.Color = gray;

tCentroid.Color = gray;

1 T T T T T T T T T
05T T
0 N
bisector
1] 2 4 6 8 10 12 14 16 18 20

Middle, Smallest, and Largest of Maximum

MOM, SOM, and LOM stand for middle, smallest, and largest of maximum, respectively. In this
example, since the aggregate fuzzy set has a plateau at its maximum value, the MOM, SOM, and LOM
defuzzification results have distinct values. If the aggregate fuzzy set has a unique maximum, then
MOM, SOM, and LOM all produce the same value.

XMOM = defuzz(x,mf, 'mom');
XSOM = defuzz(x,mf, 'som');
XLOM = defuzz(x,mf, 'lom');

Indicate the MOM, SOM, and LOM results on the original plot, and gray out the bisector result.
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hMOM
tMOM
hSOM
tSOM
hLOM
tLOM

hBisector.Color

line

(
(
(
(
(

text(xLOM,-0.7,"

line([xMOM xMOM],[-0.7 1.2],'Color','k');
text (xMOM, -0.7,"' MOM', 'FontWeight', 'bold');
[xSOM xSOM],[-0.7 1.2],'Color"','k');
text (xSOM,-0.7,"' SOM', 'FontWeight', 'bold');
line([xLOM xLOM],[-0.7 1.2],'Color','k');
LOM', 'FontWeight', 'bold"');

= gray,;
tBisector.Color = gray;
1 : : : : : : :
0.5 |
DJ V—
SOM MOM LOM
1] 2 4 6 10 12 14 16 18 20

Choosing Defuzzification Method

In general, using the default centroid method is good enough for most applications. Once you have
created your initial fuzzy inference system, you can try other defuzzification methods to see if any
improve your inference results.

Highlight the centroid result, and gray out the MOM, SOM, and LOM results.

hCentroid.Color
tCentroid.Color
hMOM.
tMOM.
hSOM.
tSOM.
hLOM.
tLOM.

Color
Color
Color
Color
Color
Color

gray,
gray,
gray,
gray,
gray,
gray,

'red';
'red';
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See Also
More About
. “Foundations of Fuzzy Logic” on page 1-7
. “Fuzzy Inference Process” on page 1-20
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Fuzzy vs. Nonfuzzy Logic
Basic Tipping Problem

To illustrate the value of fuzzy logic, examine both linear and fuzzy approaches to the following
problem:

What is the right amount to tip your waitperson?

First, work through this problem the conventional (nonfuzzy) way, writing MATLAB® commands that
spell out linear and piecewise-linear relations. Then, look at the same system using fuzzy logic.

Basic Tipping Problem. Given a number from 0 through 10 that represents the quality of service at
a restaurant (where 10 is excellent), what should the tip be?

This problem is based on tipping as it is typically practiced in the United States. An average tip for a
meal in the US is 15%, though the actual amount can vary depending on the quality of the service
provided.

Nonfuzzy Approach

Begin with the simplest possible relationship. Suppose that the tip always equals 15% of the total bill.

service = 0:.5:10;

tip = 0.15*ones(size(service));
plot(service,tip)
xlabel('Service')

ylabel('Tip"')

ylim([0.05 0.25])
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D25 T T T T T T T T T

011 i

D. D 5 L L ! L L 1 1 1 !
Service

This relationship does not account for the quality of the service, so you must add a term to the
equation. Since service is rated on a scale from 0 through 10, you the tip increase linearly from 5% if
the service is bad to 25% if the service is excellent. Now the relation looks like the following plot:

tip = (.20/10)*service+0.05;
plot(service,tip)
xlabel('Service')
ylabel('Tip"')

ylim([0.05 0.25])
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DZS T T T T T T T T T

0.2r ]

DDE 1 1 1 1 1 1 1 1 1

Service

The formula does what you want it to do, and is straight forward. However, you may want the tip to
reflect the quality of the food as well. This extension of the problem is defined as follows.

Extended Tipping Problem. Given two sets of numbers from 0 through 10 (where 10 is excellent)
that respectively represent the quality of the service and the quality of the food at a restaurant, what
should the tip be?

See how the formula is affected now that you have added another variable.

food = 0:.5:10;

[F,S] = meshgrid(food,service);
tip = (0.20/20).*(S+F)+0.05;
surf(S,F,tip)

xlabel('Service')
ylabel('Food")

zlabel('Tip"')
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0.25 ~

0.2 -

2 015

0.1 -

4

Food 0 o Service

In this case, the results look satisfactory, but when you look at them closely, they do not seem right.
Suppose that you want the service to be a more important factor than the food quality. Specify that
service accounts for 80% of the overall tipping grade and the food makes up the other 20%.

servRatio = 0.8;

tip = servRatio*(0.20/10*%S+0.05) + ...
(1-servRatio)*(0.20/10*F+0.05);

surf(S,F,tip)

xlabel('Service')

ylabel('Food")

zlabel('Tip")
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0.25 ~

0.2 -

2015

0.1 -

4

Food 0 o

Service

The response is still somehow too uniformly linear. Suppose that you want more of a flat response in
the middle, that is, you want to give a 15% tip in general, but want to also specify a variation if the
service is exceptionally good or bad. This factor, in turn, means that the previous linear mappings no
longer apply. You can still use the linear calculation with a piecewise linear construction. Now, return
to the one-dimensional problem of just considering the service. You can create a simple conditional
tip assignment using logical indexing.

tip = zeros(size(service));

tip(service<3) = (0.10/3)*service(service<3)+0.05;

tip(service>=3 & service<7) = 0.15;

tip(service>=7 & service<=10) = ...
(0.10/3)*(service(service>=7 & service<=10)-7)+0.15;

plot(service,tip)

xlabel('Service')

ylabel('Tip"')

ylim([0.05 0.25])
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Suppose that you extend this approach to two dimensions, where you account for food quality again.

servRatio = 0.8;

tip = zeros(size(S));

tip(S<3) = ((0.10/3)*S(S<3)+0.05)*servRatio + ...
(1-servRatio)*(0.20/10*F(S<3)+0.05);

tip(S>=3 & S<7) = (0.15)*servRatio + ...
(1-servRatio)*(0.20/10*F(S>=3 & S<7)+0.05);

tip(S>=7 & S<=10) = ((0.10/3)*(S(S>=7 & S<=10) -
(1-servRatio)*(0.20/10*F(S>=7 & S<=10)+0.05

surf(S,F,tip)

xlabel('Service')

ylabel('Food")

zlabel('Tip")

7)+0.15)*servRatio + ...
);
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4

Food 0 o Service

The plot looks good, but the function is surprisingly complicated. It is even not apparent how the
algorithm works to someone who did not see the original design process.

Fuzzy Logic Approach

In general, you want to capture the essentials of this problem, leaving aside all the factors that could
be arbitrary. If you make a list of what really matters in this problem, you could end up with the
following rule descriptions.

Tipping Problem Rules - Service Factor

» If service is poor, then tip is cheap
» If service is good, then tip is average
* If service is excellent, then tip is generous

The order in which the rules are presented here is arbitrary. It does not matter which rules come
first. To include the effect of food quality on the tip, add the following two rules.

Tipping Problem Rules - Food Factor

» If food is rancid, then tip is cheap
» If food is delicious, then tip is generous

You can combine the two different lists of rules into one list of three rules like so.

Tipping Problem Rules - Both Service and Food Factors
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» If service is poor or the food is rancid, then tip is cheap
» If service is good, then tip is average
» If service is excellent or food is delicious, then tip is generous

These three rules are the core of your solution and they correspond to the rules for a fuzzy logic
system. When you give mathematical meaning to the linguistic variables (what is an average tip, for
example) you have a complete fuzzy inference system. The methodology of fuzzy logic must also
consider:

* How are the rules all combined?
* How do I define mathematically what an average tip is?

Problem Solution

The following plot represents the fuzzy logic system that solves the tipping problem.

gensurf(readfis('tipper'))

4

food 0 o service

This plot was generated by the three rules that accounted for both service and food factors.

Observations Consider some observations about the example so far. You found a piecewise linear
relation that solved the problem. It worked, but it was problematic to derive, and when you wrote it
down as code, it was not easy to interpret. Conversely, the fuzzy logic system is based on some
common sense statements. Also, you were able to add two more rules to the list that influenced the
shape of the overall output without needing to undo what had already been done.
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Moreover, by using fuzzy logic rules, the maintenance of the structure of the algorithm decouples
along fairly clean lines. The notion of an average tip can change from day to day, city to city, country
to country. However, the underlying logic is the same: if the service is good, the tip should be
average.

Recalibrating the Method You can recalibrate the method quickly by simply shifting the fuzzy set
that defines average without rewriting the fuzzy logic rules.

You can shift lists of piecewise linear functions, but there is a greater likelihood for difficult
recalibration.

In the following example, the piecewise linear tipping problem is rewritten to make it more generic. It
performs the same function as before, only now the constants can be easily changed.

lowTip = 0.05;

averTip = 0.15;

highTip = 0.25;

tipRange = highTip-lowTip;
badService = 0;
okayService = 3;
goodService = 7
greatService
serviceRange
badFood = 0;
greatFood
foodRange

10;
greatService-badService;

10;
greatFood-badFood;

% If service is poor or food is rancid, tip is cheap
if service<okayService
tip = (((averTip-lowTip)/(okayService-badService))
*service+lowTip)*servRatio + ...
(1-servRatio)*(tipRange/foodRange*food+lowTip);

% If service is good, tip is average
elseif service<goodService
tip = averTip*servRatio + (1l-servRatio)* ...
(tipRange/foodRange*food+lowTip);

% If service is excellent or food is delicious, tip is generous
else
tip = (((highTip-averTip)/ ...
(greatService-goodService))* ...
(service-goodService)+averTip)*servRatio + ...
(1-servRatio)*(tipRange/foodRange*food+lowTip);
end

As with all code, the more generality that is introduced, the less precise the algorithm becomes. You
can improve clarity by adding more comments, or perhaps rewriting the algorithm in slightly more
self-evident ways. But, the piecewise linear methodology is not the optimal way to resolve this issue.

If you remove everything from the algorithm except for three comments, what remain are exactly the
fuzzy logic rules you previously wrote down.

» If service is poor or food is rancid, tip is cheap
» If service is good, tip is average
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» If service is excellent or food is delicious, tip is generous

Fuzzy logic uses language that is clear to you and that also has meaning to the computer, which is
why it is a successful technique for bridging the gap between people and machines.

By making the equations as simple as possible (linear) you make things simpler for the machine, but
more complicated for you. However, the limitation is no longer the computer - it is your mental model
of what the computer is doing. Fuzzy logic lets the machine work with your preferences rather than
the other way around.

See Also

Related Examples
. “Build Fuzzy Systems at the Command Line” on page 2-31
. “Build Fuzzy Systems Using Fuzzy Logic Designer” on page 2-14
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* “Mamdani and Sugeno Fuzzy Inference Systems” on page 2-2

* “Type-2 Fuzzy Inference Systems” on page 2-7

* “Build Fuzzy Systems Using Fuzzy Logic Designer” on page 2-14
* “Build Fuzzy Systems at the Command Line” on page 2-31
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2 Fuzzy Inference System Modeling

Mamdani and Sugeno Fuzzy Inference Systems

2-2

Fuzzy Logic Toolbox software supports two types of fuzzy inference systems:

* Mamdani systems
* Sugeno systems

Fuzzy Inference System Advantages
Mamdani * Intuitive
*  Well-suited to human input
* More interpretable rule base
* Have widespread acceptance
Sugeno * Computationally efficient

Work well with linear techniques, such as PID control
Work well with optimization and adaptive techniques
Guarantee output surface continuity
Well-suited to mathematical analysis

Mamdani Fuzzy Inference Systems

Mamdani fuzzy inference was first introduced as a method to create a control system by synthesizing
a set of linguistic control rules obtained from experienced human operators [1]. In a Mamdani
system, the output of each rule is a fuzzy set.

Since Mamdani systems have more intuitive and easier to understand rule bases, they are well-suited
to expert system applications where the rules are created from human expert knowledge, such as

medical diagnostics.

The inference process of a Mamdani system is described in “Fuzzy Inference Process” on page 1-20
and summarized in the following figure.
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The output of each rule is a fuzzy set derived from the output membership function and the
implication method of the FIS. These output fuzzy sets are combined into a single fuzzy set using the
aggregation method of the FIS. Then, to compute a final crisp output value, the combined output
fuzzy set is defuzzified using one of the methods described in “Defuzzification Methods” on page 1-
28.

Sugeno Fuzzy Inference Systems

Sugeno fuzzy inference, also referred to as Takagi-Sugeno-Kang fuzzy inference, uses singleton
output membership functions that are either constant or a linear function of the input values. The
defuzzification process for a Sugeno system is more computationally efficient compared to that of a
Mamdani system, since it uses a weighted average or weighted sum of a few data points rather than
compute a centroid of a two-dimensional area. [2]

You can convert a Mamdani system into a Sugeno system using the convertToSugeno function. The
resulting Sugeno system has constant output membership functions that correspond to the centroids
of the Mamdani output membership functions.

Each rule in a Sugeno system operates as shown in the following diagram, which shows a two-input
system with input values x and y.
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Each rule generates two values:
* 2z, — Rule output level, which is either a constant value or a linear function of the input values:
Zi = aix + b,-y + G

Here, x and y are the values of input 1 and input 2, respectively, and a;, b;, and c; are constant
coefficients. For a zero-order Sugeno system, z; is a constant (a = b = 0).

* w; — Rule firing strength derived from the rule antecedent
w; = AndMethod(F1(x), Fo(y))
Here, F(...) and F,(...) are the membership functions for inputs 1 and 2, respectively.
The output of each rule is the weighted output level, which is the product of w; and z;.

The easiest way to visualize first-order Sugeno systems (a and b are nonzero) is to think of each rule
as defining the location of a moving singleton. That is, the singleton output spikes can move around in
a linear fashion within the output space, depending on the input values. The rule firing strength then
defines the size of the singleton spike.

The final output of the system is the weighted average over all rule outputs:

N
21 Wiz

1=

N

2 Wi

i=1

Final Output =

where N is the number of rules.

The following figure shows the fuzzy inference process for a Sugeno system.
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Note Sugeno systems always use product implication and sum aggregation.

Because of the linear dependence of each rule on the input variables, the Sugeno method is ideal for
acting as an interpolating supervisor of multiple linear controllers that are to be applied, respectively,
to different operating conditions of a dynamic nonlinear system. For example, the performance of an
aircraft may change dramatically with altitude and Mach number. Linear controllers, though easy to
compute and suited to any given flight condition, must be updated regularly and smoothly to keep up
with the changing state of the flight vehicle. A Sugeno fuzzy inference system is suited to the task of
smoothly interpolating the linear gains that would be applied across the input space; it is a natural
and efficient gain scheduler. Similarly, a Sugeno system is suited for modeling nonlinear systems by
interpolating between multiple linear models.

References
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. “Build Fuzzy Systems Using Custom Functions” on page 2-40
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Type-2 Fuzzy Inference Systems

For any value in the universe of discourse, a traditional type-1 membership function has a single
membership value. Therefore, while a type-1 membership function models the degree of membership
in a given linguistic set, it does not model uncertainty in the degree of membership. To model such
uncertainty, you can use interval type-2 membership functions. In such type-2 membership functions,
the degree of membership can have a range of values.

For examples that use type-2 fuzzy inference systems, see “Fuzzy PID Control with Type-2 FIS” on
page 2-58 and “Predict Chaotic Time Series Using Type-2 FIS” on page 3-57.

Interval Type-2 Membership Functions

An interval type-2 membership function is defined by an upper and lower membership function. The
upper membership function (UMF) is equivalent to a traditional type-1 membership function. The
lower membership function (LMF) is less than or equal to the upper membership function for all
possible input values. The region between the UMF and LMF is the footprint of uncertainty (FOU).
The following diagram shows the UMF (red), the LMF (blue), and the FOU (shaded) for a type-2
triangular membership function.

Membership

Universe of Discourse

For each input value in the universe of discourse, the degree of membership is the range of values
between the LMF and UMF values.

Type-2 Fuzzy Inference Systems

Using Fuzzy Logic Toolbox software, you can create both type-2 Mamdani and Sugeno fuzzy inference
systems.

* In type-2 Mamdani systems, both the input and output membership functions are type-2 fuzzy
sets.

* In type-2 Sugeno systems, only the input membership functions are type-2 fuzzy sets. The output
membership functions are the same as for a type-1 Sugeno system — constant or a linear function
of the input values.

To create type-2 Mamdani and Sugeno systems, use mamfistype2 and sugfistype2 objects,

respectively. These objects have the same parameters as the type-1 mamfis and sugfis objects
along with an additional TypeReductionMethod parameter.
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You can also create a type-2 fuzzy inference system by converting an existing type-1 system, such as
one created using the genfis function. To do so, use the convertToType2 function.

Once you create a type-2 fuzzy inference system, you can:

» Evaluate the fuzzy system using the evalfis functions

* Simulate the fuzzy system using the Fuzzy Logic Controller block

* Tune the parameters of the fuzzy system using the tunefis function

» Deploy the fuzzy system as described in “Deploy Fuzzy Inference Systems” on page 6-2

Fuzzy Inference Process for Type-2 Fuzzy Systems

Antecedent Processing

For type-2 fuzzy inference systems, input values are fuzzified by finding the corresponding degree of
membership in both the UMFs and LMFs from the rule antecedent. Doing so generates two fuzzy
values for each type-2 membership function. For example, the fuzzification in the following figure
shows the membership value in the upper membership function (f;;) and the lower membership
function (f7).

="

Next, a range of rule firing strengths is found by applying the fuzzy operator to the fuzzified values of
the type-2 membership functions, as shown in the following figure. The maximum value of this range
(wy) is the result of applying the fuzzy operator to the fuzzy values from the UMFs. The minimum
value (wy) is the result of applying the fuzzy operator to the fuzzy values from the LMFs
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IR

Antecedent processing is the same for both Mamdani and Sugeno systems.

Consequent Processing

For a Mamdani system, the implication method clips (min implication) or scales (prod implication)
the UMF and LMF of the output type-2 membership function using the rule firing range limits. This
process produces an output fuzzy set for each rule. The following figure shows the output fuzzy set
(dark gray region) produced by applying min implication to the UMF (red) and LMF (blue).

For a type-2 Sugeno system, the output level z; for the ith rule is computed in the same manner as for
a type-1 Sugeno system.

; M
zi=cop+ > CjXj
i=1

Here, j is the input index, x; is the value of the jth input variable, and the ¢ terms are the upper
membership function parameters
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Unlike a type-1 Sugeno system, the rule firing strengths are not used to process the consequent of
each rule. Instead, the output level and rule firing strengths are used during the aggregation process.

Aggregation
The goal of the aggregation stage is to derive a single type-2 fuzzy set from the rule output fuzzy sets.

For a type-2 Mamdani system, the software finds an aggregate type-2 fuzzy set by applying the
aggregation method to the UMFs and LMFs of the output fuzzy sets of all the rules. The following
figure shows the aggregation of two type-2 fuzzy sets (the outputs for a two-rule system) using max
aggregation.

4 10

For a type-2 Sugeno system, the aggregate fuzzy set is derived using the following steps:
1  Sort the rule output levels (z;) from all the rules into ascending order. These output level values
define the universe of discourse for the aggregate type-2 fuzzy set.

2 For each output level, define the UMF value using the maximum firing range value from the
corresponding rule.

3  For each output level, define the LMF value using the minimum firing range value from the
corresponding rule.

For example, suppose you have a type-2 Sugeno system with seven rules. Further, assume these rules
have the following output levels and firing range limits.

Rule Output Level (z) Minimum Firing Value |Maximum Firing
Value
1 6.3 0.1 0.5
2 4.9 0.4 0.5
3 1.6 0.3 0.5
4 5.8 0.5 0.7
5 5.4 0.2 0.6
6 0.7 0.5 0.8
7 3.2 0.2 0.7

The following figure shows the aggregated type-2 fuzzy set for this Sugeno system with its associated
UMF (red) and LMF (blue).
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Type Reduction and Defuzzification

To find the final crisp output value for the inference process, the aggregate type-2 fuzzy set is first
reduced to an interval type-1 fuzzy set, which is a range with lower limit c¢; and upper limit cz. This
interval type-1 fuzzy set is commonly referred to as the centroid of the type-2 fuzzy set. In theory, this
centroid is the average of the centroids of all the type-1 fuzzy sets embedded in the type-2 fuzzy set.
In practice, it is not possible to compute the exact values of ¢; and ci. Instead, iterative type-
reduction methods are used to estimate these values.

For a given aggregate type-2 fuzzy set, the approximate values of ¢; and cy are the centroids of the
following type-1 fuzzy sets (green).

R

Mathematically, these centroids are found using the following equations. [1]

L N
_ 2,’ = 1Xipumf(xi) + E,’ =1+ 1Xiﬂlmf(xi)

L= —Cr N
Ei = 1llumf(xi) + 21’ =L+ 1ﬂlmf(xi)
R N
_ Ei - 1 Xilimf(X;) + Ei - R 4+ 1 XiHumf(%))
- R N
E,‘ = 1Vlmf(xi) + E,’ =R+ 111umf(xi)
Here:
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* N is the number of samples taken across the output variable range, specified using
evalfisOptions.

* X; is the ith output value sample.
*  ymsis the upper membership function.
* s the lower membership function.

* L and R are switch points that are estimated by the various type-reduction methods. For a list of
supported methods, see “Type-Reduction Methods” on page 2-12.

For both Mamdani and Sugeno systems, the final defuzzified output value (y) is the average of the two
centroid values from the type reduction process.

_CLt+CR
T2

Type-Reduction Methods

Fuzzy Logic Toolbox software supports four built-in type-reduction methods. These algorithms differ
in their initialization methods, assumptions, computational efficiency, and terminating conditions.

To set the type-reduction method for a type-2 fuzzy system, set the TypeReduction property of the
mamfistype2 or sugfistype2 object.

Method TypeReduction Description
property Value

Karnik-Mendel (KM) |"karnikmendel" First type-reduction method developed

[2]

Enhanced Karnik- "ekm" Modification of the Karnik-Mendel algorithm with an

Mendel (EKM) [3] improved initialization, modified termination condition,
and improved computational efficiency

Iterative algorithm |"iasc" Iterative improvement to brute force methods

with stop condition

(IASC) [4]

Enhanced iterative |"eiasc" Improved version of the IASC algorithm

algorithm with stop
condition (EIASC) [5]

In general, the computational efficiency of these methods improve as you move down the table.

You can also use your own custom type-reduction method. For more information, see “Build Fuzzy
Systems Using Custom Functions” on page 2-40.
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. “Predict Chaotic Time Series Using Type-2 FIS” on page 3-57
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Build Fuzzy Systems Using Fuzzy Logic Designer

2-14

Fuzzy Logic Toolbox Graphical User Interface Tools

This example shows how to build a fuzzy inference system (FIS) for the tipping example, described in
“The Basic Tipping Problem” on page 2-16, using the Fuzzy Logic Toolbox Ul tools. These tools
support only type-1 fuzzy systems.

You use the following tools to build, edit, and view fuzzy inference systems:

Fuzzy Logic Designer to handle the high-level issues for the system — How many input and
output variables? What are their names?

Fuzzy Logic Toolbox software does not limit the number of inputs. However, the number of inputs
may be limited by the available memory of your machine. If the number of inputs is too large, or
the number of membership functions is too big, then it may also be difficult to analyze the FIS
using the other tools.

Membership Function Editor on page 2-20 to define the shapes of all the membership
functions associated with each variable

Rule Editor on page 2-25 to edit the list of rules that defines the behavior of the system.

Rule Viewer on page 2-27 to view the fuzzy inference diagram. Use this viewer as a diagnostic
to see, for example, which rules are active, or how individual membership function shapes
influence the results

Surface Viewer on page 2-29 to view the dependency of one of the outputs on any one or two of
the inputs; that is, it generates and plots an output surface map for the system.

These Uls are dynamically linked, in that changes you make to the FIS using one of them, affect what
you see on any of the other open Uls. For example, if you change the names of the membership
functions in the Membership Function Editor, the changes are reflected in the rules shown in the Rule

Editor. You can use the Uls to read and write variables both to the MATLAB workspace and to a file
(the read-only viewers can still exchange plots with the workspace and save them to a file). You can
have any or all of them open for any given system or have multiple editors open for any number of
fuzzy systems.
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Fuzzy Logic Designer

Membership
Function Editor

Rule Editor

Inference

Read-only

Surface Viewer

Rule Viewer

The following figure shows how the main components of a FIS and the three editors fit together. The
two viewers examine the behavior of the entire system.

The General Case...

A Specific Example...

The GUI Editors...

Input === Output service ===l tip The FIS Editor
: :m:ee :s p:mﬁ II: cheap * .
Rules if ::I: I: Endlun vh:- :I:I: generous The Rule Editor
Input Output service = tip = .
terms  ferms fpoor ichocp, The Membership
(interpret) (assign) E:l‘?d.r averoge,
excellent} generous}

In addition to these five primary Uls, the toolbox includes the graphical Neuro-Fuzzy Designer,
which you use to build and analyze Sugeno-type adaptive neuro-fuzzy inference systems.

The Fuzzy Logic Toolbox Uls do not support building a FIS using data. If you want to use data to build
a FIS, use one of the following techniques:

* genfis to generate a Sugeno-type FIS. Then, select File > Import in Fuzzy Logic Designer to
import the FIS and perform fuzzy inference, as described in “Fuzzy Logic Designer” on page 2-
16.

* Neuro-adaptive learning techniques to model the FIS, as described in “Neuro-Adaptive Learning
and ANFIS” on page 3-114.
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If you want to use MATLAB workspace variables, use the command-line interface instead of Fuzzy
Logic Designer. For an example, see “Build Fuzzy Systems at the Command Line” on page 2-31.

The Basic Tipping Problem

This example creates a Mamdani fuzzy inference system using on a two-input, one-output tipping
problem based on tipping practices in the U.S. While the example creates a Mamdani FIS, the
methods used apply to creating Sugeno systems as well.

Given a number between 0 and 10 that represents the quality of service at a restaurant (where 10 is
excellent), and another number between 0 and 10 that represents the quality of the food at that
restaurant (again, 10 is excellent), what should the tip be?

The starting point is to write down the three golden rules of tipping:

1 Ifthe service is poor or the food is rancid, then tip is cheap.
2 If the service is good, then tip is average.
3 If the service is excellent or the food is delicious, then tip is generous.

Assume that an average tip is 15%, a generous tip is 25%, and a cheap tip is 5%.

25 —

15 —

Bud service or bad food Greof service or grent food

The numbers and the shape of the curve are subject to local traditions, cultural bias, and so on, but
the three rules are generally universal.

Now that you know the rules and have an idea of what the output should look like, use the UI tools to
construct a fuzzy inference system for this decision process.

Fuzzy Logic Designer

The Fuzzy Logic Designer app displays information about a fuzzy inference system. To open Fuzzy
Logic Designer, type the following command at the MATLAB prompt:

fuzzyLogicDesigner

Fuzzy Logic Designer opens and displays a diagram of the fuzzy inference system with the names of
each input variable on the left, and those of each output variable on the right, as shown in the next
figure. The sample membership functions shown in the boxes are just icons and do not depict the
actual shapes of the membership functions.
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Double-click the input varlable icon to
open the Membership Function Editor

JRT=IE

File Edit View

Untitied

(mamdani)

input1 outputi

W FIS Type: amdani /J'

Double-click the system
diagram to open the Rule Editor

Double—lick the output variable icon to
open the Membership Function Editor

Below the diagram is the name of the system and the type of inference used.

Name of the system.
To change it, select
File > Export > To Works pace.

FIS Mame: Untitled FIS Type: mamdani
And method min - Current Variable
Or method [max -1 || " [inputt

T input
Implication min - b —

Range [0 1]
Aggregation I — o I
Defuzzification I centroid -I Help loze

System "Untitled™ 1 input, 1 output, and 0 rules -l-|

Options for adjusting the fuzzy Siatus line describes Mame of the selected input

inference functions, such ; or output variables.
as the defuzzification method. the most racent operarion. ¥

In this example, you use the default Mamdani-type inference. Another type of inference, called
Sugeno-type inference, is also available. For more information, see “Mamdani and Sugeno Fuzzy
Inference Systems” on page 2-2.

In Fuzzy Logic Designer:

* The drop-down lists let you modify the fuzzy inference functions.

* The Current Variable area displays the name of either an input or output variable, its type, and
default range.

* A status line at the bottom displays information about the most recent operation.
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To build the fuzzy inference system described in “The Basic Tipping Problem” on page 2-16 from
scratch, type the following command at the MATLAB prompt:

fuzzylLogicDesigner

The generic untitled Fuzzy Logic Designer opens, with one input input1, and one output outputl.

i =

File Edit Wiew

Untitled

(mamdani)
input1 outputi
FIS Marme: Untitled FIS Type: mammcdani
And method min - Current Yariable
Qr method e = RET ] I—"_”mﬁ1
T inpaut
Implication min - o L
Range [a1]
Agoregation fr— -
Defuzzification I centroid - I Help Close
System "Untitled": 1 input, 1 output, and O rules

Tip To open Fuzzy Logic Designer with the prebuilt fuzzy inference system stored in tipper.fis,
enter

fuzzylLogicDesigner('tipper.fis"')

However, if you load the prebuilt system, you will not build rules or construct membership functions.

In this example, you construct a two-input, one output system. The two inputs are service and food.
The one output is tip.

To add a second input variable and change the variable names to reflect these designations:

1 Select Edit > Add variable > Input.

A second yellow box labeled input2 appears.

Click the yellow box input1. This box is highlighted with a red outline.
Edit the Name field from inputl to service, and press Enter.

Click the yellow box input2. This box is highlighted with a red outline.

gua A W N

Edit the Name field from input2 to food, and press Enter.
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Click the blue box outputl.
Edit the Name field from outputl to tip, and press Enter.

Select File > Export > To Workspace.

=101 x|

Save current FIS to workspace

Wiarkspace varizble

IUnt'rtIed

ik

Cancel

9 Enter the Workspace variable name tipper, and click OK.

The diagram is updated to reflect the new names of the input and output variables. There is now

a new variable in the workspace called tipper that contains all the information about this

system. By saving to the workspace with a new name, you also rename the entire system. Your
window looks something like the following diagram.

) Fuzzy Logic Designer: Untitled

File Edit View

=10l x|

senvice tipper
— (mamdani)
- -
e -
; ;-:_-'_‘\ ; tip
food

FIS Name: tipper FIS Type: mamdani
And method — = Current Variable
Or method max -] || Mame I

T
Implication — - bid

Range
Aggregation max -

Defuzzification

I centroid - I

Help

Close

Updating Rule Editor

Leave the inference options in the lower left in their default positions for now. You have entered all
the information you need for this particular Ul Next, define the membership functions associated
with each of the variables. To do this, open the Membership Function Editor.

You can open the Membership Function Editor in one of three ways:
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* Within the Fuzzy Logic Designer app, select Edit > Membership Functions.
* Within the Fuzzy Logic Designer app, double-click the blue icon called tip.
* At the command line, type mfedit.

The Membership Function Editor

The Membership Function Editor is the tool that lets you display and edit all of the membership
functions associated with all of the input and output variables for the entire fuzzy inference system.
The Membership Function Editor shares some features with Fuzzy Logic Designer, as shown in the
next figure. In fact, all of the five basic UI tools have similar menu options, status lines, and Help and
Close buttons.

“Variable Palette" area.
Click a variable to edit its
membership functions.

Menu commands for
saving, opening, and editing
a fuzzy system.

J Membership Function/Editor: tipper 101 =]
File Edit ‘\iew
FIZ Variahles / Membership function plots  Plot poitts: 181
. al g good excellent
3 2

SEFVICE tip

Graph displays all
membership functions
for the selected variable.

Click a line to change its attributes,
such as name, type, and numerical parameters.
Drag the curve to move it or to change its shape.

Set the display range
of the current plot.
~ Setthe range MName and type of
of the current variable. current variable.
= —

Current Yariakle Current Mermbership Function (click on MF to select)

Mame service Mame I oo

Type iput Tipe | gaussmf -]

i
Params
l—w' Range I[D 10] IIL.S 5 /
i
Display Range I[D 10] Help / | / Cloze |
al ri
Ready / /
. Fi
rd

This status line Change the numerical Select the tyge of Edit name of current
describes the most parameters for current current membership  membership function.
recent operation. membership function. function.
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When you open the Membership Function Editor to work on a fuzzy inference system that does not
already exist in the workspace, there are no membership functions associated with the variables that
you defined with Fuzzy Logic Designer.

On the upper-left side of the graph area in the Membership Function Editor is a "Variable Palette"
that lets you set the membership functions for a given variable.

To set up the membership functions associated with an input or an output variable for the FIS, select
a FIS variable in this region by clicking it.

Next select the Edit pull-down menu, and choose Add MFs .. A new window appears, which allows
you to select both the membership function type and the number of membership functions associated
with the selected variable. In the lower-right corner of the window are the controls that let you
change the name, type, and parameters (shape), of the membership function, after it is selected.

The membership functions from the current variable are displayed in the main graph. These
membership functions can be manipulated in two ways. You can first use the mouse to select a
particular membership function associated with a given variable quality, (such as poor, for the
variable, service), and then drag the membership function from side to side. This action affects the
mathematical description of the quality associated with that membership function for a given
variable. The selected membership function can also be tagged for dilation or contraction by clicking
on the small square drag points on the membership function, and then dragging the function with the
mouse toward the outside, for dilation, or toward the inside, for contraction. This action changes the
parameters associated with that membership function.

Below the Variable Palette is some information about the type and name of the current variable.
There is a text field in this region that lets you change the limits of the current variable's range
(universe of discourse) and another that lets you set the limits of the current plot (which has no real
effect on the system).

The process of specifying the membership functions for the two-input tipping example, tipper, is as
follows:

1 Double-click the input variable service to open the Membership Function Editor.
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-} Membership Function Editor: tipper 101 =l

Fil= Edit  View

FIS Variables Membership function plots  PIot points: 151

E' m Iinﬁ mfZ mf3

BEMVICE tip

food

=
]
]
]

]

]

]

1]

]

]

input variable "service”

Current Yariable Currernt Membership Function (click on MF to select)

Mame service Mame mfl

Typee infaLt Tipe Itrimf v I

Params
Range o |[-0.4nn.4]
Display Ranoe [1o1] Help | Closz |

Ready

2 In the Membership Function Editor, enter [@ 10] in the Range and the Display Range fields.
3 Create membership functions for the input variable service.

a Select Edit > Remove All MFs to remove the default membership functions for the input
variable service.

Select Edit > Add MFs to open the Membership Functions dialog box.
¢ In the Membership Functions dialog box, select gaussmf as the MF Type.
—lalx]

Add membership functions

= p

MF type

Mumber of MFs I 5 j

O | Cancel |

d  Verify that 3 is selected as the Number of MFs.
e C(Click OK to add three Gaussian curves to the input variable service.

4 Rename the membership functions for the input variable service, and specify their parameters.

a Click on the curve named mf1 to select it, and specify the following fields in the Current
Membership Function (click on MF to select) area:

* In the Name field, enter poor.
¢ In the Params field, enter [1.5 0O].
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The two inputs of Params represent the standard deviation and center for the Gaussian
curve.

Tip To adjust the shape of the membership function, type in the desired parameters or
use the mouse, as described previously.

Click on the curve named mf2 to select it, and specify the following fields in the Current
Membership Function (click on MF to select) area:

* In the Name field, enter good.

¢ In the Params field, enter [1.5 5].

Click on the curve named mf3, and specify the following fields in the Current Membership
Function (click on MF to select) area:

* In the Name field, enter excellent.
* In the Params field, enter [1.5 10].

The Membership Function Editor window looks similar to the following figure.

) Membership Function Editor: tipper o ] 4

File Edit View

FIS Variables Membership function plots  Plot points: 181
. poor good excellent
1
BC0 i
SEVICE tip

food

input variable "service”

Current Yariable Current Membership Function (click on MF to select)

Mt setvice Mt I excellent
Type input Type I gaussmf - I

Paratns
1.510
Range I [10] I [ 1
Display Range I[D 10] Help | Cloze |

Changing parameter for MF 3to [1.510]

In the FIS Variables area, click the input variable food to select it.

Enter [0 10] in the Range and the Display Range fields.

Create the membership functions for the input variable food.

b

Select Edit > Remove All MFs to remove the default Membership Functions for the input
variable food.

Select Edit > Add MFs to open the Membership Functions dialog box.
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¢ In the Membership Functions dialog box, select trapmf as the MF Type.
d  Select 2 in the Number of MFs drop-down list.
e Click OK to add two trapezoidal curves to the input variable food.
8 Rename the membership functions for the input variable food, and specify their parameters:

a In the FIS Variables area, click the input variable food to select it.
Click on the curve named mf1, and specify the following fields in the Current Membership
Function (click on MF to select) area:
* In the Name field, enter rancid.
¢ In the Params field, enter [0 0 1 3].
¢ Click on the curve named mf2 to select it, and enter delicious in the Name field.

Reset the associated parameters if desired.
9 Click on the output variable tip to select it.
10 Enter [0 30] in the Range and the Display Range fields to cover the output range.

The inputs ranges from 0 to 10, but the output is a tip between 5% and 25%.
11 Rename the default triangular membership functions for the output variable tip, and specify
their parameters.

a  Click the curve named mf1 to select it, and specify the following fields in the Current
Membership Function (click on MF to select) area:
* In the Name field, enter cheap.
* In the Params field, enter [0 5 10].

b  Click the curve named mf2 to select it, and specify the following fields in the Current
Membership Function (click on MF to select) area:
* Inthe Name field, enter average.
* Inthe Params field, enter [10 15 20].

¢ Click the curve named mf3 to select it, and specify the following:

* Inthe Name field, enter generous.
* Inthe Params field, enter [20 25 30].

The Membership Function Editor looks similar to the following figure.

Now that the variables have been named and the membership functions have appropriate shapes and
names, you can enter the rules. To call up the Rule Editor, go to the Edit menu and select Rules, or
type ruleedit at the command line.
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The Rule Editor

The menu items allow The rules are
you to save, open, or entered

edit a fuzzy system automatically
using any of the five Input or output selection menus, using the GUI

basic GUI tools. tools.

|4 Rule Editor- tipper

Fie Edt “iew Ophons

service is poor or [food is rancic
zervice is good) then
zervice iz excellent) or [food

(R —

good
ancellant
[ [s Ty (=]

not

[ not

hection
i

Ml an

Delete nie | ule | Ehangerule| JJ

ra . ——

Link input / —
statemenmrﬁj FIS MName: tlp\bq ! /‘\ /I Help | Close, ”

¥ i = ra
- - — . - = -

This status line V \/ \/
MNegate input or output The Help button
describes the most stalenments in rules. Create or edit rules with the GUI buttons and gives prne

recent operation. choices from the input or output selection menus.
information about

how the Rule Editor
works, and the
Close button closes
the window.

Constructing rules using the graphical Rule Editor interface is fairly self evident. Based on the
descriptions of the input and output variables defined with Fuzzy Logic Designer, the Rule Editor
allows you to construct the rule statements automatically. You can:

» Create rules by selecting an item in each input and output variable box, selecting one Connection
item, and clicking Add Rule. You can choose none as one of the variable qualities to exclude that
variable from a given rule and choose not under any variable name to negate the associated
quality.

* Delete a rule by selecting the rule and clicking Delete Rule.
* Edit a rule by changing the selection in the variable box and clicking Change Rule.

* Specify weight to a rule by typing in a desired number between 0 and 1 in Weight. If you do not
specify the weight, it is assumed to be unity (1).

Similar to those in Fuzzy Logic Designer and the Membership Function Editor, the Rule Editor has
the menu bar and the status line. The menu items allow you to open, close, save and edit a fuzzy
system using the five basic Ul tools. From the menu, you can also:
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* Set the format for the display by selecting Options > Format.
* Set the language by selecting Options > Language.

You can access information about the Rule Editor by clicking Help and close the Ul using Close.
To insert the first rule in the Rule Editor, select the following:

* poor under the variable service

* rancid under the variable food

* The or radio button, in the Connection block
* cheap, under the output variable, tip.

Then, click Add rule.

The resulting rule is
1. If (service is poor) or (food is rancid) then (tip is cheap) (1)

The numbers in the parentheses represent weights.
Follow a similar procedure to insert the second and third rules in the Rule Editor to get

1 [f(service is poor) or (food is rancid) then (tip is cheap) (1)
2 If (service is good) then (tip is average) (1)
3 If(service is excellent) or (food is delicious) then (tip is generous) (1)

Tip To change a rule, first click on the rule to be changed. Next make the desired changes to that
rule, and then click Change rule. For example, to change the first rule to
1. If (service not poor) or (food not rancid) then (tip is not cheap) (1)

Select the not check box under each variable, and then click Change rule.

The Format pop-up menu from the Options menu indicates that you are looking at the verbose form
of the rules. Try changing it to symbolic. You will see

1. (service==poor) | (food==rancid) => (tip=cheap) (1)

2. (service==good) => (tip=average) (1)

3. (service==excellent) | (food==delicious) => (tip=generous) (1)

There is not much difference in the display really, but it is slightly more language neutral, because it
does not depend on terms like if and then. If you change the format to indexed, you see an extremely
compressed version of the rules.

11,1(1):2

20,2(1):1

32,3(1):2

This is the version of the rules that the machine deals with.

* The first column in this structure corresponds to the input variables.

* The second column corresponds to the output variable.

* The third column displays the weight applied to each rule.

* The fourth column is shorthand that indicates whether this is an OR (2) rule or an AND (1) rule.
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* The numbers in the first two columns refer to the index number of the membership function.

A literal interpretation of rule 1 is "If input 1 is MF1 (the first membership function associated with
input 1) or if input 2 is MF1, then output 1 should be MF1 (the first membership function associated
with output 1) with the weight 1."

The symbolic format does not consider the terms, if, then, and so on. The indexed format doesn't even
bother with the names of your variables. Obviously the functionality of your system doesn't depend on
how well you have named your variables and membership functions. The whole point of naming
variables descriptively is, as always, making the system easier for you to interpret. Thus, unless you
have some special purpose in mind, it is probably be easier for you to continue with the verbose
format.

At this point, the fuzzy inference system has been completely defined, in that the variables,
membership functions, and the rules necessary to calculate tips are in place. Now, look at the fuzzy
inference diagram presented at the end of the previous section and verify that everything is behaving
the way you think it should. You can use the Rule Viewer, the next of the Ul tools we'll look at. From
the View menu, select Rules.

The Rule Viewer

<} Rule ¥iewer: tipper 10| =|

File Edit WYiew Options

service =5 food =3
1 \
: A

tin =15

A

Irnpoit:

5 5] Plot points: I:lm Iloeve: left | right | downl up |

Rule 2. If (service iz good) then (tip is average) (1)

Help | Cloze |

The Rule Viewer displays a roadmap of the whole fuzzy inference process. It is based on the fuzzy
inference diagram described in the previous section. You see a single figure window with 10 plots
nested in it. The three plots across the top of the figure represent the antecedent and consequent of
the first rule. Each rule is a row of plots, and each column is a variable. The rule numbers are
displayed on the left of each row. You can click on a rule number to view the rule in the status line.
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* The first two columns of plots (the six yellow plots) show the membership functions referenced by
the antecedent, or the if-part of each rule.

* The third column of plots (the three blue plots) shows the membership functions referenced by the
consequent, or the then-part of each rule.

Notice that under food, there is a plot which is blank. This corresponds to the characterization of
none for the variable food in the second rule.

* The fourth plot in the third column of plots represents the aggregate weighted decision for the
given inference system.

This decision will depend on the input values for the system. The defuzzified output is displayed as
a bold vertical line on this plot.

The variables and their current values are displayed on top of the columns. In the lower left, there is
a text field Input in which you can enter specific input values. For the two-input system, you will
enter an input vector, [9 8], for example, and then press Enter. You can also adjust these input
values by clicking on any of the three plots for each input. This will move the red index line
horizontally, to the point where you have clicked. Alternatively, you can also click and drag this line in
order to change the input values. When you release the line, (or after manually specifying the input),
a new calculation is performed, and you can see the whole fuzzy inference process take place:

* Where the index line representing service crosses the membership function line "service is poor"
in the upper-left plot determines the degree to which rule one is activated.

* A yellow patch of color under the actual membership function curve is used to make the fuzzy
membership value visually apparent.

Each of the characterizations of each of the variables is specified with respect to the input index line
in this manner. If you follow rule 1 across the top of the diagram, you can see the consequent "tip is
cheap" has been truncated to exactly the same degree as the (composite) antecedent — this is the
implication process in action. The aggregation occurs down the third column, and the resultant
aggregate plot is shown in the single plot appearing in the lower right corner of the plot field. The
defuzzified output value is shown by the thick line passing through the aggregate fuzzy set.

You can shift the plots using left, right, down, and up. The menu items allow you to save, open, or
edit a fuzzy system using any of the five basic UI tools.

The Rule Viewer allows you to interpret the entire fuzzy inference process at once. The Rule Viewer
also shows how the shape of certain membership functions influences the overall result. Because it
plots every part of every rule, it can become unwieldy for particularly large systems, but, for a
relatively small number of inputs and outputs, it performs well (depending on how much screen space
you devote to it) with up to 30 rules and as many as 6 or 7 variables.

The Rule Viewer shows one calculation at a time and in great detail. In this sense, it presents a sort of
micro view of the fuzzy inference system. If you want to see the entire output surface of your system
— the entire span of the output set based on the entire span of the input set — you need to open up
the Surface Viewer. This viewer is the last of the five basic Fuzzy Logic Toolbox Ul tools. To open the
Surface Viewer, select Surface from the View menu.



Build Fuzzy Systems Using Fuzzy Logic Designer

The Surface Viewer

) surface Viewer: tipper 1Ol x|
File Edit Wiew Options

]
food T SErvice

W input): I service - I W (input): I faad - I I [output): tip -
¥ grids: I,15 Y grids: I,15

Ref.inpit | Plct points: Fm Hep | Close |

Ready

Upon opening the Surface Viewer, you see a three-dimensional curve that represents the mapping
from food and service quality to tip amount. Because this curve represents a two-input one-output
case, you can see the entire mapping in one plot. When we move beyond three dimensions overall, we
start to encounter trouble displaying the results.

Accordingly, the Surface Viewer is equipped with drop-down menus X (input), Y (input) and Z
(output) that let you select any two inputs and any one output for plotting. Below these menus are
two input fields X grids and Y grids that let you specify how many x-axis and y-axis grid lines you
want to include. This capability allows you to keep the calculation time reasonable for complex
problems.

By default, the surface plot updates automatically when you change the input or output variable
selections or the number of grid points. To disable automatic plot updates, in the Options menu,
clear the Always evaluate option. When this option is disabled, to update the plot, click Evaluate.

If you want to create a smoother plot, use the Plot points field to specify the number of points on
which the membership functions are evaluated in the input or output range. This field defaults to the
minimum number of plot plots, 101. If you specify fewer plot points, the field value automatically
resets to 101. When you specify the number of plot points, the surface plot automatically updates.

By clicking on the plot axes and dragging the mouse, you can manipulate the surface so that you can
view it from different angles.

The Ref. Input field is used in situations when there are more inputs required by the system than the
surface is mapping. You can edit this field to explicitly set inputs not specified in the surface plot.
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Suppose you have a four-input one-output system and would like to see the output surface. The
Surface Viewer can generate a three-dimensional output surface where any two of the inputs vary,
but two of the inputs must be held constant because computer monitors cannot display a five-
dimensional shape. In such a case, the input is a four-dimensional vector with NaNs holding the place
of the varying inputs while numerical values indicates those values that remain fixed.

The menu items allow you to open, close, save and edit a fuzzy system using the five basic UI tools.
You can access information about the Surface Viewer by clicking Help and close the Ul using Close.

Importing and Exporting Fuzzy Inference Systems

When you save a fuzzy system to a file, you are saving an ASCII text FIS file representation of that
system with the file suffix . fis. Do not manually edit the contents of a . fis file. Doing so can
produce unexpected results when loading the file. When you save your fuzzy system to the MATLAB
workspace, you are creating a variable that acts as a MATLAB object for the fuzzy system.

Note If you do not save your FIS to a file, but only save it to the MATLAB workspace, you cannot
recover it for use in a new MATLAB session.

See Also
Fuzzy Logic Designer

More About

. “Build Fuzzy Systems at the Command Line” on page 2-31
. “Simulate Fuzzy Inference Systems in Simulink” on page 5-2
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Build Fuzzy Systems at the Command Line

You can construct a fuzzy inference system (FIS) at the MATLAB® command line. This method is an
alternative to interactively designing your FIS using Fuzzy Logic Designer.

This example shows you how to create a Mamdani fuzzy inference system. While you create a
Mamdani FIS, the methods used apply to creating Sugeno systems as well.

Tipping Problem at the Command Line

To demonstrate the command-line functionality for creating and viewing fuzzy inference systems, this
example uses the tipper FIS.

fis = readfis('tipper.fis');

This command returns a mamfis object that contains the properties of the fuzzy system. For a
Sugeno system, this command returns a sugfis object.

You can access the FIS properties using dot notation. For example, view the inputs of the fuzzy
system.

fis.Inputs

ans =
1x2 fisvar array with properties:

Name
Range
MembershipFunctions
Details:
Name Range MembershipFunctions
1 "service" 0 10 {1x3 fismf}
2 “food" 0 10 {1x2 fismf}

To set the properties of your fuzzy system, use dot notation. For example, set the name of the FIS.
fis.Name = "gratuity";

FIS Object

You represent fuzzy inference systems using mamfis and sugfis objects. These objects contain all
the fuzzy inference system information, including the variable names, membership function
definitions, and fuzzy inference methods. Each FIS is itself a hierarchy of objects. The following
objects are used within a fuzzy system:

+ fisvar objects represent both input and output variables.
+ fismf objects represent membership functions within each input and output variable.
» fisrule objects represent fuzzy rules that map inputs to outputs.

View all the information for a FIS by directly listing its properties.

fis
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fis =
mamfis with properties:

Name: "gratuity"
AndMethod: "min"
OrMethod: "max"
ImplicationMethod: "min"
AggregationMethod: "max"
DefuzzificationMethod: "centroid"
Inputs: [1x2 fisvar]
Outputs: [1x1 fisvar]
Rules: [1x3 fisrule]
DisableStructuralChecks: 0

See 'getTunableSettings' method for parameter optimization.

You can view the properties of the objects within a FIS object using dot notation. For example, view
the fisvar object for first input variable.

fis.Inputs(1)

ans =
fisvar with properties:

Name: "service"
Range: [0 10]
MembershipFunctions: [1x3 fismf]
Also, view the membership functions for this variable.
fis.Inputs(1l).MembershipFunctions

ans =
1x3 fismf array with properties:

Type
Parameters
Name
Details:

Name Type Parameters
1 "poor" "gaussmf" 1.5 0
2 "good" "gaussmf" 1.5 5
3 "excellent" "gaussmf" 1.5 10

System Display Functions

To get a high-level view of your fuzzy system from the command line, use the plotfis, plotmf, and
gensurf functions. plotfis displays the whole system as a block diagram, as shown in the Fuzzy
Logic Designer.

plotfis(fis)
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service (3) gratuity
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3 rules
tip (3]
food (2)

System gratuity: 2 inputs, 1 cutputs, 3 ules

The plotmf function plots all the membership functions associated with a given variable. For
example, view the membership functions for the first input variable.

plotmf(fis, "input',1)
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Similarly, to view the membership functions for the first output, type:

plotmf(fis, 'output',1)
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plotmf does not support viewing the output membership functions for Sugeno systems.

To view the rules of the fuzzy system, type:
fis.Rules

ans =
1x3 fisrule array with properties:

Description
Antecedent
Consequent
Weight
Connection

Details:
Description

1 "service==poor | food==rancid => tip=cheap (1)"
2 "service==good => tip=average (1)"
3 "service==excellent | food==delicious => tip=generous (1)"

The gensurf function plots the output of the FIS for any one or two input variables.

gensurf(fis)
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4

food 0 o service
Build Fuzzy Inference System

As an alternative to using the Fuzzy Logic Designer app, you can construct a FIS entirely from the
command line.

First, create a Mamdani FIS, specifying its name.

fis = mamfis('Name',"tipper");

Add the first input variable for the service quality using addInput.
fis = addInput(fis, [0 10], 'Name', "service");

Add membership functions for each of the service quality levels using addMF. In this case, use
Gaussian membership functions. For more information on Gaussian membership function properties,
see gaussmf.

fis = addMF(fis, "service","gaussmf",[1.5 @], 'Name',"poor");
fis = addMF(fis, "service","gaussmf",[1.5 5], 'Name',"good");
fis = addMF(fis, "service","gaussmf",[1l.5 10], 'Name', "excellent");

Add the second input variable for the food quality, and add two trapezoidal membership functions.
For information on trapezoidal membership functions, see trapmf.

fis = addInput(fis, [0 10], 'Name', "food");
fis = addMF(fis,"food","trapmf",[-2 @ 1 3], 'Name',"rancid");
fis = addMF(fis,"food","trapmf",[7 9 10 12], 'Name', "delicious");
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Add the output variable for the tip, and add three triangular membership functions. For more
information on the triangular membership function, see trimf.

fis = addOutput(fis, [0 30], 'Name',"tip");

fis = addMF(fis,"tip","trimf",[0 5 10], 'Name', "cheap");

fis = addMF(fis,"tip","trimf",[10 15 20], 'Name', "average");
fis = addMF(fis,"tip","trimf",[20 25 30], 'Name',"generous");

Specify the following three rules for the FIS as a numeric array:

1 If (service is poor) or (food is rancid), then (tip is cheap).
2 If (service is good), then (tip is average).
3 If (service is excellent) or (food is delicious), then (tip is generous).

Each row of the array contains one rule in the following format.

* Column 1 - Index of membership function for first input

* Column 2 - Index of membership function for second input
* Column 3 - Index of membership function for output

* Column 4 - Rule weight (from 0 to 1)

* Column 5 - Fuzzy operator (1 for AND, 2 for OR)

For the membership function indices, indicate a NOT condition using a negative value. For more
information on fuzzy rule specification, see addRule.

ruleList = [1 111 2;
20211,
32312];

Add the rules to the FIS.

fis = addRule(fis, rulelList);

Alternatively, you can create the fuzzy inference system using a combination of dot notation and
fisvar, fismf, and fisrule objects. This method is not a good practice for most applications.
However, you can use this approach when your application requires greater flexibility in constructing
and modifying your FIS.

Create the fuzzy inference system.
fis = mamfis('Name', 'tipper');

Add and configure the first input variable. In this case, create a default fisvar object and specify its
properties using dot notation.

fis.Inputs(l) = fisvar;
fis.Inputs(1l).Name = "service";
fis.Inputs(1l).Range = [0 10];

Define the membership functions for the first input variable. For each MF, create a fismf object, and
set the properties using dot notation.

fis.Inputs(1l).MembershipFunctions(1l) = fismf;

fis.Inputs(1l).MembershipFunctions(1).Name = "poor";
fis.Inputs(1l).MembershipFunctions(1l).Type = "gaussmf";
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fis.Inputs(1l).MembershipFunctions(1)
fis.Inputs(1l).MembershipFunctions(2)
fis.Inputs(1l).MembershipFunctions(2)
fis.Inputs(1l).MembershipFunctions(2)
fis.Inputs(1l).MembershipFunctions(2)
fis.Inputs(1l).MembershipFunctions(3)
fis.Inputs(1l).MembershipFunctions(3)
fis.Inputs(1l).MembershipFunctions(3)
fis.Inputs(1l).MembershipFunctions(3)

.Parameters = [1.5 0];
= fismf;

.Name = "good";

.Type = "gaussmf";
.Parameters = [1.5 51;
= fismf;

.Name = "excellent";
.Type = "gaussmf";
.Parameters = [1.5 10];

Add and configure the second input variable. For this variable, specify the name and range when you

create the fisvar object.

fis.Inputs(2) = fisvar([0 10], 'Name',

"food");

Specify the membership functions for the second input. For each MF, specify the name, type, and
parameters when you create the fismf object.

fis.Inputs(2).MembershipFunctions(1)

fis.Inputs(2).MembershipFunctions(2)

fismf("trapmf",[-2 0 1 3],...
"Name', "rancid");
fismf("trapmf",[7 9 10 12],...

'Name',"delicious");

Similarly, add and configure the output variable and its membership functions.

fis.Outputs(l) = fisvar([0 30], 'Name',"tip");

In this case, specify the output membership functions using a vector of fismf objects.

'cheap");

mfl = fismf("trimf",[0 5 101, 'Name','
mf2 = fismf("trimf",[10 15 20], 'Name', "average");
mf3 = fismf("trimf",[20 25 30], 'Name', "generous");
fis.Outputs(1l).MembershipFunctions =

[mfl mf2 mf3];

Create the rules for the fuzzy system. For each rule create a fisrule object. Then, specify the rules
using a vector of these objects. When creating a fisrule object using numeric values, you must

specify the number of inputs variables.

rulel = fisrule([1 1 1 1 21,2);
rule2 = fisrule([2 0 2 1 11,2);
rule3 = fisrule([3 2 3 1 21,2);
rules = [rulel rule2 rule3];

Before adding your rules to your fuzzy system, you must update them using the data in the FIS
object. Update the rules using the update function, and add them the fuzzy system.

rules = update(rules, fis);
fis.Rules = rules;

When constructing your fuzzy system, you can also specify custom membership functions and
inference functions. For more information, see “Build Fuzzy Systems Using Custom Functions” on

page 2-40.

Evaluate Fuzzy Inference System

To evaluate the output of a fuzzy system for a given input combination, use the evalfis command.
For example, evaluate fis using input variable values of 1 and 2.
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evalfis(fis,[1 2])

ans = 5.5586

You can also evaluate multiple input combinations using an array where each row represents one
input combination.

inputs = [3 5;

2 7;

3 1];
evalfis(fis,inputs)
ans = 3xI

12.2184
7.7885
8.9547

See Also
evalfis | gensurf |mamfis | plotfis |plotmf |sugfis

More About
. “Build Fuzzy Systems Using Fuzzy Logic Designer” on page 2-14
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Build Fuzzy Systems Using Custom Functions
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Build Fuzzy Inference Systems Using Custom Functions in Fuzzy Logic
Designer

When you build a fuzzy inference system, as described in “Fuzzy Inference Process” on page 1-20,
you can replace the built-in membership functions, inference functions, or both with custom
functions. In this section, you learn how to build a fuzzy inference system using custom functions in
the Fuzzy Logic Designer app.

To build a fuzzy inference system using custom functions in the Fuzzy Logic Designer app:

1

Open Fuzzy Logic Designer. At the MATLAB command line, type:

fuzzylLogicDesigner
Specify the number of inputs and outputs of the fuzzy system, as described in “Fuzzy Logic
Designer” on page 2-16.

Create custom membership functions, and replace the built-in membership functions with them,
as described in “Specify Custom Membership Functions” on page 2-41.

Membership functions define how each point in the input space is mapped to a membership value
between 0 and 1.

Create rules using the Rule Editor, as described in “The Rule Editor” on page 2-25.

Rules define the logical relationship between the inputs and the outputs.

Create custom inference functions, and replace the built-in inference functions with them, as
described in “Specify Custom Inference Functions” on page 2-45.

Inference methods include the AND, OR, implication, aggregation, and defuzzification methods.
This action generates the output values for the fuzzy system.

The next figure shows the tipping problem example where the built-in Implication,
Aggregation and Defuzzification functions are replaced with the custom functions,
customimp, customagg, and customdefuzz, respectively.
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6

4| Fuzzy Logic Designer: tipper E\@
File Edit View
. tipper
service
/ (mamdani)
XX tip
food
FIS Name: tipper FIS Type: mamdani
And method — - Current Variable
Or method max - || MName
L Type
Implication customimp -
........................................ Range

Aggregation customagg
Defuzzification customdefuzz =+ Help Close
Changing aggMethod to "customagg™

Select View > Surface to view the output of the fuzzy inference system in the Surface Viewer, as
described in “The Surface Viewer” on page 2-29.

Specify Custom Membership Functions

You can create custom membership functions and use them in the fuzzy inference process. The values
of these functions must lie between 0 and 1. For more information on the properties of membership
functions, see “Membership Functions” on page 1-9.

To create a custom membership function, and replace the built-in membership function:

1

Create a MATLAB function, and save it in your current working folder.
To learn how to create MATLAB functions, see “Scripts vs. Functions”.

The following code is an example of a multistep custom membership function, custmf1l, that
depends on eight parameters between 0 and 10.

% Function to generate a multi-step custom membership function
% using 8 parameters for the input argument x
function out = custmfl(x,params)

for i = 1l:length(x)
if x(i) < params(1)
y(1i) = params(1);
elseif x(i) < params(2)
y(1) = params(2);
elseif x(i) < params(3)
y(i) = params(3);

L[|

[
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elseif x(
y(1i)
elseif x(
y(1i)
elseif x(
y(1i)
elseif x(
y(1i)
elseif x(
y(1i)
else

) < params(4)
params(4);
) < params(5)
params(5);
) < params(6)
params(6);
) < params(7)
params(7);
) < params(8)
params(8);

[ | I

[

[ | I

end
out = 0.1*y'; % Scale the output to lie between 0 and 1.

end
2 Open the Fuzzy Logic Designer app.

fuzzylLogicDesigner

Fuzzy Logic Designer opens with the default FIS name, Untitled, and contains one input,
inputl, and one output, outputl.

3 In Fuzzy Logic Designer, select Edit > Membership Functions to open the Membership
Function Editor.

Three triangular-shaped membership functions for input1 are displayed by default.

4] Mermbership Function Editor: Untitled EI@

File Edit View

FIS Varlables i . _Membership function pl

; i miZ mi3

input!  ocutput1

T plot points: 181

=

incut variable “input1”

Current Variable Current Membership Function (click on MF to select)

Name input1 Name mf1

Type input Type trimf -
Range 01 Params [-0.4 0 0.4]

Display Range 0] Help Close

Ready
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To replace the default membership function with a custom function in the Membership Function
Editor:

b

Select Edit > Remove All MFs to remove the default membership functions for inputl.
Select Edit > Add Custom MF to open the Custom Membership Function dialog box.

4| Custom Membership Function EI@

Add customized membership function

MF name mi

W-File function name trimf

Parameter list [0051]

oK | Cancel |

To specify a custom function, in the Custom Membership Function dialog box:

In the MF name field, specify a name for the custom membership function. For this example,
use the name customMF1

Note When adding additional custom membership functions, specify a different MF name
for each function.

In the M-file function name field, specify the name of the custom membership function file.
In the Parameter list, specify the vector of parameters. For this example use the vector [0
124689 10].

These values determine the shape and position of the membership function, and the function
is evaluated using these parameter values.

Note The length of the parameter vector must be greater than or equal to the number of
parameters in the custom membership function.

Using the custmfl example in step 1, the Custom Membership Function dialog box looks
similar to the following figure.

4| Custom Mermbership Function EI@

Add customized membership function

MF name customiF1

W-File function name custm

Parameter list 0124689 1U]|
oK Cancel
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d Click OK to add the custom membership function.

e Specify both the Range and Display Range to be [0 10] to match the range of the custom
membership function.

The Membership Function Editor displays the custom membership function plot.

4] Mermbership Function Editor: Untitled EI@

File Edit View

lot points:
FIS Variables : : Membership function plots °*" *°= i

L customMF1

input!  ocutput1

incut variable “input1”

Current Variable Current Membership Function (click on MF to select)

Name input1 Name customMF1

Type input Type custmf1 -
Range 010 Params 0124688 10]

Display Range [0 10] Help Close

not a default mf type

This action also adds the custom membership function to the Rule Viewer, and makes it available
for creating rules for the fuzzy inference process. To view the custom function in the Rule Viewer,
select Edit > Rules in either Fuzzy Logic Designer or the Membership Function Editor.
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Help | Close |

6 To add custom membership functions for outputl, select it in the Membership Function Editor,
and repeat steps 4 and 5.

You can also add a custom membership function to a FIS at the MATLAB command line. For example,

to add custmf1l to the first input variable, inputl of the FIS, myFIS, and name it customMF1, type
the following:

myFIS = addMF(myFIS, "inputl","custmfl",[0 1 2 4 6 8 9 10], 'Name', "customMF1");

Specify Custom Inference Functions

You can replace the built-in AND, OR, implication, aggregation, and defuzzification inference methods
with custom functions. After you create the custom inference function, save it in your current
working folder. To learn how to build fuzzy systems using custom inference functions, see the “Build
Fuzzy Inference Systems Using Custom Functions in Fuzzy Logic Designer” on page 2-40 section.

The guidelines for creating and specifying the functions for building fuzzy inference systems are
described in the following sections.

* “Create Custom AND and OR Functions” on page 2-46

* “Create Custom Implication Functions” on page 2-46

* “Create Custom Aggregation Functions” on page 2-47

* “Create Custom Defuzzification Functions” on page 2-48

» “Steps for Specifying Custom Inference Functions” on page 2-48
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Create Custom AND and OR Functions

The custom AND and OR inference functions must operate column-wise on a matrix, in the same way
as the MATLAB functions max, min, or prod.

For a row or column vector X, min(x) returns the minimum element.

x =1[12 3 4];
min(x)

ans =
1

For a matrix X, min(x) returns a row vector containing the minimum element from each column.

x=1[1234;567 8;9 10 11 121;
min(x)

ans =
1 2 3 4

For N-D arrays, min(x) operates along the first non-singleton dimension.

The function min(x,y) returns an array that is same size as x and y with the minimum elements
from x or y. Either of the input arguments can be a scalar. Functions such as max, and prod operate
in a similar manner.

In the toolbox, the AND implication methods perform an element by element matrix operation, similar
to the MATLAB function min(x,vy).

a=1[12; 3 4];
b=1[22; 2 2];
min(a,b)
ans =

1 2

2 2

The OR implication methods perform an element by element matrix operation, similar to the MATLAB
function max(x,y).

Create Custom Implication Functions

Custom implication functions must operate in the same way as the MATLAB functions max, min, or
prod. Your custom implication function must be a T-norm fuzzy intersection operation. For more
information, see “Additional Fuzzy Operators” on page 1-14.

An implication function must support either one or two inputs because the software calls the function
in two ways:

* To calculate the output fuzzy set values using the firing strength of all the rules and the
corresponding output membership functions. In this case, the software calls the implication
function using two inputs, similar to the following example:

impvals = customimp(w, outputmf)

* w — Firing strength of multiple rules, specified as an nr-by-ns matrix. Here, nr is the number of
rules and ns is the number of samples of the output membership functions.
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w(:,j) = w(:,1) forallj. w(i,1) is the firing strength of the i* rule.

* outputmf — Output membership function values, specified as an nr-by-ns matrix. Here, nris
the number of rules and ns is the number of samples of the output membership functions.
outputmf (i, :) contains the data of the i output membership function.

» To calculate the output fuzzy value using the firing strength of a single rule and the corresponding
output membership function, for a given sample. In this case, the software calls the implication
function using one input, similar to the following example:

impval = customimp([w outputmf])

w and outputmf are scalar values representing the firing strength of a rule and the corresponding
output membership function value, for a given sample.

The following is an example of a bounded product custom implication function with binary mapping
T(a,b) = max{0,a+b -1}.[1]

function y = customimp(x1,x2)

if nargin ==
% x1 assumed to be non-empty column vector or matrix.
minVal = zeros(1l,size(x1,2));
y = ones(1l,size(x1,2));

for i
y

l:size(x1,1)
max(minVal,sum([y;x1(i,:)]1)-1);

end
else
% x1 and x2 assumed to be non-empty matrices.
minVal = zeros(1l,size(x1,2));
y = zeros(size(x1));

for i = 1l:size(x1,1)
y(i,:) = max(minVal,sum([x1(i,:);x2(i,:)])-1);

end

end

Note Custom implication functions are not supported for Sugeno-type systems.

Create Custom Aggregation Functions

The custom aggregation functions must operate in the same way as the MATLAB functions max, min,
or prod and must be of the form y = customagg(x). Your custom implication function must be a T-
conorm (S-norm) fuzzy intersection operation. For more information, see “Additional Fuzzy
Operators” on page 1-14.

x is an nv-by-nr matrix, which is the list of truncated output functions returned by the implication
method for each rule. nv is the number of output variables, and nr is the number of rules. The output
of the aggregation method is one fuzzy set for each output variable.

The following is an example of a bounded sum custom aggregation function with binary mapping
S(a,b) = min{a + b, 1}.[1]
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function y = customagg(x)

maxVal = ones(1,size(x,2));
y = zeros(1l,size(x,2));

for i = 1l:size(x,1)

y = min(maxVal,sum([y;x(i,:)1));
end
end

Note Custom aggregation functions are not supported for Sugeno-type systems.

Create Custom Defuzzification Functions

The custom defuzzification functions must be of the formy = customdefuzz(x,ymf), where x is
the vector of values in the membership function input range, and ymf contains the values of the
membership function for each x value.

The following is an example of a custom defuzzification function:
function defuzzfun = customdefuzz(x,ymf)

total area = sum(ymf);
defuzzfun = sum(ymf.*x)/total area;

end

Note Custom defuzzification functions are not supported for Sugeno-type systems.

Steps for Specifying Custom Inference Functions

After you create and save a custom inference function, specify the function in the fuzzy inference
system using the following steps:

1 In the lower-left panel of Fuzzy Logic Designer, select Custom from the drop-down menu
corresponding to the inference method for which you want to specify the custom function.
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|4 Fuzzy Logic Designer: Untitled E\@
File Edit View
Untitled
(mamdani)
injpuit1 output
FIS Name: Untitled FIS Type: mamdani
And method — - Current Variable
Or method max - || MName
T
Implication ube
Range
Aggregation
Defuzzification Help Close
System "Untitled™ 1 input, 1 output, and 0 rules

Doing so opens a dialog box where you specify the name of the custom inference function.

2 Inthe Method name field, specify the name of the custom inference function, and click OK.

—

4

(=[O /=)

Add customized imphethod

Method name

custo mirnp|

oK

Cancel |

The custom function replaces the built-in function when building the fuzzy inference system.

Note In order to specify a custom inference function, you must first add at least one rule to your

FIS.

3 To specify custom functions for other inference methods, repeat steps 1 and 2.

You can also specify custom inference functions for a FIS (myFIS) at the MATLAB command line. For
example, to add a custom:

» Defuzzification method, type

myFIS.DefuzzificationMethod = "customdefuzz";

where customdefuzz is the name of the custom defuzzification function.
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* Implication method, type
myFIS.ImplicationMethod = "customimp";

where customimp is the name of the custom implication function.
* Aggregation method, type

myFIS.AggregationMethod = "customagg";

where customagg is the name of the custom aggregation function.

Specify Custom Type-Reduction Functions

For type-2 fuzzy inference systems, you can specify a custom type-reduction function. This function
must be of the form y = customtr(x,umf, lmf), where x is the vector of values in the membership
function input range. umf and Imf are the respective values of the upper and lower membership
function for each x value. The output y is a two-element row vector of centroids [c;,cg].

For more information on type reduction, see “Type-2 Fuzzy Inference Systems” on page 2-7.

By default, type-2 Sugeno systems support only a weighted average form of type reduction. The
following custom type-reduction function implements a weighted sum form of type reduction for a
Sugeno system.

function y = customtr(x,umf,ymf)

y = zeros(1,2);

y(1l) = sum(x.*umf);
y(2) = sum(x.*lmf);
end

To specify the custom type-reduction function for a FIS (myFIS) at the MATLAB command line, type
myFIS.DTypeReductionMethod = "customtr";

where customtr is the name of the custom defuzzification function.

Use Custom Functions in Code Generation

You can use custom functions in fuzzy inference systems for which you generate code. For more
information on code generation for fuzzy systems, see “Deploy Fuzzy Inference Systems” on page 6-
2.

If you use a nondouble data type for your generated code, you must propagate the data type from the
input arguments of your custom function to the output argument. For example, the following custom
aggregation function maintains the data type of x in y using the ones and zeros with the 'like'
argument.

function y = customagg(x)

maxVal = ones(1,size(x,2), ' 'like',x);
y = zeros(1l,size(x,2), 'like',x);
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for i = 1l:size(x,1)

y = min(maxVal,sum([y;x(i,:)1));
end
end

For more information on writing functions that support C/C++ code generation, see “MATLAB
Programming for Code Generation” (MATLAB Coder).

References
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As the number of inputs to a fuzzy system increases, the number of rules increases exponentially. This
large rule base reduces the computational efficiency of the fuzzy system. It also makes the operation
of the fuzzy system harder to understand, and it makes the tuning of rule and membership function
parameters more difficult. Because many applications have a limited amounts of training data, a large
rule base reduces the generalizability of tuned fuzzy systems.

To overcome this issue, you can implement a fuzzy inference system (FIS) as a tree of smaller
interconnected FIS objects rather than as a single monolithic FIS object. These fuzzy trees are also
known as hierarchical fuzzy systems because the fuzzy systems are arranged in hierarchical tree
structures. In a tree structure, the outputs of the low-level fuzzy systems are used as inputs to the
high-level fuzzy systems. A fuzzy tree is more computationally efficient and easier to understand than
a single FIS with the same number of inputs.

Types of Hierarchical Structures

There are several fuzzy tree structures that you can use for your application. The following figure
shows commonly used fuzzy tree structures: an incremental, aggregated, or cascaded structure.

Yu Wi

1 o

FIS,* l FIS,*

FIS,'

L

. . . ! .1 [ 1, 3
X1z X1z Xn X2 X2 X2z X1 X2 X2 X232 X2

{a) Incremental (b} Aggregated () Cascaded (combined)

Incremental Structure

In an incremental structure, input values are incorporated in multiple stages to refine the output
values in several levels. For example, the previous figure shows a three-level incremental fuzzy tree
having fuzzy inference systems FIS!', where i indicates the index of a FIS in the nth level. In an

incremental fuzzy tree, i = 1, meaning that each level has only one fuzzy inference system. In the
previous figure, the jth input of the ith FIS in the nth level is shown as input x;jn, whereas the kth

output of the ith FIS in the nth level is shown as input xjn. In the figure, n =3,j=1o0r2, and k = 1.
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If each input has m membership functions (MFs), each FIS has a complete set of m? rules. Hence, the
total number of rules is nm? = 3 [] 32 = 27.

The following figure shows a monolithic (n = 1) FIS with four inputs (j=1, 2, 3, 4) and three MFs (m =
3).

o1

1 1 1 1
R0 X1z X3 Xy

In the FIS of this figure, the total number of rules is nm* = 1 [] 3* = 81. Hence, the total number of
rules in an incremental fuzzy tree is linear with the number of input pairs.

Input selection at different levels in an incremental fuzzy tree uses input rankings based on their
contributions to the final output values. The input values that contribute the most are generally used
at the lowest level, while the least influential ones are used at the highest level. In other words, low-
rank input values are dependent on high-rank input values.

In an incremental fuzzy tree, each input value usually contributes to the inference process to a
certain extent, without being significantly correlated with the other inputs. For example, a fuzzy
system forecasts the possibility of buying an automobile using four inputs: color, number of doors,
horse power, and autopilot. The inputs are four distinct automobile features, which can independently
influence a buyer’s decision. Hence, the inputs can be ranked using the existing data to construct a
fuzzy tree, as shown in the following figure.

color —=
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doors — fis 1 /output] |
= .
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| R lil153—s- prediction
autopilot |

For an example that illustrates creating an incremental fuzzy tree in MATLAB, see the "Create
Incremental FIS Tree" example on the fistree reference page.

Aggregated Structure

In an aggregated structure, input values are incorporated as groups at the lowest level, where each
input group is fed into a FIS. The outputs of the lower level fuzzy systems are combined (aggregated)
using the higher level fuzzy systems. For example, the following shows a two-level aggregated fuzzy

tree having fuzzy inference systems FIS,-’;I, where i, indicates the index of a FIS in the nth level.
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Aggregated

In this aggregated fuzzy tree, i; = 1,2 and i, = 1. Hence, each level includes a different number of
FIS. The jth input of the i,th FIS is shown in the figure as input x; j, and the kth output of the i,th FIS

is shown as output y; k. In the figure, j = 1,2 and k = 1. In other words, each FIS has two inputs and

one output. If each input has m MFs, then each FIS has a complete set of m? rules. Hence, the total
number of rules for the three fuzzy systems is 3 m? = 3 ] 32 = 27, which is the same as an
incremental FIS for a similar configuration.

In an aggregated fuzzy tree, input values are naturally grouped together for specific decision-making.
For example, an autonomous robot navigation task combines obstacle avoidance and target reaching
subtasks for collision-free navigation. To achieve the navigation task, the fuzzy tree can use four
inputs: distance to the closest obstacle, angle of the closest obstacle, distance to the target, and angle
of the target. Distances and angles are measured with respect to the current position and heading
direction of the robot. In this case, at the lowest level, the inputs naturally group as shown in the
following figure: obstacle distance and obstacle angle (group 1) and target distance and target angle
(group 2). Two fuzzy systems separately process individual group inputs and then another fuzzy
system combines their outputs to produce a collision-free heading for the robot.
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fis3/input2

dist,, >
fis2
angle,,, —

For an example that illustrates creating an aggregated fuzzy tree in MATLAB, see the example Create
Aggregated FIS Tree on the fistree reference page.

Variation on Aggregated Structure

In a variation of the aggregated structure known as parallel structure [1], the outputs of the lowest-
level fuzzy systems are directly summed to generate the final output value. The following figure
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shows an example of a parallel fuzzy tree, where outputs of fisl and fis2 are summed to produce
the final output.

fis linput] —

fisl|
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fis2/input2 — |
.|

The fistree object does not provide the summing node X. Therefore, you must add a custom
aggregation method to evaluate a parallel fuzzy tree. For an example, see the "Create and Evaluate
Parallel FIS Tree" example on the fistree reference page.

Cascaded or Combined Structure

A cascaded structure, also known as combined structure, combines both incremental and aggregated
structures to construct a fuzzy tree. This structure is suitable for a system that includes both
correlated and uncorrelated inputs. The tree groups the correlated inputs in an aggregated structure,
and adds uncorrelated inputs in an incremental structure. The following figure shows an example of a
cascaded tree structure, where the first four inputs are grouped pairwise in an aggregated structure
and the fifth input is added in an incremental structure.
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A

! .1
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Cascaded (combined)
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For example, consider the robot navigation task discussed in “Aggregated Structure” on page 2-53.
Suppose that task includes another input, the previous heading of the robot, taken into account to
prevent large changes in the robot heading. You can add this input using the incremental structure of
the following diagram.
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For an example that illustrates creating an aggregated fuzzy tree in MATLAB, see the "Create
Cascaded FIS Tree" example on the fistree reference page.

Add or Remove FIS Tree Outputs

When you evaluate a fistree object, it returns results for only the open outputs, which are not
connected to any FIS inputs in the fuzzy tree. You can optionally access other outputs in the tree. For
instance, in the following diagram of an aggregated fuzzy tree, you might want to obtain the output of
fis2 when you evaluate the tree.
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—= fis2/output]
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You can add such outputs to a fistree object. You can also remove outputs, provided that the fuzzy
tree always has at least one output. For an example, see the "Update FIS Tree Outputs" example on
the fistree reference page.

Use the Same Value for Multiple inputs of FIS Tree

A fistree object allows using the same value for multiple inputs. For instance, in the following
figure, input2 of fisl and inputl of fis2 use the same value during evaluation.
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For an example showing how to construct a FIS tree in this way, see the "Use Same Value for Multiple
Inputs of a FIS Tree" example on the fistree reference page.

Update Fuzzy Inference Systems in FIS Tree

You can add or remove individual FIS elements from a fistree object. When you do so, the software
automatically updates the Connections, Inputs, and Outputs properties of the fistree object.
For an example, see the "Update Fuzzy Inference Systems in a FIS Tree" example on the fistree
reference page.

Tune a Fuzzy Tree
Once you have configured the internal connections in your fuzzy tree, the next step is to tune the

parameters of the tree. For an example, see “Tune FIS Tree for Gas Mileage Prediction” on page 3-
37.
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. “Tuning Fuzzy Inference Systems” on page 3-2
. “Tune FIS Tree for Gas Mileage Prediction” on page 3-37

2-57



2 Fuzzy Inference System Modeling

Fuzzy PID Control with Type-2 FIS

This example compares a type-2 fuzzy PID controller with both a type-1 fuzzy PID controller and
conventional PID controller. This example is adapted from [1].

Fuzzy PID Control

This example uses the following fuzzy logic controller (FLC) structure as described in [1]. The output
of the controller (u) is found using the error (e) and the derivative of the error (¢). Using scaling
factors C, and Cy, inputs e and é are normalized to F and AE, respectively. The normalized ranges for
both inputs are in the range [-1,1]. The fuzzy logic controller also produces a normalized output in the
range [-1,1]. Additional scaling factors Cy and C; map the fuzzy logic controller output U into u.

Fuzzy PID controller

rot e C E
_(./ ! ¢ | » C,
A Fuzzy U - y
i Logic +
& AE Controller | C,
> Jd/dt »> C, >

This example uses a delayed first-order system G(s) as the plant model.

B Ce—LS
G() = 5771
Here, C, L, and T are the gain, time delay, and time constant, respectively.

The scaling factors Cy, Cp, and C; are defined as follows, where 7. is the closed-loop time constant.

Cy= min(T, %) x C,

_ 1
O e Cfret )

Ci1 = max(T, %) x Cy

The input scaling factorC, is:

_ 1
Ce = Tt —y&)

where r(t;) and y(t;) are the reference and system output values at time t = t,.. These values
correspond to the nominal operating point of the system.

This example compares the performance of type-1 and type-2 Sugeno fuzzy inference systems (FISs)
using the Fuzzy Logic Controller Simulink® block.
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Construct Type-1 FIS

Create a type-1 FIS using sugfis.
fisl = sugfis;

Add input variables to the FIS.

fisl
fisl

addInput(fisl,[-1 17, 'Name','E");
addInput(fisl,[-1 1], 'Name', 'delE"');

Add three uniformly distributed overlapping triangular membership functions (MFs) to each input.
The MF names stand for negative (N), zero (Z), and positive (P).

fisl = addMF(fisl, 'E', "trimf',[-2 -1 O], 'Name','N');
fisl = addMF(fisl,'E', "trimf',[-1 0 1], 'Name','Z');
fisl = addMF(fisl,'E', "trimf',[0 1 2], 'Name','P"');

fisl = addMF(fisl, 'delE', 'trimf',[-2 -1 O], 'Name','N');
fisl = addMF(fisl, 'delE"', 'trimf',[-1 © 1], 'Name','Z");
fisl = addMF(fisl, 'delE', 'trimf',[0 1 2], 'Name','P');

Plot the input membership functions.

figure

subplot(1,2,1)
plotmf(fisl, "input',1)
title('Input 1)
subplot(1,2,2)
plotmf(fisl, "input',2)
title('Input 2')

2-59



2 Fuzzy Inference System Modeling

Degree of membership
Degree of membership

-1 0.5 0 0.5 1 -1 0.5 0 0.5 1

Add the output variable to the FIS.
fisl = addOutput(fisl,[-1 1], 'Name','U');

Add uniformly distributed constant functions to the output. The MF names stand for negative big
(NB), negative medium (NM), zero (Z), positive medium (PM), and positive big (PB).

fisl = addMF(fisl,'U', 'constant',-1, 'Name', 'NB');
fisl = addMF(fisl,'U', 'constant',-0.5, 'Name', 'NM"');
fisl = addMF(fisl,'U', 'constant',0, 'Name','Z");
fisl = addMF(fisl,'U', 'constant',0.5, 'Name', 'PM');
fisl = addMF(fisl,'U', 'constant',1, 'Name', 'PB');

Add rules to the FIS. These rules create a proportional control surface.

rules = [...
"E==N & delE==N => U=NB";
"E==Z & delE==N => U=NM";
"E==P & delE==N => U=Z"; ...
"E==N & delE==Z => U=NM";
"E==Z & delE==Z => U=Z"; ...
"E==P & delE==Z => U=PM";
"E==N & delE==P => U=Z"; ...
"E==Z & delE==P => U=PM";
"E==P & delE==P => U=PB"

1;
fisl = addRule(fisl,rules);
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Plot the control surface.

figure
gensurf(fisl)
title('Control surface of type-1 FIS')

Control surface of type-1 FIS

Construct Type-2 FIS
Convert the type-1 FIS, fisl, to a type-2 FIS.
fis2 = convertToType2(fisl);

The type-2 Sugeno system, fis2, uses type-2 membership functions for the input variables and
type-1 membership functions for the output variables.

Define the footprint of uncertainty (FOU) for the input MFs as defined in [1]. To do so, set the lower
MF scaling factor for each MF For this example, set the lower MF lag values to 0.

= [0.2 0.9 0.2;0.3 0.9 0.3];

= 1l:length(fis2.Inputs)

for j = 1l:length(fis2.Inputs(i).MembershipFunctions)
fis2.Inputs(i).MembershipFunctions(j).LowerLag = 0;
fis2.Inputs(i).MembershipFunctions(j).LowerScale = scale(i,j);

Plot the type-2 input membership functions.
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figure

subplot(1,2,1)
plotmf(fis2, 'input',1)
title('Input 1')
subplot(1,2,2)
plotmf(fis2, 'input',2)
title('Input 2')

Input 1 Input 2
1.4 p- 14 p-
UppatiF UppertdF
—— LowerddF — LowerddF
127 FOU ' 1.2} FOU ]
M Z P
1 1

i e
& &
o0&y T soay
£ £
£ £
S 06 . 5 06|
k] [uk]
g g
Toal 1 T4l
= 04 & 0.4

0.z 0.2

] 0
1 £.5 0 0.5 1 -1 0.5 0 0.5 1
E delE

The FOU adds additional uncertainty to the FIS and produces a nonlinear control surface.
figure

gensurf(fis2)
title('Control surface of type-2 FIS')
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Control surface of type-2 FIS

Conventional PID Controller

This example compares the fuzzy logic controller performance with that of the following conventional
PID controller.

_ K; Kgs

Here, K}, is proportional gain, K; is integrator gain, K, is derivative gain, and ty is the derivative filter
time constant.
Configure Simulation

Define the nominal plant model.

C =0.5;
L =0.5;
T =20.5;
G = tf(C,[T 1], 'Outputdelay',L);

Generate the conventional PID controller parameters using pidtune.
pidController = pidtune(G, 'pidf');

In this example, the reference (r) is a step signal and t, = 0, which results in C, = 1 as follows.

11
Ce= 1=y ~ T-0- L

2-63



2 Fuzzy Inference System Modeling

Ce = 1;

To configure the simulation, use the following nominal controller parameters.

tauC = 0.2;
Cd = min(T,L/2)*Ce;
CO = 1/(C*Ce*(tauC+L/2));

max(T,L/2)*C0O;
To simulate the controllers, use the comparepidcontrollers Simulink model.

model = 'comparepidcontrollers';
load_system(model)
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Type-2 Fuzzy PID

Simulate Nominal Process

Simulate the model at the nominal operating conditions.
outl = sim(model);

Plot the step response of the system for all three controllers.

plotOutput(outl, [ 'Nominal: C=' num2str(C) ', L=' num2str(L) ', T=' num2str(T)])
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Mominal: C=0.5, L=0.5, T=0.5
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Obtain the step-response characteristics of the system for each controller.
stepResponseTable(outl)
ans=3x4 table

Rise Time (sec) Overshoot (%) Settling Time (sec) Integral of Absolut
PID 0.62412 11.234 4.5564 1.04
Type-1 FLC 1.4267 0 4.1023 1.1522
Type-2 FLC 1.8662 0 5.129 1.282

For the nominal process:
* Both the type-1 and type-2 fuzzy logic controllers outperform the conventional PID controller in
terms of overshoot.

* The conventional PID controller, performs better with respect to rise-time and integral of absolute
error (IAE).

* The type-1 FLC performs better than the type-2 FLC in terms of rise-time, settling-time, and IAE.
Simulate Modified Process

Modify the plant model by increasing the gain, time delay, and time constant values as compared to
the nominal process.

C 0.85;
L 0.6;
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T

0.6;
G=t

£(C, [T 11, 'Outputdelay’,L);

Simulate the model using the updated plant parameters.
out2 = sim(model);
Plot the step response of the system for all three controllers.

plotOutput(out2,['Modified 1: C=' num2str(C) ',L=' num2str(L) ',T=' num2str(T)])

Modified 1: C=0.85,L=0.6,T=0.6
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Obtain the step-response characteristics of the system for each controller.
stepResponseTable(out?2)

ans=3x4 table

Rise Time (sec) Overshoot (%) Settling Time (sec) Integral of Absolut
PID 0.38464 80.641 29.452 4.7486
Type-1 FLC 0.47262 24.877 4.6788 1.1137
Type-2 FLC 0.47262 22.787 3.4561 1.076

For this modified process:

* The conventional PID controller exhibits significant overshoot, larger settling-time, and higher IAE
as compared to the fuzzy logic controllers
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» For all performance measures, the type-2 FLC produces the same or superior performance
compared to the type-1 FLC.

Conclusion

Overall, the type-1 FLC produces superior performance for the nominal plant as compared to the
conventional PID controller. The type-2 FLC shows more robust performance for the modified plant.

The robustness of the conventional PID controller can be improved using different methods, such as
prediction or multiple PID controller configurations. On the other hand, the performance of a type-2
FLC can be improved by using a different:

¢ Rulebase
e  Number of rules
« FOU

For example, you can create a type-2 FLC that defines the FOU using both the lower MF scaling
factor and lower MF lag.

For fis2, set the lower MF scale and lag values to 0.7 and 0. 1, respectively for all input
membership functions.

for i = 1l:length(fis2.Inputs)
for j = 1l:length(fis2.Inputs(i).MembershipFunctions)
fis2.Inputs(i).MembershipFunctions(j).LowerScale

0.7;
fis2.Inputs(i).MembershipFunctions(j).LowerLag 1;

0.1;
end
end

Plot the updated membership functions.

figure

subplot(1,2,1)
plotmf(fis2, "input',1)
title('Input 1)
subplot(1,2,2)
plotmf(fis2, "input',2)
title('Input 2')
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Simulate the model using the nominal plant, and plot the step responses for the controllers.

C .

0
0
0
t

5;
L 5;

T 5;

G f(C,[T 1], 'Outputdelay',L);

out4 = sim(model);

close system(model,0)
plotOutput(out4,['Nominal: C=' num2str(C) ',

L=

num2str(L)

’ T=I

num2str(T)])
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Mominal: C=0.5, L=0.5, T=0.5
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Obtain the step-response characteristics of the system for each controller.
stepResponseTable(out4)

ans=3x4 table

Rise Time (sec) Overshoot (%) Settling Time (sec) Integral of Absolut
PID 0.62412 11.234 4.5564 1.04
Type-1 FLC 1.4267 0 4.1023 1.1522
Type-2 FLC 1.2179 0 3.8746 1.1087

In this case, the updated FOU of type-2 FLC improves the rise-time of the step response .

However, the lower MF lag values also increase the overshoot in the case of the modified plant.

C = 0.85;

L =20.6;

T =20.6;

G = tf(C,[T 11, 'Outputdelay',L);

out5 = sim(model);
plotOutput(out5, [ 'Nominal: C=' num2str(C) ', L=' num2str(L) ', T=' num2str(T)])
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Nominal: C=0.85, L=0.6, T=0.6
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stepResponseTable(out5)
ans=3x4 table
Rise Time (sec) Overshoot (%) Settling Time (sec) Integral of Absolut
PID 0.38464 80.641 29.452 4.7486
Type-1 FLC 0.47262 24.877 4.6788 1.1137
Type-2 FLC 0.47262 26.699 4.6812 1.1278

Therefore, to obtain desired step response characteristics, you can vary the lower MF scale and lag
values to find a suitable combination.

You can further improve the fuzzy logic controller outputs using a Mamdani type FIS since it also
provides lower MF scale and lag parameters for output membership functions. However, a Mamdani
type-2 FLC introduces additional computational delay due to the expensive type-reduction process.

References

[1] Mendel, J. M., Uncertain Rule-Based Fuzzy Systems: Introduction and New Directions, Second
Edition, Springer, 2017, pp. 229-234, 600-608.

Local Functions

function plotQutput(out,plotTitle)

figure
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plot([0 20],[1 11)

hold on
plot(out.yout{l}.Values)
plot(out.yout{2}.Values)
plot(out.yout{3}.Values)
hold off

grid minor

xlabel('Time (sec)')
ylabel('Output')
title(plotTitle)
legend(["Reference","PID","Type-1 FLC","Type-2 FLC"], 'Location', "best")
end

function t = stepResponseTable(out)

s = stepinfo(out.yout{1l}.Values.Data,out.yout{1l}.Values.Time);
stepResponseInfo(l).RiseTime = s.RiseTime;
stepResponseInfo(l).0vershoot = s.0Overshoot;
stepResponseInfo(l).SettlingTime = s.SettlingTime;
stepResponseInfo(1l).IAE = out.yout{4}.Values.Data(end);

_—~ o~ o~ —~

s = stepinfo(out.yout{2}.Values.Data,out.yout{2}.Values.Time);

stepResponseInfo(2).RiseTime = s.RiseTime;
stepResponseInfo(2).0vershoot = s.0Overshoot;
stepResponseInfo(2).SettlingTime = s.SettlingTime;
stepResponseInfo(2).IAE = out.yout{5}.Values.Data(end);

s = stepinfo(out.yout{3}.Values.Data,out.yout{3}.Values.Time);

stepResponseInfo(3).RiseTime = s.RiseTime;
stepResponseInfo(3).0vershoot = s.0Overshoot;
stepResponseInfo(3).SettlingTime = s.SettlingTime;
stepResponseInfo(3).IAE = out.yout{6}.Values.Data(end);

t = struct2table(stepResponselInfo, "RowNames", ["PID" "Type-1 FLC" "Type-2 FLC"1);
t.Properties.VariableNames{1} 'Rise Time (sec)';

t.Properties.VariableNames{2} [t.Properties.VariableNames{2} ' (%)'];
t.Properties.VariableNames{3} 'Settling Time (sec)';
t.Properties.VariableNames{4} '"Integral of Absolute Error';

end

See Also
mamfistype2 | sugfistype2

More About
. “Type-2 Fuzzy Inference Systems” on page 2-7
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This example shows how to use fuzzy logic for image processing. Specifically, this example shows how
to detect edges in an image.

An edge is a boundary between two uniform regions. You can detect an edge by comparing the
intensity of neighboring pixels. However, because uniform regions are not crisply defined, small
intensity differences between two neighboring pixels do not always represent an edge. Instead, the
intensity difference might represent a shading effect.

The fuzzy logic approach for image processing allows you to use membership functions to define the
degree to which a pixel belongs to an edge or a uniform region.

Import RGB Image and Convert to Grayscale
Import the image.
Irgb = imread('peppers.png');

Irgbisa 384 x 512 x 3 uint8 array. The three channels of Irgb (third array dimension) represent
the red, green, and blue intensities of the image.

Convert Irgb to grayscale so that you can work with a 2-D array instead of a 3-D array. To do so, use
the rgb2gray function.

Igray = rgb2gray(Irgb);

figure

image(Igray, 'CDataMapping', 'scaled')
colormap('gray")

title('Input Image in Grayscale')
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Input Image in Grayscale
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Convert Image to Double-Precision Data

The evalfis function for evaluating fuzzy inference systems supports only single-precision and
double-precision data. Therefore, convert Igray to a double array using the im2double function.

I = im2double(Igray);
Obtain Image Gradient

The fuzzy logic edge-detection algorithm for this example relies on the image gradient to locate
breaks in uniform regions. Calculate the image gradient along the x-axis and y-axis.

Gx and Gy are simple gradient filters. To obtain a matrix containing the x-axis gradients of I, you
convolve I with Gx using the conv2 function. The gradient values are in the [-1 1] range. Similarly, to
obtain the y-axis gradients of I, convolve I with Gy.

Gx = [-1 1];

Gy = Gx';

Ix = conv2(I,Gx, 'same');
Iy = conv2(I,Gy, 'same');

Plot the image gradients.

figure

image(Ix, 'CDataMapping', 'scaled")
colormap('gray"')

title('Ix")
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figure

image(Ily, 'CDataMapping', 'scaled")
colormap('gray"')

title('Iy")
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You can use other filters to obtain the image gradients, such as the Sobel operator or the Prewitt
operator. For information about how you can filter an image using convolution, see “What Is Image
Filtering in the Spatial Domain?” (Image Processing Toolbox)

Alternatively, if you have the Image Processing Toolbox software, you can use the imfilter (Image
Processing Toolbox), imgradientxy (Image Processing Toolbox), or imgradient (Image Processing
Toolbox) functions to obtain the image gradients.

Define Fuzzy Inference System (FIS) for Edge Detection
Create a fuzzy inference system (FIS) for edge detection, edgeFIS.
edgeFIS = mamfis('Name', 'edgeDetection');

Specify the image gradients, Ix and Iy, as the inputs of edgeFIS.

edgeFIS
edgeFIS

addInput(edgeFIS,[-1 1], 'Name', 'Ix');
addInput(edgeFIS,[-1 1], 'Name','Iy');

Specify a zero-mean Gaussian membership function for each input. If the gradient value for a pixel is
0, then it belongs to the zero membership function with a degree of 1.

sx = 0.1;
sy = 0.1;
edgeFIS = addMF(edgeFIS, 'Ix', 'gaussmf',[sx 0], 'Name', 'zero');
edgeFIS = addMF(edgeFIS, 'Iy', 'gaussmf',[sy 0], 'Name', 'zero');
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sx and sy specify the standard deviation for the zero membership function for the Ix and Iy inputs.
To adjust the edge detector performance, you can change the values of sx and sy. Increasing the
values makes the algorithm less sensitive to the edges in the image and decreases the intensity of the
detected edges.

Specify the intensity of the edge-detected image as an output of edgeFIS.
edgeFIS = addOutput(edgeFIS,[0 1], 'Name', 'Iout');

Specify the triangular membership functions, white and black, for Iout.

wa = 0.1;

wb = 1;

wc = 1;

ba = 0;

bb = 0;

bc = 0.7;

edgeFIS = addMF(edgeFIS, 'Tout', 'trimf',[wa wb wc], 'Name', 'white');
edgeFIS = addMF(edgeFIS, 'Tout', 'trimf',[ba bb bcl, 'Name', 'black');

As you can with sx and sy, you can change the values of wa, wb, wc, ba, bb, and bc to adjust the
edge detector performance. The triplets specify the start, peak, and end of the triangles of the
membership functions. These parameters influence the intensity of the detected edges.

Plot the membership functions of the inputs and outputs of edgeFIS.

figure

subplot(2,2,1)
plotmf(edgeFIS, "input',1)
title('Ix")

subplot(2,2,2)

plotmf (edgeFIS, "input"',2)
title('Iy")

subplot(2,2,[3 4])

plotmf (edgeFIS, 'output',1)
title('Iout"')
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Specify FIS Rules

Add rules to make a pixel white if it belongs to a uniform region and black otherwise. A pixel is in a
uniform region when the image gradient is zero in both directions. If either direction has a nonzero
gradient, then the pixel is on an edge.

ri "If Ix is zero and Iy is zero then Iout is white";

r2 "If Ix is not zero or Iy is not zero then Iout is black";
edgeFIS = addRule(edgeFIS,[rl r2]);

edgeFIS.Rules

ans =
1x2 fisrule array with properties:

Description
Antecedent
Consequent
Weight
Connection

Details:
Description

1 "Ix==zero & Iy==zero => Iout=white (1)
2 "Ix~=zero | Iy~=zero => Iout=black (1)"
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Evaluate FIS

Evaluate the output of the edge detector for each row of pixels in I using corresponding rows of Ix
and Iy as inputs.

Ieval = zeros(size(I));
for ii = 1:size(I,1)

Ieval(ii,:) = evalfis(edgeFIS, [(Ix(ii,:));(Iy(ii,:))1");
end

Plot Results

Plot the original grayscale image.

figure

image(I, 'CDataMapping', 'scaled')
colormap('gray"')

title('Original Grayscale Image')
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Plot the detected edges.

figure

image(Ieval, 'CDataMapping', 'scaled')
colormap('gray"')

title('Edge Detection Using Fuzzy Logic')
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Edge Detection Using Fuzzy Logic
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See Also
evalfis
More About

. “Build Fuzzy Systems at the Command Line” on page 2-31
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* “Tuning Fuzzy Inference Systems” on page 3-2

* “Tune Fuzzy Rules and Membership Function Parameters” on page 3-6
* “Tune Fuzzy Trees” on page 3-15

* “Customize FIS Tuning Process” on page 3-20

* “Tune Mamdani Fuzzy Inference System” on page 3-27

* “Tune FIS Tree for Gas Mileage Prediction” on page 3-37

» “FIS Parameter Optimization with K-fold Cross Validation” on page 3-50
* “Predict Chaotic Time Series Using Type-2 FIS” on page 3-57

* “Tune Fuzzy Robot Obstacle Avoidance System Using Custom Cost Function” on page 3-70
* “Classify Pixels Using Fuzzy Systems” on page 3-81

* “Autonomous Parking Using Fuzzy Inference System” on page 3-97

* “Neuro-Adaptive Learning and ANFIS” on page 3-114

* “Train Adaptive Neuro-Fuzzy Inference Systems” on page 3-120

* “Save Training Error Data to MATLAB Workspace” on page 3-130

* “Predict Chaotic Time-Series using ANFIS” on page 3-136

* “Modeling Inverse Kinematics in a Robotic Arm” on page 3-144

* “Adaptive Noise Cancellation Using ANFIS” on page 3-152

* “Nonlinear System Identification” on page 3-160

* “Gas Mileage Prediction” on page 3-173
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Tuning Fuzzy Inference Systems

Designing a complex fuzzy inference system (FIS) with a large number of inputs and membership
functions (MFs) is a challenging problem due to the large number of MF parameters and rules. To
design such a FIS, you can use a data-driven approach to learn rules and tune FIS parameters. To
tune a fuzzy system, use the tunefis function and configure the tuning process using a
tunefisOptions object.

Using Fuzzy Logic Toolbox software, you can tune both type-1 and type-2 FISs as well as FIS trees.
For examples, see “Predict Chaotic Time Series Using Type-2 FIS” on page 3-57 and “Tune FIS Tree
for Gas Mileage Prediction” on page 3-37.

During training, the optimization algorithm generates candidate FIS parameter sets. The fuzzy
system is updated with each parameter set and then evaluated using the input training data.

If you have input/output training data, the cost for each solution is computed based on the difference
between the output of the fuzzy system and the expected output values from the training data. For an
example that uses this approach, see Tune Mamdani Fuzzy Inference System on page 3-27.
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>  Fuzzy System
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output training

data

If you do not have input/output training data, you can specify a custom model and cost function for
evaluating candidate FIS parameter sets. The cost measurement function sends an input to the fuzzy
system and receives the evaluated output. The cost is based on the difference between the evaluated
output and the output expected by the model. For more information and an example that uses this
approach, see “Tune Fuzzy Robot Obstacle Avoidance System Using Custom Cost Function” on page
3-70.
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For more information on tuning fuzzy systems see the following examples.

* “Tune Fuzzy Rules and Membership Function Parameters” on page 3-6
* “Tune Fuzzy Trees” on page 3-15
* “Customize FIS Tuning Process” on page 3-20

Tuning Methods

The following table shows the tuning methods supported by the tunefis function. These tuning
methods find the optimal FIS parameters

Method Description More Information

Genetic algorithm Population-based global “What Is the Genetic Algorithm?”
optimization method that (Global Optimization Toolbox)
searches randomly by
mutation and crossover
among population members

Particle swarm optimization |Population-based global “What Is Particle Swarm
optimization method in which|Optimization?” (Global Optimization
population members step Toolbox)

throughout a search region
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Method Description More Information
Pattern search Direct-search local “What Is Direct Search?” (Global
optimization method that Optimization Toolbox)

searches a set of points near
the current point to find a
new optimum

Simulated annealing A local optimization method |“What Is Simulated Annealing?”
that simulates a heating and |(Global Optimization Toolbox)
cooling process to that finds
a new optimal point near the
current point

Adaptive neuro-fuzzy Back-propagation algorithm |“Neuro-Adaptive Learning and ANFIS”
inference that tunes membership on page 3-114

function parameters.
Alternatively, you can use the
anfis function.

The first four tuning methods require Global Optimization Toolbox software.

Global optimization methods, such as genetic algorithms and particle swarm optimization, perform
better for large parameter tuning ranges. These algorithms are useful for both the rule-learning and
parameter-tuning stages of FIS optimization.

On the other hand, local search methods, such as pattern search and simulated annealing, perform
better for small parameter ranges. If a FIS is generated from training data using genfis or a rule
base is already added to a FIS using training data, then these algorithms can produce faster
convergence compared to global optimization methods.

Prevent Overfitting of Tuned System

Data overfitting is a common problem in FIS parameter optimization. When overfitting occurs, the
tuned FIS produces optimized results for the training data set but performs poorly for a test data set.
To overcome the data overfitting problem, a tuning process can stop early based on an unbiased
evaluation of the model using a separate validation dataset.

When tuning using the tunefis function, you can prevent overfitting using k-fold cross validation. To
prevent For more information and an example, see “FIS Parameter Optimization with K-fold Cross
Validation” on page 3-50.

Improve Tuning Results

To improve the performance of your tuned fuzzy systems, consider the following guidelines.

* Use multiple phases in your tuning process. For example, first learn the rules of a fuzzy system,
and then tune input/output MF parameters using the learned rule base.

* Increase the number of iterations in both the rule-learning and parameter-tuning phases. Doing so
increases the duration of the optimization process and can also increase validation error due to
overtuned system parameters with the training data. To avoid overfitting, train your system using
k-fold cross validation.
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Change the clustering technique used by genfis. Depending on the clustering technique, the
generated rules can differ in their representation of the training data. Hence, the use of different
clustering techniques can affect the performance of tunefis.

Change FIS properties. Try changing properties such as the type of FIS, number of inputs, number
of input/output MFs, MF types, and number of rules. A Sugeno system has fewer output MF
parameters (assuming constant MFs) and faster defuzzification. Therefore, for fuzzy systems with
a large number of inputs, a Sugeno FIS generally converges faster than a Mamdani FIS. Small
numbers of MFs and rules reduce the number of parameters to tune, producing a faster tuning
process. Furthermore, a large number of rules might overfit the training data.

Modify tunable parameter settings for MFs and rules. For example, you can tune the support of a
triangular MF without changing its peak location. Doing so reduces the number of tunable
parameters and can produce a faster tuning process for specific applications. For rules, you can
exclude zero MF indices by setting the ALlowEmpty tunable setting to false, which reduces the
overall number of rules during the learning phase.

To improve the tuning results for fuzzy trees, consider the following guidelines.

You can separately tune the parameters of each FIS in a FIS tree. You can then tune all the fuzzy
systems together to generalize the parameter values.

Change FIS tree properties, such as the number of fuzzy systems and the connections between the
fuzzy systems.

Use different rankings and groupings of the inputs to a FIS tree. For more information about
creating FIS trees, see Fuzzy Trees.

See Also
genfis | getTunableSettings | tunefis

More About

“Tune Mamdani Fuzzy Inference System” on page 3-27
“Tune FIS Tree for Gas Mileage Prediction” on page 3-37
“Predict Chaotic Time Series Using Type-2 FIS” on page 3-57
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Tune Fuzzy Rules and Membership Function Parameters
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When tuning a fuzzy inference system (FIS) using the tunefis function, you can:

* Tune membership function parameters for input and output variables.
* Learn fuzzy rules.
* Tune the antecedent and consequent parameters of fuzzy rules.

For more information on tuning a FIS, see “Tuning Fuzzy Inference Systems” on page 3-2.

Tune Membership Function Parameters

For both type-1 and type-2 FISs, you can specify tunable parameter settings for the input and output
MFs and tune the values of the selected parameters. You can tune the parameters for any
combination of input and output MFs. This example shows an example workflow using a type-1 FIS.
For an example that tunes a type-2 FIS, see “Predict Chaotic Time Series Using Type-2 FIS” on page
3-57.

Create a FIS.

fis = mamfis;

fis = addInput(fis, [0 10], 'NumMFs',3);

fis = addOutput(fis, [0 1], 'NumMFs',3);

fis = addRule(fis,[1 11 1;1111;1111]1);

Extract input and output parameter settings from the FIS.
[in,out] = getTunableSettings(fis)

in =
VariableSettings with properties:

Type: "input"
VariableName: "inputl"
MembershipFunctions: [1x3 fuzzy.tuning.MembershipFunctionSettings]
FISName: "fis"

out =
VariableSettings with properties:

Type: "output"
VariableName: "outputl"”
MembershipFunctions: [1x3 fuzzy.tuning.MembershipFunctionSettings]
FISName: "fis"

The parameter settings are represented by VariableSettings objects that include the FIS name,
variable type, variable name, and MF parameter settings. Examine the parameter settings of MF 1 of
input 1.

in(1l).MembershipFunctions (1) .Parameters

ans =
NumericParameters with properties:
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Minimum: [-Inf -Inf -Inf]
Maximum: [Inf Inf Inf]
Free: [1 1 1]

For each parameter value of an input/output ME you can specify whether it is available for tuning
and its minimum and maximum values. By default, all MF parameters are free for tuning and their
ranges are set to [-Inf,Inf]. Make MF 1 of input 1 nontunable.

in(1l) .MembershipFunctions(1l) = setTunable(in(1l).MembershipFunctions(1),false);
Similarly, make the first parameter of MF 2 of input 1 nontunable.

in(1l) .MembershipFunctions(2).Parameters.Free(1l) = false;

Set minimum ranges for the second and third parameters of MF 3 of input 1 to 0.

in(1l) .MembershipFunctions(3).Parameters.Minimum(2:3) = 0;

Set maximum ranges for second and third parameters of MF 3 of input 1 to 15.
in(1).MembershipFunctions(3).Parameters.Maximum(2:3) = 15;

The default minimum and maximum range values of tunable MF parameters are set to corresponding
input/output ranges in the tuning process.

Finally, make the output nontunable.
out = setTunable(out, false);

Specify input and output training data. For this example, generate training data using the following
function.

_ |sin(2x)
ex/5
X = (0:0.1:10)';
y = abs(sin(2*x)./exp(x/5));

Specify options for tunefis. For this example, use the genetic algorithm tuning method.
options = tunefisOptions("Method","ga");

Specify a maximum of five generations for optimization.
options.MethodOptions.MaxGenerations = 5;

If you have Parallel Computing Toolbox™ software, you can improve the speed of the tuning process
by setting options.UseParallel to true. If you do not have Parallel Computing Toolbox software,
set options.UseParallel to false.

By default, tunefis uses root mean squared error (RMSE) for cost calculation. You can change the
cost function to norml or norm2 by setting options.DistanceMetric.

options.DistanceMetric = "norml";

Tune fis using the parameter settings, training data, and tuning options.
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rng('default') % for reproducibility
[fisout,optimout] = tunefis(fis, [in;out],x,y,options);

Best Mean Stall
Generation Func-count f(x) f(x) Generations
1 100 32.84 32.84 0
2 147 32.84 32.84 1
3 194 32.84 32.84 2
4 241 32.84 32.84 3
5 288 32.84 32.84 4
Optimization terminated: maximum number of generations exceeded.

fisout includes the updated parameter values. optimout provides additional outputs of the
optimization method and any error messages that are returned during the update process of the input
fuzzy system using the optimized parameter values.

optimout

optimout = struct with fields:
tuningOutputs: [1x1 struct]
totalFcnCount: 288
totalRuntime: 1.7459
errorMessage: [1]

optimout.tuningOutputs

ans = struct with fields:
x: [5 9.1667 5.8333 10 14.1667]
fval: 32.8363
exitflag: 0O
output: [1x1 struct]
population: [50x5 double]
scores: [50x1 double]

You can optionally tune fis using either just the input or output parameter settings. Since the output
parameter settings are set to nontunable, tuning the FIS with just the input parameter settings
produces the same results.

rng('default"')
[fisout,optimout] = tunefis(fis,in,x,y,options);

Best Mean Stall
Generation Func-count f(x) f(x) Generations
1 100 32.84 32.84 0
2 147 32.84 32.84 1
3 194 32.84 32.84 2
4 241 32.84 32.84 3
5 288 32.84 32.84 4
Optimization terminated: maximum number of generations exceeded.

optimout

optimout = struct with fields:
tuningOutputs: [1x1 struct]
totalFcnCount: 288
totalRuntime: 1.5220
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errorMessage: []

optimout.tuningOutputs

ans = struct with fields:

x: [5 9.1667 5.8333 10 14.1667]

fval: 32.8363
exitflag: ©
output: [1x1 struct]
population: [50x5 double]
scores: [50x1 double]

Tune Fuzzy Rules

In addition to tuning membership function parameters, you can tune the antecedent and consequent

parameters of the rules in a fuzzy system.

Obtain rule parameter settings from a fuzzy system using getTunableSettings.

[~,~,rule] = getTunableSettings(fis)

rule=3x1 object

3x1 RuleSettings array with properties:

Index
Antecedent
Consequent
FISName

Each rule parameter setting includes the FIS name, index of the rule in the FIS, and parameter
settings for the rule antecedent and consequent (the rule clauses).

The parameter settings for a rule clause include three options:

*  Whether the input/output MF indices are available for tuning. By default, clause parameters are

free for tuning.

*  Whether the clause allows use of NOT logic, in other words, whether it allows negative MF

indices. By default, rules do not allow NOT logic.

*  Whether the clause allows the absence of input/output variables, in other words, if it allows zero
MF indices. By default, the absence of a variable is allowed.

rule(l).Antecedent(1)

ans =
ClauseParameters with properties:

AllowNot: 0
AllowEmpty: 1
Free: 1

Allow NOT logic in the antecedent of rule 1.

rule(1l).Antecedent.AllowNot = true;
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Make the consequent of rule 1 not available for tuning.
rule(l).Consequent.Free = 0;

Do not allow absence of a variable in the consequent of rule 2.
rule(2).Consequent.AllowEmpty = false;

Set rule 3 as nontunable.

rule(3) = setTunable(rule(3),false);

Set options.DistanceMetric to norm2.
options.DistanceMetric = "norm2";

Tune fis using the rule parameter settings.

rng(‘'default’') % for reproducibility
fisout = tunefis(fis, rule,x,y,options);

Best Mean Stall
Generation Func-count f(x) f(x) Generations
1 100 1.648 2.575 0
2 147 1.648 2.448 1
3 194 1.648 2.212 2
4 241 1.648 2.052 3
5 288 1.648 1.874 4
Optimization terminated: maximum number of generations exceeded.

Since you specified rule 3 as nontunable, you can exclude rule 3 when you tune fis. Doing so
produces the same tuning result.

rng('default') % for reproducibility
fisout = tunefis(fis,rule(1:2),x,y,options);

Best Mean Stall
Generation Func-count f(x) f(x) Generations
1 100 1.648 2.575 0
2 147 1.648 2.448 1
3 194 1.648 2.212 2
4 241 1.648 2.052 3
5 288 1.648 1.874 4
Optimization terminated: maximum number of generations exceeded.

Learn Fuzzy Rules

You can configure tunefis to learn the rules of a fuzzy system. To do so, set the
OptimizationType option of tunefisOptions to learning.

fisin = fis;

fisin.Rules = [];

options.OptimizationType = 'learning’;

Set the maximum number of rules in the tuned FIS to three.
options.NumMaxRules = 3;

The size of the tuned rule base may be less than NumMaxRules, because tunefis removes duplicate
rules from the tuned FIS. If you do not specify NumMaxRules, then tunefis adds the maximum
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number of rules determined by the possible combinations of input MFs. The default input MF
combinations include zero MF indices, which allow absence of variables. The default combinations
exclude negative MF indices, so that NOT logic is not allowed.

Set options.DistanceMetric to rmse and tune the FIS.

options.DistanceMetric = "rmse";
rng('default') % for reproducibility
fisout = tunefis(fisin,[],x,y,options);

Best Mean Stall
Generation Func-count f(x) f(x) Generations
1 400 0.165 0.2956 0
2 590 0.165 0.2805 1
3 780 0.165 0.2578 2
4 970 0.165 0.2393 3
5 1160 0.165 0.2322 4
Optimization terminated: maximum number of generations exceeded.

During the tuning process, the FIS automatically learns rules after cost optimization with the training
data. Examine the tuned rules.

fisout.Rules

ans =
1x3 fisrule array with properties:

Description
Antecedent
Consequent
Weight
Connection

Details:
Description

1 "inputl==mf3 => outputl=mfl (1)"
2 "inputl==mfl => outputl=mf2 (1)"
3 "inputl==mf2 => outputl=mfl (1)"

You can remove some of the existing rules and learn additional rules.

fisout.Rules(2:end) = [];
rng('default') % for reproducibility
fisout = tunefis(fisin,[],x,y,options);

Best Mean Stall
Generation Func-count f(x) f(x) Generations
1 400 0.165 0.2956 0
2 590 0.165 0.2805 1
3 780 0.165 0.2578 2
4 970 0.165 0.2393 3
5 1160 0.165 0.2322 4
Optimization terminated: maximum number of generations exceeded.

fisout.Rules
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ans =
1x3 fisrule array with properties:

Description
Antecedent
Consequent
Weight
Connection

Details:
Description

=

"inputl==mf3 => outputl=mfl (1)"
"inputl==mfl => outputl=mf2 (1)"
3 "inputl==mf2 => outputl=mfl (1)"

N

You can also tune the antecedents and consequents of existing rules and learn new rules. To do so,
obtain the rule tunable parameter settings and pass them to the tunefis function.

fisout.Rules(2:end) = [];
fisout.Rules(1l).Antecedent = 1;
fisout.Rules(1l).Consequent = 1;
[~,~,rule] = getTunableSettings(fisout);
rng('default"')

fisout = tunefis(fisin, rule,x,y,options);

Best Mean Stall
Generation Func-count f(x) f(x) Generations
1 400 0.165 0.3063 0
2 590 0.165 0.2845 1
3 780 0.165 0.2549 2
4 970 0.165 0.2344 3
5 1160 0.165 0.2153 4
Optimization terminated: maximum number of generations exceeded.

fisout.Rules

ans =
1x3 fisrule array with properties:

Description
Antecedent
Consequent
Weight
Connection

Details:
Description

1 "inputl==mfl => outputl=mf2 (1)"
2 "inputl==mf2 => outputl=mfl (1)"
3 "inputl==mf3 => outputl=mfl (1)"
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Tune MF and Rule Parameters

You can tune all MF and rule parameters simultaneously. First obtain all parameter settings for the
FIS.

[in,out,rule] = getTunableSettings(fis);
Configure the tuning options.

options = tunefisOptions('Method','ga');
options.MethodOptions.MaxGenerations = 5;

Tune the MF and rule parameters of the FIS.

rng('default') % for reproducibility
fisout = tunefis(fis,[in;out;rule],x,y,options);

Best Mean Stall
Generation Func-count f(x) f(x) Generations
1 400 0.165 0.296 0
2 590 0.1638 0.2821 0
3 780 0.1625 0.2697 0
4 970 0.1625 0.2616 1
5 1160 0.1604 0.2512 0
Optimization terminated: maximum number of generations exceeded.

For a large fuzzy system, tuning all FIS parameters in the same tuning process can take several
iterations to obtain the expected results. To improve the tuning time, you can tune parameters using
the following two steps.

1 Tune or learn rule parameters only.

2  Tune both MF and rule parameters.

The learning and tuning rules is less computationally expensive due to the small number of rule
parameters. Therefore, the first step quickly converges to a fuzzy rule base during training. In the
second step, using the rule base from the first step as an initial condition improves convergence of
the parameter tuning process.

Generate FIS from Data and Tune

To generate an initial rule base for tuning, you can generate a FIS from your training data using the
genfis function. You can then optimize the FIS using tunefis. In this approach, the tuning process
can employ a local optimization method because the rule base is derived from the training data.

This example uses the same training data as the preceding examples.

Create options for genfis that specify five MFs, a Gaussian MF for the input, and a constant MF for
the output.

goptions = genfisOptions('GridPartition', 'NumMembershipFunctions',5,
"InputMembershipFunctionType', 'gaussmf’,
'"OutputMembershipFunctionType', 'constant');

Generate the initial FIS, and get its parameter settings.

fisin = genfis(x,y,goptions);
[in,out,rule] = getTunableSettings(fisin);
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Use the pattern search method for optimization, setting the maximum number of iterations to 25, and
tune the FIS.

toptions = tunefisOptions('Method', 'patternsearch');
toptions.MethodOptions.MaxIterations = 25;
rng('default"')

fisout = tunefis(fisin,[in;out],x,y,toptions);

Iter Func-count f(x) MeshSize Method

0 1 0.346649 1

1 19 0.346649 0.5 Refine Mesh

2 37 0.273812 1 Successful Poll
3 38 0.236413 2 Successful Poll
4 39 0.190794 4 Successful Poll
5 40 0.182142 8 Successful Poll
6 47 0.182142 4 Refine Mesh

7 49 0.162927 8 Successful Poll
8 56 0.162927 4 Refine Mesh

9 67 0.162927 2 Refine Mesh

10 69 0.159539 4 Successful Poll
11 80 0.159539 2 Refine Mesh

12 92 0.159539 1 Refine Mesh
13 94 0.159421 2 Successful Poll
14 106 0.159373 4 Successful Poll
15 117 0.159373 2 Refine Mesh
16 125 0.159185 4 Successful Poll
17 136 0.159185 2 Refine Mesh
18 151 0.159185 1 Refine Mesh
19 152 0.15914 2 Successful Poll
20 167 0.15914 1 Refine Mesh
21 170 0.158914 2 Successful Poll
22 185 0.158914 1 Refine Mesh
23 187 0.158839 2 Successful Poll
24 202 0.158839 1 Refine Mesh
25 206 0.158366 2 Successful Poll
26 215 0.158121 4 Successful Poll

Maximum number of iterations exceeded: increase options.MaxIterations.
You can increase the number of iterations to further optimize the cost.

See Also
genfis | getTunableSettings | tunefis

More About

. “Tune Mamdani Fuzzy Inference System” on page 3-27
. “Tune FIS Tree for Gas Mileage Prediction” on page 3-37
. “Tune Fuzzy Trees” on page 3-15
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Tune Fuzzy Trees

You can tune the parameters of a FIS tree using a similar two-step process as shown in “Tuning Fuzzy
Inference Systems” on page 3-2.

* Learn and tune the rules of the FISs in the tree.

* Learn the MF parameters of the FISs in the tree.

sin(x) + cos(x)

exp(x)
creating FIS trees, see “Fuzzy Trees” on page 2-52.

Create a FIS tree to model for as shown in the following figure. For more information on

sin(X)JrCGS(X)} sin(x)+cos(x)

fisl -
cxXplx
X —— fis2 P >

Create fis1 as a Sugeno type FIS, which results in a faster tuning process due to computationally
efficient defuzzification method. Add two inputs, both with range the [0, 10] and with three MFs each.
Use a smooth differentiable MF, such as gaussmf, to match the characteristics of the data type you
are modeling.

fisl = sugfis('Name', 'fisl');
fisl = addInput(fisl, [0 10], 'NumMFs',3, 'MFType', 'gaussmf');
fisl = addInput(fisl, [0 10], 'NumMFs',3, 'MFType', 'gaussmf');

Add an output with the range [-1.5, 1.5] having nine MFs corresponding to the nine possible input
MF combinations. Doing so provides maximum granularity for the FIS rules. Set the output range
according to the possible values of sin(x) + cos(x).

fisl = addOutput(fisl,[-1.5 1.5], 'NumMFs',9);

Create fis2 as a Sugeno type FIS. Add two inputs. Set the range of the first input to [-1.5, 1.5],
which matches the range of the output of fisl. The second input is the same as the inputs of fis1.
Therefore, use the same input range, [0, 10]. Add three MFs for each of the inputs.

fis2 = sugfis('Name', 'fis2');
fis2 = addInput(fis2,[-1.5 1.5], 'NumMFs',3, '"MFType', 'gaussmf');
fis2 = addInput(fis2,[0 10], 'NumMFs',3, 'MFType', 'gaussmf');

Add an output with range [0 1] and nine MFs. The output range is set according to the possible
£ sin(x) + cos(x)

values o oXD0)
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fis2 = addOutput(fis2,[0 1], 'NumMFs',9);

Connect the inputs and the outputs as shown in the diagram. Output 1 of fis1 connects to input 1 of
fis2, inputs 1 and 2 of fis1 connect to each other, and input 2 of fisl connects to input 2 of fis2.

conl = ["fisl/outputl” "fis2/inputl”];
con2 = ["fisl/inputl" "fisl/input2"];
con3 = ["fisl/input2" "fis2/input2"];

Finally, create a FIS tree using the specified FISs and connections.
fisT = fistree([fisl fis2],[conl;con2;con3]);

Add an additional output to the FIS tree to access the output of fis1l.
fisT.OQutputs = ["fisl/outputl";fisT.Outputs];

Generate input and output training data.

= (0:0.1:10)';

sin(x)+cos(x);

yl./exp(x);
= [yl y2];

X
yl
y2
y

Tune the FIS tree parameters in two steps. First, learn the rules of the FIS tree using a global
optimization method (particle swarm for this example).

options = tunefisOptions('Method', 'particleswarm', 'OptimizationType', 'learning');

This tuning step uses a small number of iterations to learn a rule base without overfitting the training
data. The rule base provides an educated initial condition for the second step to optimize all the FIS
tree parameters together. Set the maximum iteration number to 5, and learn the rule base.

options.MethodOptions.MaxIterations = 5;
rng('default') % for reproducibility
fisToutl = tunefis(fisT,[],x,y,options);

Best Mean Stall
Iteration f-count f(x) f(x) Iterations

0 100 0.6682 0.9395 0
1 200 0.6682 1.023 0
2 300 0.6652 0.9308 0
3 400 0.6259 0.958 0
4 500 0.6259 0.918 1
5 600 0.5969 0.9179 0

Optimization ended: number of iterations exceeded OPTIONS.MaxIterations.

Next, to tune all the FIS tree parameters, use a local optimization method (pattern search for this
example). Local optimization is generally faster than global optimization and can produce better
results when the input fuzzy system parameters are already consistent with the training data.

Use the patternsearch method for optimization. Set the number of iterations to 25.

options.Method = 'patternsearch';
options.MethodOptions.MaxIterations = 25;

Use getTunableSettings to obtain input, output, and rule parameter settings from the FIS tree.

[in,out,rule] = getTunableSettings(fisToutl);
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Tune the FIS tree parameters.

rng('default') % for reproducibility

fisTout2 = tunefis(fisToutl, [in;out;rule],x,y,options);

Iter Func-count
0 1
1 3
2 13
3 20
4 33
5 33
6 61
7 61
8 92
9 92

10 128
11 175
12 212
13 265
14 275
15 328
16 339
17 391
18 410
19 462
20 469
21 521
22 542
23 594
24 614
25 662
26 698

Maximum number of iterations exceeded: increase options.MaxIterations.

f(x)
.596926
.551284
.548551
.546331
.527482
.527482
.511532
.511532
.505355
.505355
.505355
.487734
.487734
.487734
.486926
.486926
.483683
.483683
.442624
.442624
0.44051
0.44051
0.435381
0.435381
0.398872
0.398385
0.398385

[cNoNoNoNoNoNoNoNoNoNoNoNoNoNoNoNoNoNoNol

MeshSize

= =

=

POARARNBENENAEANANBENDROPRPOCOODOODODDO RN

Method

Successful Poll
Successful Poll
Successful Poll
Successful Poll
Refine Mesh
Successful Poll
Refine Mesh
Successful Poll
Refine Mesh
Refine Mesh
Successful Poll
Refine Mesh
Refine Mesh
Successful Poll
Refine Mesh
Successful Poll
Refine Mesh
Successful Poll
Refine Mesh
Successful Poll
Refine Mesh
Successful Poll
Refine Mesh
Successful Poll
Successful Poll
Refine Mesh

The optimization cost reduces from 0.59 to 0.39 in the second step.

Alternatively, you can tune the specific fuzzy systems within a FIS tree. For this example, after

learning the rule base of the FIS tree, separately tune fisl and fis2 parameters.

To obtain parameter settings of a FIS within the FIS tree, use getTunableSettings, specifying the
FIS name. First, get the parameter settings for fis1l.

[in,out,rule] = getTunableSettings(fisToutl,"FIS","fisl");

Tune the parameters of fisl.

rng('default")

fisTout2 = tunefis(fisToutl, [in;out;rule],x,y,options);

Iter Func-count

Ok WNREO

1

3
18
28
56
84
107

f(x)
.596926
.551284
.510362
.494804
.494804
.493422
.492883

[cNcNoNoNoNoNG]

MeshSize

DO~ OORNRE

Method

Successful Poll
Successful Poll
Successful Poll
Refine Mesh

Successful Poll
Successful Poll
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7 107 0.492883 8 Refine Mesh
8 136 0.492883 4 Refine Mesh
9 171 0.492883 2 Refine Mesh
10 178 0.491534 4 Successful Poll
11 213 0.491534 2 Refine Mesh
12 229 0.482682 4 Successful Poll
13 264 0.482682 2 Refine Mesh
14 279 0.446645 4 Successful Poll
15 313 0.446645 2 Refine Mesh
16 330 0.44657 4 Successful Poll
17 364 0.44657 2 Refine Mesh
18 384 0.446495 4 Successful Poll
19 418 0.446495 2 Refine Mesh
20 461 0.445938 4 Successful Poll
21 495 0.445938 2 Refine Mesh
22 560 0.422421 4 Successful Poll
23 594 0.422421 2 Refine Mesh
24 597 0.397265 4 Successful Poll
25 630 0.397265 2 Refine Mesh
26 701 0.390338 4 Successful Poll

Maximum number of iterations exceeded: increase options.MaxIterations.
In this case, the optimization cost is improved by tuning only fis1 parameter values.
Next, obtain the parameter settings for fis2 and tune the fis2 parameters.
[in,out,rule] = getTunableSettings(fisTout2,"FIS","fis2");

rng('default"')
fisTout3 = tunefis(fisTout2,[in;out;rule],x,y,options);

Iter Func-count f(x) MeshSize Method

0 1 0.390338 1

1 2 0.374103 2 Successful Poll
2 5 0.373855 4 Successful Poll
3 10 0.356619 8 Successful Poll
4 33 0.356619 4 Refine Mesh

5 43 0.350715 8 Successful Poll
6 65 0.349417 16 Successful Poll
7 65 0.349417 8 Refine Mesh

8 87 0.349417 4 Refine Mesh

9 91 0.349356 8 Successful Poll
10 112 0.349356 4 Refine Mesh

11 138 0.346102 8 Successful Poll
12 159 0.346102 4 Refine Mesh

13 172 0.345938 8 Successful Poll
14 193 0.345938 4 Refine Mesh

15 222 0.342721 8 Successful Poll
16 244 0.342721 4 Refine Mesh

17 275 0.342721 2 Refine Mesh

18 283 0.340727 4 Successful Poll
19 312 0.340554 8 Successful Poll
20 335 0.340554 4 Refine Mesh

21 366 0.340554 2 Refine Mesh

22 427 0.337873 4 Successful Poll
23 457 0.337873 2 Refine Mesh

24 521 0.33706 4 Successful Poll
25 551 0.33706 2 Refine Mesh
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26 624

Maximum number of iterations exceeded: increase options.MaxIterations.

0.333193

4

Successful Poll

The optimization cost is further reduced by tuning the fis2 parameter values. To avoid overfitting of
individual FIS parameter values, you can further tune both fisl and fis2 parameters together.

[in,out,rule] = getTunableSettings(fisTout3);

rng('default"')

fisToutd4 = tunefis(fisTout3,[in;out;rule],x,y,options);

Iter Func-count
0 1
1 8
2 91
3 116
4 154
5 205
6 302
7 352
8 391
9 441

10 478
11 528
12 562
13 612
14 713
15 763
16 867
17 917
18 1036
19 1086
20 1212
21 1266
22 1369
23 1381
24 1407
25 1407
26 1447

Maximum number of iterations exceeded: increase options.MaxIterations.

f(x)
.333193
.326804
.326432
.326261
.326261
.326261
.326092
.326092
.325964
.325964
0.32578
0.32578
0.325691
0.325691
0.229273
0.229273
0.22891
0.22891
.228688
.228688
.228688
.228445
.228441
.227645
.226125
.226125
.226125

loNoNoNoNoNoNoNoNoNO)

loNoNoNoNoNoNoNoNo)

MeshSize

=
POOOOOORLANEFEFNAEANENANANAENENIEANROANE

Method

Successful Poll
Successful Poll
Successful Poll
Refine Mesh
Refine Mesh
Successful Poll
Refine Mesh
Successful Poll
Refine Mesh
Successful Poll
Refine Mesh
Successful Poll
Refine Mesh
Successful Poll
Refine Mesh
Successful Poll
Refine Mesh
Successful Poll
Refine Mesh
Refine Mesh
Successful Poll
Successful Poll
Successful Poll
Successful Poll
Refine Mesh
Refine Mesh

Overall, the optimization cost is smaller after using the three tuning steps.

See Also

getTunableSettings | tunefis

More About

. “Fuzzy Trees” on page 2-52

. “Tune Mamdani Fuzzy Inference System” on page 3-27
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Customize FIS Tuning Process

You can customize the FIS tuning process by specifying either a custom cost function or a custom
optimization method.

For more information on tuning a FIS, see “Tune Fuzzy Rules and Membership Function Parameters”
on page 3-6 and “Tune Fuzzy Trees” on page 3-15.

Tune FIS Using Custom Cost Function
You can specify a custom cost function for tuning your fuzzy system. Doing so is useful for:

* Training a FIS using a custom model without using input/output training data. For an example, see
“Tune Fuzzy Robot Obstacle Avoidance System Using Custom Cost Function” on page 3-70.

* Combining the outputs of the component FISs of a FIS tree using mathematical operations, as
shown in this example.

As an example, consider the FIS tree from “Tune Fuzzy Trees” on page 3-15. Suppose you cant you
want to modify the FIS tree as shown in the following diagram, combining the FIS outputs using
known mathematical operations from the training data.

sin(x)

fisl >

Y

Z sin(x)+cos(x)

cos(x) sin(x)+cos(x)

x = fis2 X exp(x)

1/exp(x)

Y

— fis3

Create the FIS tree.

fisl = sugfis('Name', 'fisl');

fisl = addInput(fisl, [0 10], 'NumMFs',3, 'MFType', 'gaussmf');
fisl = addOutput(fisl,[-1 1], 'NumMFs',b3);

fis2 = sugfis('Name', 'fis2"');

fis2 = addInput(fis2,[0 10], 'NumMFs',3, 'MFType', 'gaussmf');
fis2 = addOutput(fis2,[-1 1], 'NumMFs',63);

fis3 = sugfis('Name', 'fis3");

fis3 = addInput(fis3,[0 10], 'NumMFs',3, 'MFType', 'gaussmf');
fis3 = addOutput(fis3,[0 1], 'NumMFs',b3);

con = ["fisl/inputl" "fis2/inputl";"fis2/inputl" "fis3/inputl”];

fisT = fistree([fisl fis2 fis3],con);
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Generate training data.

X = (0:0.1:10)';

yl = sin(x)+cos(x);
y2 = yl./exp(x);
y = [yl;y2];

To implement the addition and multiplication operations, use a custom cost function. For this
example, use the function customcostfcn, included at the end of the example. Learn a rule base
using this cost function.

options = tunefisOptions('Method',"particleswarm", 'OptimizationType',"learning");
options.MethodOptions.MaxIterations = 5;

rng('default"')

fisToutl = tunefis(fisT,[],@(fis)customcostfcn(fis,x,y),options);

Best Mean Stall
Iteration f-count f(x) f(x) Iterations
0 100 0.746 1.31 0
1 200 0.5089 1.249 0
2 300 0.5089 1.086 1
3 400 0.5089 1.112 2
4 500 0.5089 1.106 3
5 600 0.4999 1.051 0
Optimization ended: number of iterations exceeded OPTIONS.MaxIterations.

Next, tune all the parameters of the FIS tree.

options.Method = 'patternsearch';

options.MethodOptions.MaxIterations = 25;

[in,out,rule] = getTunableSettings(fisToutl);

rng('default")

fisTout2 = tunefis(fisToutl, [in;out;rule],@(fis)customcostfcn(fis,x,y),options);

Iter Func-count f(x) MeshSize Method

0 1 0.499882 1

1 13 0.499864 2 Successful Poll
2 51 0.499727 4 Successful Poll
3 72 0.499727 2 Refine Mesh

4 117 0.499727 1 Refine Mesh

5 157 0.499542 2 Successful Poll
6 170 0.499485 4 Successful Poll
7 191 0.499485 2 Refine Mesh

8 217 0.499483 4 Successful Poll
9 238 0.499483 2 Refine Mesh

10 275 0.499483 4 Successful Poll
11 296 0.499483 2 Refine Mesh

12 340 0.499483 1 Refine Mesh

13 381 0.499483 2 Successful Poll
14 425 0.499483 1 Refine Mesh

15 497 0.499483 0.5 Refine Mesh

16 536 0.499394 1 Successful Poll
17 547 0.499217 2 Successful Poll
18 591 0.499217 1 Refine Mesh

19 603 0.499211 2 Successful Poll
20 630 0.498972 4 Successful Poll
21 652 0.498972 2 Refine Mesh
22 696 0.498972 1 Refine Mesh
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23 768 0.498972 0.5 Refine Mesh
24 843 0.498972 0.25 Refine Mesh
25 859 0.495584 0.5 Successful Poll
26 869 0.494138 1 Successful Poll

Maximum number of iterations exceeded: increase options.MaxIterations.

You can add more input/output MFs and specify additional FIS tree outputs to improve the tuning
performance. Using additional MF parameters and more training data for additional FIS tree outputs
can further fine tune the outputs of fisl, fis2, and fis3.

Tune FIS Using Custom Optimization Method

You can also implement your own FIS parameter optimization method using getTunableSettings,
getTunableValues, and setTunableValues. This example uses these functions to tune a rule
base of a fuzzy system.

Create a FIS to approximate sin(6), where 6 varies from 0 to 2m.
fisin = mamfis;

Add an input with a range of [0, 2r] and having five Gaussian MFs. Also, ass an output with a range
of [-1, 1] and having five Gaussian MFs.

fisin
fisin

= addInput(fisin, [0 2*pi], 'NumMFs',5, '"MFType', 'gaussmf');
= addOutput(fisin,[-1 1], ‘NumMFs',5, 'MFType"', 'gaussmf');

Add five rules.

fisin = addRule(fisin,[1 11 1;2 2 11;3311;4411;5511]);
fisin.Rules

ans =
1x5 fisrule array with properties:

Description

Antecedent
Consequent
Weight
Connection

Details:

Description

1 "inputl==mfl => outputl=mfl (1)"
2 "inputl==mf2 => outputl=mf2 (1)"
3 "inputl==mf3 => outputl=mf3 (1)"
4 "inputl==mf4 => outputl=mf4 (1)"
5 "inputl==mf5 => outputl=mf5 (1)"

For a faster FIS update, set DisableStructuralChecks to true.
fisin.DisableStructuralChecks = true;
Obtain the rule parameter settings.

[~,~,rule] = getTunableSettings(fisin);
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Make the rule antecedents nontunable. In the rule consequents, do not allow NOT logic (negative MF
indices) or empty variables (zero MF indices).

for i = l:numel(rule)
rule(i).Antecedent.Free = false;
rule(i).Consequent.AllowNot = false;
rule(i).Consequent.AllowEmpty = false;
end

Generate data for tuning.

X
y

(0:0.1:2*%pi)"';
sin(x);

To tune the rule parameters, use the customtunefis function defined at the end of this example.
Set the number of iterations to 2, and do not allow invalid parameter values when updating the FIS
using setTunableValues.

numite = 2;
ignoreinvp = false;
fisout = customtunefis(fisin, rule,x,y,numite,ignoreinvp);

Initial cost = 1.170519
Iteration 1: Cost 0.241121
Iteration 2: Cost 0.241121

Display the tuned rules.
fisout.Rules

ans =
1x5 fisrule array with properties:

Description

Antecedent
Consequent
Weight
Connection

Details:

Description

1 "inputl==mfl => outputl=mf4 (1)"
2 "inputl==mf2 => outputl=mf5 (1)"
3 "inputl==mf3 => outputl=mf3 (1)"
4 "inputl==mf4 => outputl=mfl (1)"
5 "inputl==mf5 => outputl=mf2 (1)"

Allow NOT logic in the rules, and optimize the FIS again.

for i = 1l:numel(rule)
rule(i).Consequent.AllowNot = true;
end
fisout = customtunefis(fisin, rule,x,y,numite,ignoreinvp);
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Initial cost = 1.170519
Iteration 1: Cost = 0.357052
Iteration 2: Cost = 0.241121

fisout.Rules

ans =
1x5 fisrule array with properties:

Description
Antecedent
Consequent
Weight
Connection
Details:
Description
1 "inputl==mfl => outputl=mf4 (1)"
2 "inputl==mf2 => outputl=mf5 (1)"
3 "inputl==mf3 => outputl=mf3 (1)"
4 "inputl==mf4 => outputl=mfl (1)"
5 "inputl==mf5 => outputl=mf2 (1)"

With NOT logic, there are more combinations of rule parameters, and it generally takes more
iterations to tune a FIS.

Next, reset AllowNot to false and set ALllowEmpty to true. In other words, allow the absence of
variables (zero output MF indices) in the consequents. Tune the FIS with the updated rule parameter
settings.

for i = l:numel(rule)
rule(i).Consequent.AllowNot

= false;
rule(i).Consequent.AllowEmpty =

true;
end

try

fisout = customtunefis(fisin, rule,x,y,numite,ignoreinvp);
catch me

disp("Error: "+me.message)
end

Initial cost = 1.170519

Error: Rule consequent must have at least one nonzero membership function index.

The tuning process fails since the FIS only contains one output, which must be nonzero (nonempty) in
the rule consequent. To ignore invalid parameter values, specify IgnoreInvalidParameters with
setTunableValues.

Set ignoreinvp to true, which specifies IgnoreInvalidParameters value in the call to
setTunableValues used in customtunefis.

ignoreinvp = true;
fisout = customtunefis(fisin, rule,x,y,numite,ignoreinvp);
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Initial cost = 1.170519
Iteration 1: Cost = 0.241121
Iteration 2: Cost 0.241121

fisout.Rules

ans =
1x5 fisrule array with properties:

Description
Antecedent
Consequent
Weight
Connection
Details:
Description
1 "inputl==mfl => outputl=mf4 (1)"
2 "inputl==mf2 => outputl=mf5 (1)"
3 "inputl==mf3 => outputl=mf3 (1)"
4 "inputl==mf4 => outputl=mfl (1)"
5 "inputl==mf5 => outputl=mf2 (1)"

In this case, the tuning process bypasses the invalid values and uses only valid parameter values for

optimization.

By default, tunefis ignores invalid values when updating fuzzy system parameters. You can change
this behavior by setting tunefisOptions.IgnoreInvalidParameters to false.

Local Functions
function cost = customcostfcn(fis,x,y)

tY = evalfis(fis,x);

sincosx = tY(:,1)+tY(:,2);
sincosexpx = sincosx.*tY(:,3);
actY = [sincosx;sincosexpx];

d = y(:)-acty;

cost = sqgrt(mean(d.*d));

end
function fis = customtunefis(fis,rule,x,y,n,ignore)

% Show initial cost.
cost = findcost(fis,x,y);
fprintf('Initial cost = %f\n',cost);

% Optimize rule parameters.
numMFs = numel(fis.Outputs.MembershipFunctions);
for ite = 1:n
for i = l:numel(rule)
% Get consequent value.
pval = getTunableValues(fis,rule(i));

o

% Loop through output MF indices to minimize the

cost.
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% Use output indices according to AllowNot and AllowEmpty.
allowNot = rule(i).Consequent.AllowNot;
allowEmpty = rule(i).Consequent.AllowEmpty;
if allowNot && allowEmpty
mfID = -numMFs:numMFs;
elseif allowNot && ~allowEmpty
mfID = [-numMFs:-1 1:numMFs];
elseif ~allowNot && allowEmpty
mfID = O:numMFs;

else

mfID = 1:numMFs;
end
cost = 1000;

minCostFIS = fis;
for j = 1:length(mfID)
% Update consequent value.
pval(l) = mfID(j);
% Set updated consequent value to the FIS.

fis = setTunableValues(fis,rule(i),pval, 'IgnoreInvalidParameters',ignore);

% Evaluate cost.
rmse = findcost(fis,x,y);
% Update FIS with the minimum cost.
if rmse<cost
cost = rmse;
minCostFIS = fis;

end
end
fis = minCostFIS;
end
fprintf('Iteration %d: Cost = %f\n',ite,cost);
end
end

function cost = findcost(fis,x,y)
actY = evalfis(fis,x);

d =y - acty;

cost = sqrt(mean(d.*d));

end

See Also
getTunableSettings | tunefis

More About
. “Tune Mamdani Fuzzy Inference System” on page 3-27
. “Tune Fuzzy Trees” on page 3-15
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Tune Mamdani Fuzzy Inference System

This example shows how to tune membership function (MF) and rule parameters of a Mamdani fuzzy
inference system (FIS). This example uses particle swarm and pattern search optimization, which
require Global Optimization Toolbox™ software.

Automobile fuel consumption prediction in miles per gallon (MPG) is a typical nonlinear regression
problem. It uses several automobile profile attributes to predict fuel consumption. The training data
is available in the University of California at Irvine Machine Learning Repository and contains data
collected from automobiles of various makes and models.

This example uses the following six input data attributes to predict the output data attribute MPG
with a FIS:

Number of cylinders

Displacement

Horsepower

Weight

Acceleration

o U A W N R

Model year
Prepare Data

Load the data. Each row of the dataset obtained from the repository represents a different automobile
profile.

[data,name] = loadgas;

Remove leading and trailing whitespace from the attribute names.

name = strtrim(string(name));

data contains 7 columns, where the first six columns contain the following input attributes.

* Number of cylinders
» Displacement

* Horsepower

* Weight

* Acceleration

* Model year

The seventh column contains the output attribute, MPG.

Create separate input and output data sets, X and Y, respectively.

X
Y

data(:,1:6);
data(:,7);

Partition the input and output data sets into training data (odd-indexed samples) and validation data
(even-indexed samples).

trnX
trnY

X(1l:2:end,:);

; raining input data set
Y(1l:2:end,:);

% T
% Training output data set
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vildX
vlidY

X(2:2:end,:); % Validation input data set
Y(2:2:end,:); % Validation output data set

Extract the range of each data attribute, which you will use for input/output range definition during
FIS construction.

dataRange = [min(data)' max(data)'];
Construct FIS using Data Attribute Ranges

Create a Mamdani FIS for tuning.
fisin = mamfis;

Add input and output variables to the FIS, where each variable represents one of the data attributes.
For each variable, use the corresponding attribute name and range.

To reduce the number of rules, use two MFs for each input variable, which results in 26 =64 input
MF combinations. Therefore, the FIS uses a maximum of 64 rules corresponding to the input MF
combinations.

To improve data generalization beyond the training data, use 64 MFs for the output variable. Doing
so allows the FIS to use a different output MF for each rule.

Both input and output variables use default triangular MFs, which are uniformly distributed over the
variable ranges.

for i = 1:6

fisin = addInput(fisin,dataRange(i,:), 'Name',name(i), 'NumMFs',62);
end
fisin = addOutput(fisin,dataRange(7,:), 'Name',name(7), 'NumMFs',664);

View the FIS structure. Initially, the FIS has zero rules. The rules of the system are found during the
tuning process.

figure
plotfis(fisin)
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Tune FIS with Training Data
Tuning is performed in two steps.

1 Learn the rule base while keeping the input and output MF parameters constant.
2  Tune the parameters of the input/output MFs and rules.

The first step is less computationally expensive due to the small number of rule parameters, and it
quickly converges to a fuzzy rule base during training. In the second step, using the rule base from
the first step as an initial condition provides fast convergence of the parameter tuning process.

Learn Rules

To learn a rule base, first specify tuning options using a tunefisOptions object. Since the FIS
allows a large number of output MFs (used in rule consequents), use a global optimization method
(genetic algorithm or particle swarm). Such methods perform better in large parameter tuning
ranges as compared to local optimization methods (pattern search and simulation annealing). For this
example, tune the FIS using the particle swarm optimization method ('particleswarm").

To learn new rules, set the OptimizationType to 'learning'. Restrict the maximum number of
rules to 64. The number of tuned rules can be less than this limit, since the tuning process removes
duplicate rules.

options = tunefisOptions('Method', 'particleswarm’,...

'OptimizationType', 'learning’,
"NumMaxRules',64);
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If you have Parallel Computing Toolbox™ software, you can improve the speed of the tuning process
by setting options.UseParallel to true. If you do not have Parallel Computing Toolbox software,
set options.UseParallel to false.

Set the maximum number of iterations to 20. To reduce training error in the rule learning process,
you can increase the number of iterations. However, using too many iterations can overtune the FIS
to the training data, increasing the validation errors.

options.MethodOptions.MaxIterations = 20;

Since particle swarm optimization uses random search, to obtain reproducible results, initialize the
random number generator to its default configuration.

rng('default')
Tune the FIS using the specified tuning data and options.

Learning rules using the tunefis function takes approximately 5 minutes. For this example, enable
tuning by setting runtunefis to true. To load pretrained results without running tunefis, you can
set runtunefis to false.

runtunefis = false;

Parameter settings can be empty when learning new rules. For more information, see tunefis.

if runtunefis

fisoutl = tunefis(fisin,[],trnX,trnY,options); %#ok<UNRCH>
else

tunedfis = load('tunedfismpgprediction.mat');

fisoutl = tunedfis.fisoutl;

fprintf('Training RMSE = %.3f MPG\n',calculateRMSE(fisoutl,trnX,trnY));
end

Training RMSE = 4.452 MPG
The Best f(x) column shows the training root-mean-squared-error (RMSE).

View the structure of the tuned FIS, fisoutl.

plotfis(fisoutl)
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The learning process produces a set of new rules for the FIS. For example, view the descriptions of
the first three rules.
[fisoutl.Rules(1l:3).Description]’
ans = 3x1 string
"Cylinder==mf2 & Disp==mf2 & Power==mf2 & Weight==mf2 & Year==mf2 => MPG=mf5 (1)"

"Cylinder==mfl & Power==mf2 & Weight==mf2 & Acceler==mf2 & Year==mfl => MPG=mf63 (1)"
"Cylinder==mf2 & Disp==mfl & Acceler==mf2 => MPG=mf28 (1)"

The learned system should have similar RMSE performance for both the training and validation data
sets. To calculate the RMSE for the validation data set, evaluate fisoutl using validation input data
set v1dX. To hide run-time warnings during evaluation, set all the warning options to none.

Calculate the RMSE between the generated output data and the validation output data set v1dY.
plotActualAndExpectedResultsWithRMSE(fisoutl,vldX,vldY)
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Since the training and validation errors are similar, the learned system does not overfit the training
data.

Tune All Parameters

After learning the new rules, tune the input/output MF parameters along with the parameters of the
learned rules. To obtain the tunable parameters of the FIS, use the getTunableSettings function.

[in,out,rule] = getTunableSettings(fisoutl);

To tune the existing FIS parameter settings without learning new rules, set the OptimizationType
to 'tuning’.

options.OptimizationType = 'tuning';

Since the FIS already learned rules using the training data, use a local optimization method for fast
convergence of the parameter values. For this example, use the pattern search optimization method
('patternsearch').

options.Method = 'patternsearch';

Tuning the FIS parameters takes more iterations than the previous rule-learning step. Therefore,
increase the maximum number of iterations of the tuning process to 60. As in the first tuning stage,
you can reduce training errors by increasing the number of iterations. However, using too many
iterations can overtune the parameters to the training data, increasing the validation errors.

options.MethodOptions.MaxIterations = 60;
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To improve pattern search results, set method option UseCompletePoll to true.

options.MethodOptions.UseCompletePoll = true;
Tune the FIS parameters using the specified tunable settings, training data, and tuning options.

Tuning parameter values with tunefis function takes approximately 5 minutes. To load pretrained
results without running tunefis, you can set runtunefis to false.

if runtunefis

rng('default') S#ok<UNRCH>

fisout = tunefis(fisoutl,[in;out;rule],trnX,trnY,options);
else

fisout = tunedfis.fisout;

fprintf('Training RMSE = %.3f MPG\n',calculateRMSE(fisout,trnX,trnY));
end

Training RMSE = 2.903 MPG

At the end of the tuning process, some of the tuned MF shapes are different than the original ones.

figure
plotfis(fisout)
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Check Performance

Validate the performance of the tuned FIS, fisout, using the validation input data set vldX.
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Compare the expected MPG obtained from the validation output data set v1dY and actual MPG
generated using fisout. Compute the RMSE between these results.

plotActualAndExpectedResultsWithRMSE (fisout,vldX,vldY);

RMSE = 3.0116 MPG
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Tuning the FIS parameters improves the RMSE compared to the results from the initial learned rule
base. Since the training and validation errors are similar, the parameters values are not overtuned.

Conclusion

You can further improve the training error of the tuned FIS by:

Increasing number of iterations in both the rule-learning and parameter-tuning phases. Doing so
increases the duration of the optimization process and can also increase validation error due to
overtuned system parameters with the training data.

Using global optimization methods, such as ga and particleswarm, in both rule-learning and
parameter-tuning phases. ga and particleswarm perform better for large parameter tuning
ranges since they are global optimizers. On the other hand, patternsearch and
simulannealbnd perform better for small parameter ranges since they are local optimizers. If a
FIS is generated from training data with genfis or a rule base is already added to a FIS using
training data, then patternsearch and simulannealbnd may produce faster convergence as
compared to ga and particleswarm. For more information on these optimization methods and
their options, see ga (Global Optimization Toolbox), particleswarm (Global Optimization
Toolbox), patternsearch (Global Optimization Toolbox), and simulannealbnd (Global
Optimization Toolbox).
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* Changing the FIS properties, such as the type of FIS, number of inputs, number of input/output
MFs, MF types, and number of rules. For fuzzy systems with a large number of inputs, a Sugeno
FIS generally converges faster than a Mamdani FIS since a Sugeno system has fewer output MF
parameters (if constant MFs are used) and faster defuzzification. Small numbers of MFs and
rules reduce the number of parameters to tune, producing a faster tuning process. Furthermore, a
large number of rules may overfit the training data. In general, for larger fuzzy systems, a FIS tree
can produce similar performance with a smaller number of rules as compared to a single FIS. For
an example, see “Tune FIS Tree for Gas Mileage Prediction” on page 3-37.

* Modifying tunable parameter settings for MFs and rules. For example, you can tune the support of
a triangular MF without changing its peak location. Doing so reduces the number of tunable
parameters and can produce a faster tuning process for specific applications. For rules, you can
exclude zero MF indices by setting the ALllowEmpty tunable setting to false, which reduces the
overall number of rules during the learning phase.

Local Functions
function plotActualAndExpectedResultsWithRMSE(fis,x,y)

% Calculate RMSE bewteen actual and expected results
[rmse,actY] = calculateRMSE(fis,x,y);

% Plot results

figure

subplot(2,1,1)

hold on

bar(actY)

bar(y)

bar(min(actY,y), 'FaceColor',[0.5 0.5 0.5])

hold off

axis([0 200 0 601])

xlabel("Validation input dataset index"),ylabel("MPG")

legend(["Actual MPG" "Expected MPG" "Minimum of actual and expected values"], ...
'Location', 'NorthWest')

title("RMSE = " + num2str(rmse) + " MPG")

subplot(2,1,2)

bar(actY-y)

xlabel("Validation input dataset index"),ylabel("Error (MPG)")
title("Difference Between Actual and Expected Values")

end
function [rmse,actY] = calculateRMSE(fis,x,y)

% Specify options for FIS evaluation
persistent evalOptions
if isempty(evalOptions)
evalOptions = evalfisOptions("EmptyOutputFuzzySetMessage", "none",

"NoRuleFiredMessage", "none", "OutOfRangeInputValueMessage", "none");
end

% Evaluate FIS
actY = evalfis(fis,x,evalOptions);

% Calculate RMSE
del = actY - y;
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rmse = sqrt(mean(del.”2));

end

See Also
genfis | getTunableSettings | tunefis

More About
. “Tune Mamdani Fuzzy Inference System” on page 3-27
. “Tune FIS Tree for Gas Mileage Prediction” on page 3-37
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Tune FIS Tree for Gas Mileage Prediction

This example shows how to tune parameters of a FIS tree, which is a collection of connected fuzzy
inference systems. This example uses particle swarm and pattern search optimization, which require
Global Optimization Toolbox™ software.

Automobile fuel consumption prediction in miles per gallon (MPG) is a typical nonlinear regression
problem. It uses several automobile profile attributes to predict fuel consumption. The training data
is available in the University of California at Irvine Machine Learning Repository and contains data
collected from automobiles of various makes and models.

This example uses the following six input data attributes to predict the output data attribute MPG
with a FIS tree:

Number of cylinders

Displacement

Horsepower

Weight

Acceleration

o U1 A W N M

Model year
Prepare Data

Load the data. Each row of the dataset obtained from the repository represents a different automobile
profile.

data = loadgas;
data contains 7 columns, where the first six columns contain the following input attributes.

* Number of cylinders
* Displacement

* Horsepower

* Weight

* Acceleration

* Model year

The seventh column contains the output attribute, MPG.

Create separate input and output data sets, X and Y, respectively.

X
Y

data(:,1:6);
data(:,7);

Partition the input and output data sets into training data (odd-indexed samples) and validation data
(even-indexed samples).

trnX = X(1:2:end,:); % Training input data set
trnY = Y(1:2:end,:); % Training output data set
vldX = X(2:2:end,:); % Validation input data set
vldY = Y(2:2:end,:); % Validation output data set
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Extract the range of each data attribute, which you will use for input/output range definition during
FIS construction.

dataRange = [min(data)' max(data)'];

Construct a FIS Tree

For this example, construct a FIS tree using the following steps:

1 Rank the input attributes based on their correlations with the output attribute.
2 Create multiple FIS objects using the ranked input attributes.
3  Construct a FIS tree from the FIS objects.

Rank Inputs According to Correlation Coefficients

Calculate the correlation coefficients for the training data. In the final row of the correlation matrix,
the first six elements show the correlation coefficients between the six put data attributes and the
output attribute.

cl = corrcoef(data);
cl(end,:)

ans = 1Ix7

-0.7776 -0.8051 -0.7784 -0.8322 0.4233 0.5805 1.0000

The first four input attributes have negative values, and the last two input attributes have positive
values.

Rank the input attributes that have negative correlations in descending order by the absolute value of
their correlation coefficients.

1  Weight

2 Displacement

3 Horsepower

4  Number of cylinders

Rank the input attributes that have positive correlations in descending order by the absolute value of
their correlation coefficients.

1 Model year
2  Acceleration

These rankings show that the weight and model year have the highest negative and positive
correlations with MPG, respectively.

Create Fuzzy Inference Systems

For this example, implement a FIS tree with the following structure.
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The FIS tree uses multiple two-input-one-output FIS objects to reduce the total number of rules used
In the inference process. fisl, fis2, and fis3 directly take the input values and generate
intermediate MPG values, which are further combined using fis4 and fis5.

Input attributes with negative and positive correlation values are paired up to combine both positive
and negative effects on the output for prediction. The inputs are grouped according to their ranks as
follows:

* Weight and model year

* Displacement and acceleration

* Horsepower and number of cylinders

The last group includes only inputs with negative correlation values since there are only two inputs
with positive correlation values.

This example uses Sugeno-type FIS objects for faster evaluation during the tuning process as
compared to Mamdani systems. Each FIS includes two inputs and one output, where each input
contains two default triangular membership functions (MFs), and the output includes 4 default
constant MFs. Specify the input and output ranges using the corresponding data attribute ranges.

The first FIS combines the weight and model year attributes.

fisl = sugfis('Name', 'fisl');

fisl = addInput(fisl,dataRange(4,:), 'NumMFs',2, 'Name',"weight");
fisl = addInput(fisl,dataRange(6,:), 'NumMFs',2, 'Name',"year");
fisl = addOutput(fisl,dataRange(7,:), 'NumMFs',4);

The second FIS combines the displacement and acceleration attributes.

fis2 = sugfis('Name', 'fis2");

fis2 = addInput(fis2,dataRange(2,:), 'NumMFs',2, 'Name',"displacement");
fis2 = addInput(fis2,dataRange(5,:), '"NumMFs',2, 'Name', "acceleration");
fis2 = addOutput(fis2,dataRange(7,:), 'NumMFs',4);

The third FIS combines the horsepower and number of cylinder attributes.

fis3 = sugfis('Name', 'fis3');

fis3 = addInput(fis3,dataRange(3,:), 'NumMFs',2, 'Name', "horsepower");
fis3 = addInput(fis3,dataRange(1,:), 'NumMFs',2, 'Name', "cylinders");
fis3 = addOutput(fis3,dataRange(7,:), 'NumMFs"',4);

The fourth FIS combines the outputs of the first and second FIS.
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fis4 = sugfis('Name', 'fisd');

fis4 = addInput(fis4,dataRange(7,:), '"NumMFs',62);

fis4 = addInput(fis4,dataRange(7,:), '"NumMFs',62);

fis4 = addOutput(fis4,dataRange(7,:), 'NumMFs"',4);

The final FIS combines the outputs of third and fourth FIS and generates the estimated MPG. This
FIS has the same input and output ranges as the fourth FIS.

fis5 = fis4;
fis5.Name = 'fis5';
fis5.0utputs(1l).Name = "mpg";

Construct FIS Tree

Connect the fuzzy systems (fisl, fis2, fis3, fis4, and fis5) according to the FIS tree diagram.

fisTin = fistree([fisl fis2 fis3 fis4 fis5], [
"fisl/outputl" "fis4/inputl";
"fis2/outputl" "fis4/input2";
"fis3/outputl" "fis5/input2";
"fis4/outputl" "fis5/inputl"])

fisTin =
fistree with properties:

FIS: [1x5 sugfis]
Connections: [4x2 string]
Inputs: [6x1 string]
Outputs: "fis5/mpg"
DisableStructuralChecks: 0

See 'getTunableSettings' method for parameter optimization.

Tune FIS Tree with Training Data

Tuning is performed in two steps.

1 Learn the rule base while keeping the input and output MF parameters constant.
2 Tune the parameters of the input/output MFs and rules.

The first step is less computationally expensive due to the small number of rule parameters, and it
quickly converges to a fuzzy rule base during training. In the second step, using the rule base from
the first step as an initial condition provides fast convergence of the parameter tuning process.

Learn Rules

To learn a rule base, first specify tuning options using a tunefisOptions object. Global optimization
methods (genetic algorithm or particle swarm) are suitable for initial training when all the
parameters of a fuzzy system are untuned. For this example, tune the FIS tree using the particle
swarm optimization method ('particleswarm').

To learn new rules, set the OptimizationType to 'learning'. Restrict the maximum number of

rules to 4. The number of tuned rules of each FIS can be less than this limit, since the tuning process
removes duplicate rules.
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options = tunefisOptions('Method', 'particleswarm’,...
'OptimizationType', 'learning’,
"NumMaxRules',4);

If you have Parallel Computing Toolbox™ software, you can improve the speed of the tuning process
by setting options.UseParallel to true. If you do not have Parallel Computing Toolbox software,
set options.UseParallel to false.

Set the maximum number of iterations to 50. To reduce training error in the rule learning process,
you can increase the number of iterations. However, using too many iterations can overtune the FIS
tree to the training data, increasing the validation errors.

options.MethodOptions.MaxIterations = 50;

Since particle swarm optimization uses random search, to obtain reproducible results, initialize the
random number generator to its default configuration.

rng('default")

Tune the FIS tree using the specified tuning data and options. Set the input order of the training data
according to the FIS tree connections as follows: weight, year, displacement, acceleration,
horsepower, and cylinders.

[46 25 31];
trnX(:,inputOrdersl);

inputOrdersl
orderedTrnX1

Learning rules with tunefis function takes approximately 4 minutes. For this example, enable
tuning by setting runtunefis to true. To load pretrained results without running tunefis, you can
set runtunefis to false.

runtunefis = false;
Parameter settings can be empty when learning new rules. For more information, see tunefis.

if runtunefis

fisToutl = tunefis(fisTin,[],orderedTrnXl,trnY,options); %#ok<UNRCH>
else

tunedfis = load('tunedfistreempgprediction.mat');

fisToutl = tunedfis.fisToutl;

fprintf('Training RMSE = %.3f MPG\n',calculateRMSE(fisToutl,orderedTrnX1l,trnY));
end

Training RMSE = 3.399 MPG

The Best f(x) column shows the training root-mean-squared-error (RMSE).

The learning process produces a set of new rules for the FIS tree.

fprintf("Total number of rules = %d\n",numel([fisToutl.FIS.Rules]));

Total number of rules = 17

The learned system should have similar RMSE performance for both the training and validation data

sets. To calculate the RMSE for the validation data set, evaluate fisout1l using validation input data
set v1dX. To hide run-time warnings during evaluation, set all the warning options to none.
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Calculate the RMSE between the generated output data and the validation output data set v1dY.
Since the training and validation errors are similar, the learned system does not overfit the training
data.

orderedVldXl = vldX(:,inputOrdersl);
plotActualAndExpectedResultsWithRMSE(fisToutl,orderedV1dX1,vldY)

RMSE = 3.4626 MPG

&G0
I ctual MPG
I Expected MPG
Ag b | I Minimum of actual and expected values
0
e
=
20+

0 20 40 &0 &0 100 120 140 160 180 200
Validation input dataset index

Difference Between Actual and Expected Values

Error (MPG)

20 . . . . . . . . .
0 20 40 &0 80 100 120 140 160 180

Validation input dataset index

Tune All Parameters

After learning the new rules, tune the input/output MF parameters along with the parameters of the
learned rules. To obtain the tunable parameters of the FIS tree, use the getTunableSettings
function.

[in,out,rule] = getTunableSettings(fisToutl);

To tune the existing FIS tree parameter settings without learning new rules, set the
OptimizationTypeto 'tuning’.

options.OptimizationType = 'tuning';

Since the FIS tree already learned rules using the training data, use a local optimization method for
fast convergence of the parameter values. For this example, use the pattern search optimization
method ('patternsearch').

options.Method = 'patternsearch’;

Tuning the FIS tree parameters takes more iterations than the previous rule-learning step. Therefore,
increase the maximum number of iterations of the tuning process to 75. As in the first tuning stage,



Tune FIS Tree for Gas Mileage Prediction

you can reduce training errors by increasing the number of iterations. However, using too many
iterations can overtune the parameters to the training data, increasing the validation errors.

options.MethodOptions.MaxIterations = 75;
To improve pattern search results, set method option UseCompletePoll to true.

options.MethodOptions.UseCompletePoll = true;
Tune the FIS tree parameters using the specified tunable settings, training data, and tuning options.

Tuning parameter values with tunefis function takes several minutes. To load pretrained results
without running tunefis, you can set runtunefis to false.

rng('default')
if runtunefis

fisTout2 = tunefis(fisToutl, [in;out;rule],orderedTrnXl,trnY,options); S%#ok<UNRCH>
else

fisTout2 = tunedfis.fisTout2;

fprintf('Training RMSE = %.3f MPG\n',calculateRMSE(fisTout2,orderedTrnX1,trnY));
end

Training RMSE = 3.037 MPG

At the end of the tuning process, the training error reduces compared to the previous step.

Check Performance

Validate the performance of the tuned FIS tree, fisout2, using the validation input data set vldX.

Compare the expected MPG obtained from the validation output data set v1dY and actual MPG
generated using fisout2. Compute the RMSE between these results.

plotActualAndExpectedResultsWithRMSE(fisTout2,orderedV1dX1,vldY)
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Tuning the FIS tree parameters improves the RMSE compared to the results from the initial learned
rule base. Since the training and validation errors are similar, the parameters values are not
overtuned.

Analyze Intermediate Data

To gain insight into the operation of your fuzzy tree, you can add the outputs of the component fuzzy
systems as outputs of your FIS tree. For this example, to access the intermediate FIS outputs, add
three additional outputs to the tuned FIS tree.

fisTout3 = fisTout2;

fisTout3.0utputs(end+l) = "fisl/outputl";
fisTout3.0utputs(end+l) = "fis2/outputl”;
fisTout3.0utputs(end+l) = "fis3/outputl”;

To generate the additional outputs, evaluate the augmented FIS tree, fisTout3.

actY = evaluateFIS(fisTout3,orderedVldX1);
figure,plot(actY(:,[2 3 4 1])),xlabel("Input dataset index"),ylabel("MPG"),axis([1 200 0 55])
legend(["OQutput of fisl" "Output of fis2" "Output of fis3" "Output of fis5"],...
'"Location', 'NorthEast', 'NumColumns',2)
title("Intermediate and Final Outputs")
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The final output of the FIS tree (fis5 output) appears to be highly correlated with the outputs of
fisl and fis3. To validate this assessment, check the correlation coefficients of the FIS outputs.

c2 = corrcoef(actY(:,[2 3 4 11));
c2(end,:)

ans = 1x4

0.9541 0.8245 -0.8427 1.0000

The last row of the correlation matrix shows that the outputs of fisl and fis3 (first and third
column, respectively) have higher correlations with the final output as compared to the output of
fis2 (second column). This result indicates that simplifying the FIS tree by removing fis2 and fis4
and can potentially produce similar training results compared to the original tree structure.

Simplify and Retrain FIS Tree

Remove fis2 and fis4 from the FIS tree and connect the output of fis1 to the first input of fis5.
When you remove a FIS from a FIS tree, any existing connections to that FIS are also removed.
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fisTout3.FIS([2 4]) = [1;
fisTout3.Connections(end+l,:) = ["fisl/outputl" "fis5/inputl"];
fis5.Inputs(1l).Name = "fislout";

To make the number of FIS tree outputs match the number of outputs in the training data, remove
the FIS tree outputs from fisl and fis3.

fisTout3.0utputs(2:end) = [];
Update the input training data order according to the new FIS tree input configuration.

[4 6 3 1];
trnX(:,inputOrders2);

inputOrders?2
orderedTrnX2

Since the FIS tree configuration is changed, you must rerun both the learning and tuning steps. In
the learning phase, the existing rule parameters are also tuned to fit the new configuration of the FIS
tree.

options.Method = "particleswarm";
options.OptimizationType = "learning";
options.MethodOptions.MaxIterations = 50;

[~,~,rule] = getTunableSettings(fisTout3);

rng('default')
if runtunefis
fisTout4 = tunefis(fisTout3,rule,orderedTrnX2,trnY,options); %#ok<UNRCH>
else
fisTout4 = tunedfis.fisTout4;
fprintf('Training RMSE = %.3f MPG\n',calculateRMSE(fisTout4,orderedTrnX2,trnY));
end

Training RMSE = 3.380 MPG

In the training phase, the parameters of the membership function and rules are tuned.

options.Method = "patternsearch";
options.OptimizationType = "tuning";
options.MethodOptions.MaxIterations = 75;
options.MethodOptions.UseCompletePoll = true;
[in,out,rule] = getTunableSettings(fisTout4);
rng(‘'default")
if runtunefis
fisTout5 = tunefis(fisTout4,[in;out;rule],orderedTrnX2,trnY,options); S%#ok<UNRCH>
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else

fisTout5 = tunedfis.fisTout5;

fprintf('Training RMSE = %.3f MPG\n',calculateRMSE(fisTout5,orderedTrnX2,trnY));
end

Training RMSE = 3.049 MPG

At the end of the tuning process, the FIS tree contains updated MF and rule parameter values. The
rule base size of the new FIS tree configuration is smaller than the previous configuration.

fprintf("Total number of rules = %d\n",numel([fisTout5.FIS.Rulesl]));
Total number of rules = 11

Check Performance of the Simplified FIS Tree

Evaluate the updated FIS tree using the four input attributes of the checking dataset.

orderedV1dX2 = vldX(:,inputOrders2);
plotActualAndExpectedResultsWithRMSE(fisTout5,orderedV1dXx2,vldY)

RMSE = 3.1524 MPG
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The simplified FIS tree with four input attributes produces better results in terms of RMSE as
compared to the first configuration, which uses six input attributes. Therefore, it shows that a FIS
tree can be represented with fewer number of inputs and rules to generalize the training data.

Conclusion

You can further improve the training error of the tuned FIS tree by:
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* Increasing number of iterations in both the rule-learning and parameter-tuning phases. Doing so
increases the duration of the optimization process and can also increase validation error due to
overtuned system parameters with the training data.

* Using global optimization methods, such as ga and particleswarm, in both rule-learning and
parameter-tuning phases. ga and particleswarm perform better for large parameter tuning
ranges since they are global optimizers. On the other hand, patternsearch and
simulannealbnd perform better for small parameter ranges since they are local optimizers. If
rules are already added to a FIS tree using training data, then patternsearch and
simulannealbnd may produce faster convergence as compared to ga and particleswarm. For
more information on these optimization methods and their options, see ga (Global Optimization
Toolbox), particleswarm (Global Optimization Toolbox), patternsearch (Global Optimization
Toolbox), and simulannealbnd (Global Optimization Toolbox).

* Changing the FIS properties, such as the type of FIS, number of inputs, number of input/output
MFs, MF types, and number of rules. For fuzzy systems with a large number of inputs, a Sugeno
FIS generally converges faster than a Mamdani FIS since a Sugeno system has fewer output MF
parameters (if constant MFs are used) and faster defuzzification. Small numbers of MFs and
rules reduce the number of parameters to tune, producing a faster tuning process. Furthermore, a
large number of rules may overfit the training data.

* Modifying tunable parameter settings for MFs and rules. For example, you can tune the support of
a triangular MF without changing its peak location. Doing so reduces the number of tunable
parameters and can produce a faster tuning process for specific applications. For rules, you can
exclude zero MF indices by setting the ALlowEmpty tunable setting to false, which reduces the
overall number of rules during the learning phase.

* Changing FIS tree properties, such as number of fuzzy systems and connections between the
fuzzy systems.

» Using different ranking and grouping of the inputs to the FIS tree.

Local Functions
function plotActualAndExpectedResultsWithRMSE(fis,x,y)

% Calculate RMSE bewteen actual and expected results
[rmse,actY] = calculateRMSE(fis,Xx,y);

% Plot results

figure

subplot(2,1,1)

hold on

bar(actY)

bar(y)

bar(min(actY,y), 'FaceColor',[0.5 0.5 0.5])

hold off

axis([0 200 0 60])

xlabel("Validation input dataset index"),ylabel("MPG")

legend(["Actual MPG" "Expected MPG" "Minimum of actual and expected values"], ...
'"Location', 'NorthWest"')

title("RMSE = " + num2str(rmse) + " MPG")

subplot(2,1,2)

bar(actY-y)

xlabel("Validation input dataset index"),ylabel("Error (MPG)")
title("Difference Between Actual and Expected Values")
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end
function [rmse,actY] = calculateRMSE(fis,x,y)

% Evaluate FIS
actY = evaluateFIS(fis,x);

% Calculate RMSE
del = actY - y;
rmse = sqrt(mean(del.”2));

end
function y = evaluateFIS(fis,x)

% Specify options for FIS evaluation
persistent evalOptions
if isempty(evalOptions)
evalOptions = evalfisOptions("EmptyOutputFuzzySetMessage", "none",
"NoRuleFiredMessage", "none", "OutOfRangeInputValueMessage", "none");
end

% Evaluate FIS
y = evalfis(fis,x,evalOptions);

end

See Also
fistree | getTunableSettings | sugfis | tunefis

More About
. “Tuning Fuzzy Inference Systems” on page 3-2
. “Tune Mamdani Fuzzy Inference System” on page 3-27
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This example shows parameter optimization of a fuzzy inference system (FIS) using k-fold cross
validation. This example uses genetic algorithm (GA) optimization, which requires Global
Optimization Toolbox™ software.

Data Overfitting in FIS Parameter Tuning

Data overfitting is a common problem in FIS parameter optimization. When overfitting occurs, the
tuned FIS produces optimized results for the training data set but performs poorly for a test data set.
Due to overtuning, the optimized FIS parameter values pick up noise from the training data set and
lose the ability to generalize to new data sets. The difference between the training and test
performance increases with the increased bias of the training data set.

To overcome the data overfitting problem, a tuning process can stop early based on an unbiased
evaluation of the model using a separate validation dataset. Such a validation dataset can also
increase bias if it does not accurately represent the problem space. To overcome bias from the
validation data set, a k-fold cross-validation approach is commonly used. Here, the training data is
randomly shuffled and then divided into k partitions, as shown in the following figure. For each
training-validation iteration, a different partition is used for validation, with the remaining data used
for testing. Therefore, each data partition is used once for validation and k — 1 times for training.

Data partition and validation iterations for k=4

Data
partition

1 2 3 4
Training-validation iteration

- validation data

training data

Each training-validation iteration runs for n cycles; however, an iteration can stop early at ny < n and
advance to the next iteration if an increase in the validation cost exceeds a predefined threshold

value. The optimized model at the end of the k™ iteration is used as the output of the k-fold cross-
validation process.

This example shows how using k-fold cross validation with the tunefis function prevents data
overfitting compared to parameter tuning that does not use k-fold cross validation.

Tune FIS without K-Fold Validation

This example describes a data overfitting problem for automobile fuel consumption prediction. It uses
several automobile profile attributes to predict fuel consumption. The training data is available in the
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University of California at Irvine Machine Learning Repository and contains data collected from
automobiles of various makes and models.

This example uses the following six input data attributes to predict the output data attribute MPG
with a FIS:

Number of cylinders

Displacement

Horsepower

Weight

Acceleration

O A W N R

Model year

Load the data using the Lloaddata utility function shown at the end of the example. This function
creates training and test data sets.

[data,varName,trnX,trnY, testX,testY] = loadData;

Create an initial FIS based on the input and output data attributes using the constructFIS utility
function.

fisin = constructFIS(data,varName);
Create an option set for tuning the FIS. The default option set uses GA for optimization.
options = tunefisOptions;

If you have Parallel Computing Toolbox™ software, you can improve the speed of the tuning process
by setting options.UseParallel to true. If you do not have Parallel Computing Toolbox software,
set options.UseParallel to false.

To demonstrate the data overfitting problem, this example uses a maximum of 100 generations to
tune the rules.

options.MethodOptions.MaxGenerations = 100;

Tune the FIS using the specified tuning data and options. Tuning rules using the tunefis function
takes several minutes. This example uses a flag, runtunefis, to either run the tunefis function or
load pretrained results. To load the pretrained results, set runtunefis to false.

runtunefis = false;
To demonstrate the data overfitting problem, use the following performance measures:

» Training error — Root-mean-square error (RMSE) between the expected training output and the
actual training output obtained from the tuned FIS.

* Test error — RMSE between the expected test output and the actual test output obtained from the
tuned FIS.

* Function count — The total number of evaluations of the cost function for tuning the FIS.
In this example, use only rule parameter settings for tuning the FIS.

Since GA optimization uses random search, to obtain reproducible results, initialize the random
number generator to its default configuration.
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if runtunefis
% Get rule parameter settings.
[~,~,rule] = getTunableSettings(fisin);

% Set default random number generator.
rng('default"')

% Tune rule parameters.
[outputFIS,optimData] = tunefis(fisin, rule,trnX,trnY,options);

% Get the trainig error.
trnErrNoKFold = optimData.tuningOutputs.fval

% Calculate the test error.
evalOptions = evalfisOptions("EmptyOutputFuzzySetMessage", "none",

"NoRuleFiredMessage", "none", "OutOfRangeInputValueMessage", "none");
actY = evalfis(outputFIS,testX,evalOptions);
del = actY - testY;

testErrNoKFold = sqrt(mean(del.”2))

% Get the function count.
fcnCountNoKFold = optimData.totalFcnCount

save tuningWithoutKFoldValidation trnErrNoKFold testErrNoKFold fcnCountNoKFold
else

% Load the pretrained results.

results = load('tuningWithoutKFoldValidation.mat');

trnErrNoKFold = results.trnErrNoKFold

testErrNoKFold = results.testErrNoKFold

fcnCountNoKFold = results.fcnCountNoKFold
end

trnErrNoKFold = 2.4952
testErrNoKFold = 2.8412

fcnCountNoKFold = 19210

The higher value of the test error as compared to the training error indicates that the trained FIS is
more biased to the training data.

Tune FIS Parameters with K-Fold Validation

You can use k-fold cross validation in FIS parameter optimization by setting options.KFoldValue
to a value greater than or equal to 2. For this example, set the k-fold value to 4.

options.KFoldValue = 4;

To specify a tolerance value for which stop a k-fold tuning process, set the
options.ValidationTolerance property. For this example, set the tolerance value to 0.02. This
tolerance value configures the k-fold tuning process to stop if the current validation cost increases by
more than 2% of the minimum validation cost found up to that point in the tuning process.

options.ValidationTolerance = 0.02;

For a noisy data set, you can compute a moving average of the validation cost by setting the
options.ValidationWindowSize property to a value greater than 1. For this example, set the
validation window size to 2.
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options.ValidationWindowSize = 2;

Restrict the maximum number of generations in each tuning process to 25 so that the total number of
generations in the 4-fold tuning process is the same as the previous case.

options.MethodOptions.MaxGenerations = 25;

Tune the FIS with k-fold validation.

if runtunefis
% Set default random number generator.
rng('default"')

% Tune the FIS.
[outputFIS,optimData] = tunefis(fisin, rule,trnX,trnY,options);

% Get the trainig error.
trnErrWithKFold = optimData.tuningOutputs(end).fval

% Calculate the test error.

actY = evalfis(outputFIS, testX,evalOptions);
del = actY - testY;

testErrWithKFold = sqrt(mean(del.”2))

% Get the function count.
fcnCountWithKFold = optimData.totalFcnCount

save tuningWithKFoldValidation trnErrWithKFold testErrWithKFold fcnCountWithKFold
else

% Load the pretrained results.

results = load('tuningWithKFoldValidation.mat');

trnErrWithKFold = results.trnErrWithKFold

testErrWithKFold = results.testErrWithKFold

fcnCountWithKFold = results.fcnCountWithKFold
end

trnErrWithKFold = 2.7600
testErrWithKFold = 2.9082

fcnCountWithKFold = 5590

Plot the test-to-training error differences for training both with and without k-fold cases.

= categorical({'Without k-fold', 'With k-fold'});
cats = reordercats(cats,{'Without k-fold', 'With k-fold'});

= [trnErrNoKFold testErrNoKFold testErrNoKFold-trnErrNoKFold; .
trnErrWithKFold testErrWithkKFold testErrWithKFold-trnErrWithKFold];
b = bar(cats,data);
ylabel('Root mean square error (RMSE)")

text(b(3).XEndPoints,b(3).YEndPoints,string(b(3).YData), 'HorizontalAlignment"', 'center',...

'"VerticalAlignment', 'bottom')
legend('Training error','Test error','Test to training error difference',
'Location', 'northoutside')
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The test error performance is similar in both cases. However, the difference in the training and test
errors with k-fold validation is less than without k-fold validation. Therefore, the k-fold validation
reduces the bias of the training data and produces better generalized FIS parameter values. The total
function count during k-fold validation is less than the count without k-fold validation.

disp(table(fcnCountNoKFold, fcnCountWithKFold, .
'VariableNames', ["Without k-fold" "With k-fold"],
'RowName', "Function counts"))

Without k-fold With k-fold

Function counts 19210 5590

Therefore, k-fold validation reduces the number of generations in each GA optimization cycle,
reducing FIS parameter overfitting. The overall k-fold validation results can be further improved by
experimenting with different k-fold, tolerance, and window size values.

Conclusion

With k-fold cross validation, you can achieve better FIS parameter generalization with fewer function
counts as compared to a similar tuning process without run-time cross validation.

In general, use the following process for FIS parameter optimization with k-fold validation:

1  Start with a validation tolerance of 0 and a window size of 1, which provide the minimal k-fold
performance.
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2 Increase the k-fold value to achieve your desired performance. In general, use a k-fold value less
than or equal to 10.

Increase the tolerance value to achieve your desired performance.
Increase the window size to achieve your desired performance.
You can repeat steps 3 and 4 in a loop to find optimal validation settings.

Higher values of tolerance, window size, and k-fold value introduce data overfitting in the optimized
FIS parameter values. Therefore, use smaller values to achieve your desired tuning performance.

Local Functions
function [data,varName, trnX,trnY,testX,testY] = loadData

Load the data. Each row of the dataset obtained from the repository represents
a different automobile profile. Data contains 7 columns, where the first six
columns contain the following input attributes.
- Number of cylinders
- Displacement
- Horsepower
- Weight
- Acceleration
- Model year
The seventh column contains the output attribute, MPG.
data,name] = loadgas;

— 9% 0° 0% 0% 0P O° o° O° o° o°

% Remove leading and trailing whitespace from the attribute names.
varName = strtrim(string(name));

o°

Create input and output data sets.
size(data,2);

data(:,1:n-1);

data(:,n);

< X o
L ||

% Create training and test data sets.
trnX = x(1:2:end, :);

trnY = y(1:2:end,:);
testX = x(2:2:end, :);
testY = y(2:2:end,:);
end

function fisin = constructFIS(data,varName)

% Create a Sugeno FIS.
fisin = sugfis;

Add input and output variables to the FIS, where each variable represents
one of the data attributes. For each variable, use the corresponding
attribute name and range. To reduce the number of rules, use two MFs for
each input variable, which results in 276=64 input MF combinations.
Therefore, the FIS uses a maximum of 64 rules corresponding to the input
MF combinations. Both input and output variables use default triangular
MFs, which are uniformly distributed over the variable ranges.

dataRange = [min(data)' max(data)'];

numINputs = size(data,2)-1;

numInputMFs = 2;

d° 0° o° 0 o° o° o°
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numOutputMFs = numInputMFs”~numINputs;
for i = 1l:numINputs

fisin = addInput(fisin,dataRange(i,:), 'Name',varName(i), 'NumMFs',numInputMFs);
end

% To improve data generalization, use 64 MFs for the output variable.

% Doing so allows the FIS to use a different output MF for each rule.

fisin = addOutput(fisin,dataRange(end,:), ‘Name',varName(end), 'NumMFs"',numOutputMFs);
fisin.Rules = repmat(fisrule,[1 numOutputMFs]);

end
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Predict Chaotic Time Series Using Type-2 FIS

This example shows chaotic time series prediction using a tuned type-2 fuzzy inference system (FIS).
This example tunes the FIS using particle swarm optimization, which requires Global Optimization
Toolbox™ software.

Time Series Data

This example simulates time-series data using the following form of the Mackey-Glass (MG) nonlinear
delay differential equation.

x(t) = 0.2x(t—=1)

= T 0= X0 =1 - 0.1x(t)

Simulate the time series for 1200 samples using the following configuration.

* Sample time tg = 1 sec

* Initial condition x(0) = 1.2
e =20

e x(t-T1)=0fort<r.

ts = 1;

numSamples = 1200;

tau = 20;

X = zeros(1l,numSamples+tau+l);
x(tau+l) = 1.2;

for t = l+tau:numSamples+tau
x_dot = 0.2*x(t-tau)/(1l+(x(t-tau))"10)-0.1*x(t);
x(t+1) = x(t) + ts*x _dot;

end

Plot the simulated MG time-series data.

figure(1l)

plot(x(tau+2:end))

title('Mackey-Glass Chaotic Time Series')
xlabel('Time (sec)')

ylabel('x(t)")
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Generate Training and Validation Data

Time-series prediction uses known time-series values up to time t to predict a future value at time
t + P. The standard method for this type of prediction is to create a mapping from D sample data
points, sampled every A units in time (x(t — (D — 1)A), ..., x(t — A), x(t)) to a predicted future value
x = (t + P). For this example, set D = 4 and A = P = 1. Hence, for each t, the input and output
training data sets are [x(t — 3), x(t — 2), x(t — 1), x(f)] and x(t + 1), respectively. In other words, use
four successive known time-series values to predict the next value.

Create 1000 input/output data sets from samples x(100 + D — 1) to x(1100 + D - 2).

D = 4;
inputData = zeros(1000,D);
outputData = zeros(1000,1);
for t = 100+D-1:1100+D-2
for i = 1:D
inputData(t-100-D+2,1i) = x(t-D+i);
end
outputData(t-100-D+2,:) = x(t+1);
end

Use the first 500 data sets as training data (trnX and trnY) and the second 500 sets as validation
data (v1dX and v1dY).

trnX = inputData(1:500,:);
trnY = outputData(1:500,:);
vldX = inputData(501:end,:);
vldY = outputData(501:end,:);
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Construct FIS

This example uses a type-2 Sugeno FIS. Since a Sugeno FIS has fewer tunable parameters than a
Mamdani FIS, a Sugeno system generally converges faster during optimization.

fisin = sugfistype2;

Add three inputs, each with three default triangular membership functions (MFs). Initially, eliminate
the footprint of uncertainty (FOU) for each input MF by setting each lower MF equal to its
corresponding upper MF. To do so, set the scale and lag values of each lower MF to 1 and 0,
respectively. By eliminating the FOU for all input membership functions, you configure the type-2 FIS
to behave like a type-1 FIS.

numInputs = D;
numInputMFs = 3;
range = [min(x) max(x)];
for i = l:numInputs
fisin = addInput(fisin, range, 'NumMFs',numInputMFs);
for j = l:numInputMFs
fisin.Inputs(i).MembershipFunctions(j).LowerScale = 1;
fisin.Inputs(i).MembershipFunctions(j).LowerLag = 0;
end
end

For prediction, add an output to the FIS. The output contains default constant membership functions.
To provide maximum resolution for the input-output mapping, set the number of output MFs equal to
the number of input MF combinations.

numOutputMFs = numInputMFs~numInputs;
fisin = addOutput(fisin, range, 'NumMFs',numOutputMFs);

View the FIS structure. Initially, the FIS has zero rules. The rules of the system are found during the
tuning process.

plotfis(fisin)
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Tune FIS with Training Data
To tune the FIS, you use the following three steps.

Learn the rule base while keeping the input and output MF parameters constant.

Tune the output MF parameters and the upper MF parameters of the inputs while keeping the
rule and lower MF parameters constant.

3 Tune the lower MF parameters of the inputs while keeping the rule, output ME and upper MF
parameters constant.

The first step is less computationally expensive due to the small number of rule parameters, and it
quickly converges to a fuzzy rule base during training. After the second step, the system is a trained
type-1 FIS. The third step produces a tuned type-2 FIS.

Learn Rules
To learn a rule base, first specify tuning options using a tunefisOptions object.
options = tunefisOptions;

Since the FIS does not contain any pretuned fuzzy rules, use a global optimization method (genetic
algorithm or particle swarm) to learn the rules. Global optimization methods perform better in large
parameter tuning ranges as compared to local optimization methods (pattern search and simulated
annealing). For this example, tune the FIS using particle swarm optimization ('particleswarm').

options.Method = 'particleswarm';


https://www.mathworks.com/help/fuzzy/tunefisoptions.html

Predict Chaotic Time Series Using Type-2 FIS

To learn new rules, set the OptimizationType to 'learning"'.
options.OptimizationType = 'learning';

Restrict the maximum number of rules to the number of input MF combinations. The number of tuned
rules can be less than this limit, since the tuning process removes duplicate rules.

options.NumMaxRules = numInputMFs~numInputs;

If you have Parallel Computing Toolbox™ software, you can improve the speed of the tuning process
by setting UseParallel to true. If you do not have Parallel Computing Toolbox software, set
UseParallel to false.

options.UseParallel = false;

Set the maximum number of iterations to 10. Increasing the number of iterations can reduce training
error. However, the larger number of iterations increases the duration of the tuning process and can
overtune the rule parameters to the training data.

options.MethodOptions.MaxIterations = 10;

Since particle swarm optimization uses random search, to obtain reproducible results, initialize the
random number generator to its default configuration.

rng('default')

Tuning a FIS using the tunefis function takes several minutes. For this example, enable tuning by
setting runtunefis to true. To load pretrained results without running tunefis, you can set
runtunefis to false.

runtunefis = false;

Tune the FIS using the specified training data and options.

if runtunefis
fisoutl = tunefis(fisin,[],trnX,trnY,options);

else
tunedfis = load('tunedfischaotictimeseriestype2.mat');
fisoutl = tunedfis.fisoutl;

end

View the structure of the trained FIS, which contains the new learned rules.

plotfis(fisoutl)
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Check the individual input-output relationships tuned by the learned rulebase. For example, the
following figure shows the relationship between the second input and the output.

gensurf(fisoutl,gensurfOptions('InputIndex',2))
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Evaluate the tuned FIS using the input validation data. Plot the actual generated output with the
expected validation output, and compute the root-mean-square-error (RMSE).

plotActualAndExpectedResultsWithRMSE (fisoutl,vldX,vldY)
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Tune Upper Membership Function Parameters

Tune the upper membership function parameters. A type-2 Sugeno FIS supports only crisp output
functions. Therefore, this step tunes input upper MFs and crisp output functions.

Obtain the input and output parameter settings using getTunableSettings. Since the FIS uses
triangular input MFs, you can tune the input MFs using asymmetric lag values.

[in,out] = getTunableSettings(fisoutl, 'AsymmetricLag',true);
Disable the tuning of lower MF parameters.

for i = 1l:length(in)
for j = 1l:length(in(i).MembershipFunctions)
in(i).MembershipFunctions(j).LowerScale.Free = false;
in(i).MembershipFunctions(j).LowerLag.Free = false;
end
end

To optimize the existing tunable MF parameters while keeping the rulebase constant, set
OptimizationTypeto 'tuning’.

options.OptimizationType = 'tuning';

Tune the FIS using the specified tuning data and options. To load pretrained results without running
tunefis, you can set runtunefis to false.

rng('default")
if runtunefis
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fisout2 = tunefis(fisoutl,[in;out],trnX,trnY,options);
else
tunedfis = load('tunedfischaotictimeseriestype2.mat');
fisout2 = tunedfis.fisout2;
end

View the structure of the trained FIS, which now contains tuned upper MF parameters.

plotfis(fisout2)
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Evaluate the tuned FIS using the validation data, compute the RMSE, and plot the actual generated
output with the expected validation output.

plotActualAndExpectedResultsWithRMSE (fisout2,vldX,vldY)
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Tuning the upper MF parameters improves the performance of the FIS. This result is equivalent to
tuning a type-1 FIS.

Tune Lower Membership Function Parameters

Tune only the input lower MF parameters. To do so, set the lower scale and lag values tunable, and
disable tuning of the upper MF parameters.

for i = 1:length(in)
for j = 1l:length(in(1i).MembershipFunctions)
in(i).MembershipFunctions(j).UpperParameters.Free = false;
in(i).MembershipFunctions(j).LowerScale.Free = true;
in(i).MembershipFunctions(j).LowerLag.Free = true;
end

~ —

end

Tune the FIS using the specified tuning data and options. To load pretrained results without running
tunefis, you can set runtunefis to false.

rng('default")

if runtunefis
fisout3 = tunefis(fisout2,in,trnX,trnY,options);

else
tunedfis = load('tunedfischaotictimeseriestype2.mat');
fisout3 = tunedfis.fisout3;

end

View structure of the trained FIS, which now contains tuned lower MF parameters.
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plotfis(fisout3)
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Evaluate the tuned FIS using the validation data, compute the RMSE, and plot the actual generated

output with the expected validation output.

plotActualAndExpectedResultsWithRMSE (fisout3,vldX,vldY)
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Tuning both the upper and lower MF values improves the FIS performance. The RMSE improves
when the trained FIS includes both tuned upper and lower parameter values.

Conclusion

Type-2 MFs provides additional tunable parameters as compared to type-1 MFs. Therefore, with
adequate training data, a tuned type-2 FIS can fit the training data better than a tuned type-1 FIS.

Overall, you can produce different tuning results by modifying any of the following FIS properties or
tuning options:

* Number of inputs

*  Number of MFs

* Type of MFs

* Optimization method

* Number of tuning iterations

Local Functions
function [rmse,actY] = calculateRMSE(fis,x,y)
% Specify options for FIS evaluation

evalOptions = evalfisOptions("EmptyOutputFuzzySetMessage", "none",
"NoRuleFiredMessage", "none", "OutOfRangeInputValueMessage", "none");
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% Evaluate FIS
actY = evalfis(fis,x,evalOptions);

% Calculate RMSE
del = actY - y;
rmse = sqrt(mean(del.”2));

end

function plotActualAndExpectedResultsWithRMSE(fis,vldX,vldY)
[rmse,actY] = calculateRMSE(fis,vldX,vldY);

figure

plot([actY vldY])

axis([0 length(vldY) min(vldY)-0.01 max(vldY)+0.13])
xlabel('sample index')

ylabel('signal value')

title(['RMSE = ' num2str(rmse)])

legend(["Actual output" "Expected output"],'Location',"northeast")
end

See Also
sugfistype2 | tunefis

More About

. “Type-2 Fuzzy Inference Systems” on page 2-7
. “Tuning Fuzzy Inference Systems” on page 3-2
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This example shows how to tune a fuzzy inference system (FIS) using a custom cost function. The
example requires Global Optimization Toolbox™ software.

Problem Description

In this example, you use a custom cost function to learn robot navigation in a simulation environment.
The goal of the navigation task is to reach a specified target while avoiding obstacles. The direction to

N
the target is represented as a unit force vector (F;) directed from the robot to a target location. The

—
obstacle avoidance direction is represented by a unit force vector (F,) directed towards the robot
from the closest obstacle location.

Simulation Environment for Robot Navigation
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The robot, target, and obstacle are shown as circles with 0.5 m radius in the 25 m x 25 m simulation
environment. The navigation task is to combine the force vectors such that the direction 8 of the

[
resultant force vector F provides a collision-free direction for the robot.

- — -
F=wF,+ (1 -—w)F, where0=sw=<1

0=/LF

This example assumes a robot with differential kinematics for the simulation. In other words, the
robot can rotate on its center without any constraints. However, to avoid sharp turns, the change per



Tune Fuzzy Robot Obstacle Avoidance System Using Custom Cost Function

time step in the robot direction is limited to [-7, 7] Therefore, if the current robot heading direction
is 6,(k), the next heading direction is calculated as:

0.(k + 1) = 6,(k) + min(max(e - 0.(k), %) - %)

—_
The weight w of the force vector F, is calculated using function f,:

w= fw(a: 6t,o)

where

d
a= d—‘z is the ratio of the robot-to-obstacle distance (d,) and the robot-to-target-distance (d;)

* 0, 1is the absolute difference between the target and obstacle directions with respect to the robot

To achieve the navigation task, the function f,, must generate high w values, that is, focus on
avoiding the obstacle when:

* Both the target and obstacle directions from the robot are similar (6; , is low)

* The obstacle is closer to the robot than the target (a is low).

Otherwise, f,, must generate low w values, that is, focus on reaching the target.

The goal of this example is to design a FIS that learns fuzzy rules and optimizes the FIS parameters
to model the function f,, for collision-free robot navigation in the simulation environment.

Assumptions

The following assumptions apply for the robot simulation:

* The robot can perfectly localize in the simulation environment; that is, the robot knows its current
position in the simulation environment.
» The robot is equipped with perfect sensors to identify the obstacle and determine its location.

* The robot has no dynamic constraints; that is, the robot can rotate and move as commanded
without any mechanical constraints. To avoid sharp turns, a soft constraint is imposed on rotation,

which limits the change per time step in the robot heading to [-7, 7]

* The robot runs with a fixed speed. You can include additional fuzzy systems to control the robot
speed. For simplicity, this example uses a fixed speed for the robot.

Construct Fuzzy System

To model function f,, construct a FIS as shown in the following figure. For this example, use a
Mamdani FIS.

a—'!-

FIS ———w

H{.u

—h.
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fisin = mamfis;
Add the following two inputs as shown in the previous figure.
* a — Ratio of distances, robot-to-obstacle / robot-to-target

* 0; ,— Difference between target and obstacle directions

Set the range of the first input to [0, 2], which indicates that a contributes to obstacle avoidance
when the obstacle distance is less than or equal to twice the target distance.

Set the range of the second input to [0, pi/2], which indicates that 6; , contributes to obstacle
avoidance when the difference between the target and obstacle directions is less than or equal to

pi/2.
fisin
fisin

addInput(fisin, [0 2], 'Name', 'alpha');
addInput(fisin, [0 pi/2], 'Name', 'theta t 0');

To minimize the number of rules, which corresponds to the number of combinations of input
membership functions, add two membership functions (MFs) to each input. To generate similar
membership values beyond the input ranges, use zmf (Z-shaped curve membership function) and smf
(S-shaped curve membership function) MFs. The tuning process optimizes the input MF parameter
values.

Add membership functions to the first input.

fisin
fisin

addMF (fisin, "alpha', 'zmf',[0 2], 'Name', 'low"');
addMF (fisin, "alpha', 'smf', [0 2], 'Name', "'high");

Add membership functions to the second input.

fisin
fisin

addMF (fisin, 'theta t o', 'zmf',[0 pi/2], ‘Name', 'low"');
addMF (fisin, 'theta t o', 'smf',[0 pi/2], 'Name', "high");

Add an output to the FIS or the obstacle force vector weight, restricting the weight values to the
range [0, 1].

fisin = addOutput(fisin, [0 1], 'Name','w');

Add two MFs to the output. You can add more MFs to the output for finer granularity of output
values. However, doing so increases the number of tuning parameters. The output MFs also use zmf
and smf to generate similar membership values beyond the input ranges. The tuning process
optimizes the output MF parameter values.

addMF (fisin, 'w', 'zmf', [0 1], '‘Name', 'low');
addMF (fisin, 'w', 'smf', [0 11, 'Name', "high');

fisin
fisin

View the FIS structure. Initially, the FIS has zero rules. The tuning process finds rules for the fuzzy
system.

figure
plotfis(fisin)
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Learn Rules and Optimize FIS Parameters

Since you do not have training data for this example, you simulate the robot navigation using a
custom cost function. The tuning process uses this custom cost function when optimizing the FIS
parameters.

For parameter optimization, obtain the parameter settings from the FIS.
[in,out] = getTunableSettings(fisin);

Next, create tuning options with OptimizationType set to Llearning. This example uses the
genetic algorithm (ga) optimization method for the tuning process. To improve the speed of the
tuning process, set the UseParallel option to true, which requires Parallel Computing Toolbox
software. If you do not have Parallel Computing Toolbox software, set UseParallel to false.

™

options = tunefisOptions('Method', 'ga', 'OptimizationType', 'learning');

Set the population size of the genetic algorithm to 200. The larger population size increases the
probability of generating a better solution in fewer generations.

options.MethodOptions.PopulationSize = 200;

Set the maximum number of generations to 25. To tune the parameters further, you can set a higher
number of generations. However, doing so increases the duration of the tuning process and can
overtune the parameter values.

options.MethodOptions.MaxGenerations = 25;
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Set the locations of the obstacle, target, and robot for the training environments. Set the initial
heading of the robot to pi/2 for the training environment. To learn navigation both with and without
obstacle avoidance on the way to the target location, use two training tasks with different obstacle
locations.

trnObstacle = [3 12;13 18];
trnTarget = [13 22;13 22];
trnRobot = [13 2 pi/2;13 2 pi/2;];

showSimulationEnvironmentsForTraining(trnObstacle,trnTarget, trnRobot)

Training Task: 1
25 25
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Specify the custom cost function using a function handle.

costFunction = @(fis)navigationCostFcn(fis,trnObstacle,trnTarget,trnRobot);

In the cost function, the robot navigation is simulated in the training environments using each FIS
from the population. Each navigation task is run for 100 iterations, where each iteration is equivalent
to a decision cycle of length 1 s. The robot uses a fixed speed of 0.5 m/s throughout the navigation
task. For more simulation details, see the getNavigationResults function.

function cost = navigationCostFcn(fis,obstacle,target, robot)

cost = 0;

for i = 1l:size(obstacle,1)

results = getNavigationResults(fis,obstacle(i,:),target(i,:),robot(i,:));
cost = cost + getNavigationCost(results);

end

end

The cost of each navigation task is the total distance traveled by the robot. If the robot does not reach
the target or collides with the obstacle, a high cost value (200) is assigned for the simulation.

function cost = getNavigationCost(results)

if results.notSafe || ~results.reachedTarget
cost = 200;
else
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cost = results.travelledDistance;
end
end

Since genetic algorithm optimization uses random search, to obtain reproducible results, initialize the
random number generator to its default configuration.

rng('default')

Learning rules using the tunefis function takes approximately 10 minutes. For this example, enable
tuning by setting runtunefis to true. To load pretrained results without running tunefis, you can
set runtunefis to false.

runtunefis = false;

Tune the FIS using the specified training environments and tuning options.

if runtunefis
fisout = tunefis(fisin,[in;out],costFunction,options); S%#ok<UNRCH>
else
tunedfis = load('tunedfisnavigation.mat');
fisout = tunedfis.fisout;
end

The tuned FIS produces the following robot trajectories in the simulation environments.
showNavigationTrajectories(fisout, trnObstacle,trnTarget, trnRobot)

Navigation Task: 1 Navigation Task: 2
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In the first case, the robot reaches the target with minimum distance since the obstacle is not on the
path to the target. In the second case, the robot successfully avoids the obstacle and reaches the
target.

View the structure of the tuned FIS, fisout.

figure
plotfis(fisout)
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The tuning process produces a set of new rules for the FIS.
fisout.Rules

ans =
1x5 fisrule array with properties:

Description

Antecedent
Consequent
Weight
Connection
Details:
Description
1 "alpha==low & theta t o==high => w=low (1)"
2 "alpha==low & theta t o==low => w=high (1)"
3 "theta t o==high => w=low (1)"
4 "alpha==high & theta t o==high => w=low (1)"
5 "alpha==low => w=low (1)"

The rules are described as follows with respect to the expected behaviors of f,:
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Rule 1 is consistent with the expected behavior of f,,. When the obstacle is not located in front of
the robot on the way to the target (6; , is high) and the obstacle is close (a is low), this rule
produces low weight values.

Rule 4 is also consistent with the expected behavior of f,,. When the obstacle is not located in
front of the robot on the way to the target (6; , is high) and the obstacle is farther away (a is
high), this rule produces low weight values.

Rule 3 generates low weight values when the obstacle is not located in front of the robot (6; , is
high), irrespective of the obstacle distance. This rule covers the conditions for both rule 1 and rule
4. Therefore, rules 1 and 4 are redundant and can be removed.

Rule 2 is also consistent with the expected behavior of f,,. When the obstacle is close to the robot
(a is low) and is located in front of the robot on the way to the target (6; , is low), this rule
produces high weight values for the obstacle avoidance task.

Rule 5 generates low weight values when the obstacle distance is low. This rule contradicts rule 2
when 6; , is low. In this case, the output of rule 5 does not contribute to the final output due to the
high output values of rule 2. Therefore, rule 5 can also be removed.

Remove the redundant rules.

fisoutpruned = fisout;
fisoutpruned.Rules([1 4 5]) = [];
fisoutpruned.Rules

ans =

1x2 fisrule array with properties:

Description
Antecedent
Consequent
Weight
Connection

Details:
Description

1 "alpha==low & theta t o==low => w=high (1)"
2 “theta_t o==high => w=low (1)"

fisout and fisoutpruned generate similar control surfaces. Therefore, only two rules are

necessary for obstacle avoidance in the simulation environment.

figure

subplot(1,2,1)

gensurf(fisout)

title('Output surface of fisout')
subplot(1,2,2)

gensurf(fisoutpruned)

title('Output surface of fisoutpruned')
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Check Performance

Validate the performance of the tuned FIS with different positions of the obstacle, robot, and target.
In the following validation cases, the robot successfully avoids the obstacle to reach the target
position using the tuned FIS.

vldObstacle = [13 5;10 10;8 8];

vldRobot = [5 12 0;5 20 -pi/2;19 19 -pil;
vldTarget = [23 12;15 4;5 5];

showNavigationTrajectories(fisoutpruned,vldObstacle,vldTarget,vldRobot)

Navigation Task: 1 Navigation Task: 2 Navigation Task: 3
25 25 25
®  Obstacle ®  Obstacle ®  Obstacle
#  Target #  Target #  Target
20 #  Robol 20 #  Robot 20 #  Robol
15 15 15
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Conclusion

This example uses a custom cost function that simulates robot navigation in different training
environments to learn fuzzy rules and optimize the FIS parameter values for collision-free navigation.
You can Include more training environments to learn obstacle avoidance in other scenarios, for
example narrow corridor and U-shape obstacles. In these scenarios, the robot may need additional
navigation subtasks, such as wall following and subtarget (intermediate landmark) reaching, for
successful collision-free navigation to the target. Complex environments also require additional terms
in the cost calculation for safe navigation. For example, in a narrow corridor the robot should stay in
the middle; that is, the distances to the obstacles on the left and right should be the same.

Using a custom cost function with tunefis provides the flexibility of simulating a custom system
with custom cost calculation. However, the tradeoff is a lengthy tuning process due to the number of
simulations required (for each set of optimized parameter values). Therefore, if possible, to expedite
the tuning process, use training data. For instance, the tuning process in this example would run
faster if input/output decision data of a human operator was available for tuning the FIS.

Local Functions

function showSimulationEnvironment(obstacle, target, robot,navigationResults)
% Show the robot trajectory in the simulation environment.

% Radius of the robot, target, and obstacle.
radius = 1; % 1m

% Use 25mx25m simulation environment.
axis([0 25 0 25]);

% Set equal aspect ratio.
pbaspect([1 1 1])

% Temporary plots to enable legends.

hold on
plot(robot(l),robot(2)+radius, 'ob"', 'LineWidth', radius*1, 'MarkerFaceColor','b")
plot(robot(l),robot(2)+radius, 'or', 'LineWidth', radius*1, '"MarkerFaceColor','r")
plot(robot(l),robot(2)+radius, 'og', 'LineWidth', radius*1, '"MarkerFaceColor','g")
hold off

% Draw obstacle.
rectangle('Position', [obstacle(1l)-0.5*radius obstacle(2)+0.5*radius radius radius],
'Curvature',[1 1], 'FaceColor','b"', 'EdgeColor','b")

% Draw target.
rectangle('Position',[target(1l)-0.5*radius target(2)+0.5*radius radius radius],
"Curvature',[1 1], 'FaceColor','r"', 'EdgeColor','r")

% Draw robot.
rectangle('Position',[robot(1)-0.5*radius robot(2)+0.5*radius radius radius],
'"Curvature',[1 1], 'FaceColor','qg"', 'EdgeColor','g")

% Add labels, title, and legends.

xlabel('x (m)"'),ylabel('y (m)")

title('Simulation Environment for Robot Navigation')
legend(["Obstacle" "Target" "Robot"])

% Plot the robot trajectory if specified.
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if nargin == 4
X = navigationResults.Xx;
y = navigationResults.y;
for i = l:numel(x)
rectangle('Position', [x(i)-0.5*radius y(i)+0.5*radius radius radius],
"Curvature',[1 1], 'FaceColor','g', 'EdgeColor','qg")
end
end

end
function showSimulationEnvironmentsForTraining(obstacle,target, robot)

% Show simulation environments for training.
drawEnvironmentAndShowTrajectory(obstacle, target, robot, 'Training Task')

end
function showNavigationTrajectories(fis,obstacle,target, robot)

% Show robot trajectories in the simulation environments.
drawEnvironmentAndShowTrajectory(obstacle, target, robot, 'Navigation Task',b fis)

end

function drawEnvironmentAndShowTrajectory(obstacle,target, robot,plotTitle,varargin)
% Expand figure horizontally to tile the simulation environments.

h = figure;

h.Position = [h.Position(1:2) 3*h.Position(3) h.Position(4)];

numTasks = size(target,1);

% Draw each simulation environment.

for i = 1l:numTasks
0 = obstacle(i,:);
t = target(i,:);
r = robot(i,:);

subplot(1,numTasks,i)

if ~isempty(varargin)
results = getNavigationResults(varargin{l1l},o0,t,r);
showSimulationEnvironment(o,t,r, results)

else
showSimulationEnvironment(o,t,r)

end

title([plotTitle ': ' num2str(i)])

end

end

See Also
getTunableSettings | mamfis | tunefis

More About
. “Tuning Fuzzy Inference Systems” on page 3-2
. “Tune Mamdani Fuzzy Inference System” on page 3-27
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Classify Pixels Using Fuzzy Systems

This example shows how to classify image pixels using a fuzzy inference system (FIS). This example
requires Image Processing Toolbox™ software.

Pixel classification is an image processing technique that segments an image by classifying each pixel
according to specific pixel attributes. Noise and other sources of uncertainty can complicate pixel
classification. Using a FIS-based method for classification can help address such uncertainty.

This example includes the following stages.

1 Tune a FIS to classify pixels based on color.
2 Tune a FIS to classify pixels based on texture.
3 Combine the tuned FIS objects into a hierarchical fuzzy system for pixel classification.

Load the image data, which contains three visible segments: green grass, white border, and soccer
ball.

exData = load('fuzzpixclass');
cImg = exData.cImg;

figure
imshow(cImg)

This example uses fuzzy systems to segment the image into three categories by classifying each pixel
as belonging to the green grass, white border, or soccer ball.

Segment Image Using Color

The image segments include the following color attributes.
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* Green field: variation of green and dark shadow pixels

*  White border: white, light green, and dark shadow pixels

* Soccer ball: white and dark color pixels

Since the number of dark pixels is insignificant compared to the green and white pixels, you can

create one fuzzy classifier to distinguish between green and white pixels. You can train the classifiers
with sample green and white pixels since none of the segments include unique color attribute.

Extract representative subimages from the green field and white border segments as training data.
Each subimage includes variations in pixel color.

grnImg = exData.grnImg;
whtImg = exData.whtImg;
figure

subplot(1,2,1)
imshow(grnImg)
xlabel('Green subimage')
subplot(1,2,2)
imshow(whtImg)
xlabel('White subimage')

I'il "

Green subimage White subimage

Construct FIS

For color segmentation, construct a three-input, one-output Sugeno FIS without rules. For each input
and output variable, include two default membership functions (MFs).
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colorFISIn = sugfis('NumInputs',3, 'NumInputMFs"',?2,
"NumQutputs',1, 'NumOutputMFs',2, 'AddRules', 'none');

The input variables correspond to the RGB values for each pixel. The output value is high if the pixel
color is green; otherwise it is low.

Train FIS

Create training data from the representative color subimages. The getColorInputData helper
function, which is shown at the end of the example, creates a three-column array of RGB values for
each pixel in a specified image.

[grnSubRow, grnSubCol, grnSubbDepth] = size(grnImg); % Green subimage size
[whtSubRow,whtSubCol,whtSubDepth] = size(whtImg); % White subimage size
trnX = [...
getColorInputData(grnImg);
getColorInputData(whtImg)
1;
trnY = [...
ones(grnSubRow*grnSubCol,1); % Output is high (1) for green pixels
zeros (whtSubRow*whtSubCol, 1) % Output is low (1) for white pixels

1;

Input data trnX has three columns for the RGB pixel values. Output data trnY is a column vector
that contains a 1 for each green pixel and a 0 for each white pixel.

Create an option set for learning rules for colorFISIn. To reduce the duration of the optimization
process, use the minimum values for cross-validation parameters.

options = tunefisOptions('OptimizationType', 'learning', 'KFoldValue',?2,
'ValidationTolerance',0.0, 'ValidationWindowSize',1);

If you have Parallel Computing Toolbox™ software, you can improve the speed of the tuning process
by setting options.UseParallel to true. If you do not have Parallel Computing Toolbox software,
set options.UseParallel to false.

To learn rules and find FIS parameter values, this example uses genetic algorithm optimization,
which is a stochastic process. To obtain reproducible results, initialize the random number generator
to its default configuration.

rng('default')

Learn fuzzy rules for colorFISIn using the training data and options. Learning rules using the
tunefis function can take several minutes. For this example, you can enable tuning by setting
runtunefis to true. To load pretrained results without running tunefis, set runtunefis to
false.

runtunefis = false;

To learn new rules without tuning input and output MF parameters, set the parameter settings to [ ].
For more information, see tunefis.

if runtunefis
colorFISOQutl = tunefis(colorFISIn,[],trnX,trnY,options); %#ok<UNRCH>

else
colorFISOutl

exData.colorFISOutl;
end
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Calculate the root mean squared error (RMSE) for the trained FIS. The calculateRMSE helper
function, which is shown at the end of the example, classifies the training data pixels using the
trained FIS and compares the results to the expected pixel classifications.

fprintf('Training RMSE after learning rules = %.3f MPG\n',...
calculateRMSE(colorFISOutl, trnX,trnY));

Training RMSE after learning rules = 0.283 MPG

After learning the new rules, tune the input and output MF parameters. To obtain the tunable
parameter settings of the FIS, use the getTunableSettings function.

[in,out] = getTunableSettings(colorFISOutl);

To tune the existing FIS parameter values without learning new rules, set the OptimizationType to
"tuning’.

options.OptimizationType = 'tuning';
Tune the FIS parameters using the specified tunable settings, training data, and tuning options.

if runtunefis
rng('default"')
colorFISOut = tunefis(colorFISOutl, [in;out],trnX,trnY,options);
colorFISOut.Name = "colorFISOut";
else
colorFISOut = exData.colorFISOut;

end

Calculate the RMSE for the tuned FIS.

fprintf('Training RMSE after tuning MF parameters = %.3f MPG\n',...
calculateRMSE(colorFISOut,trnX,trnY));

Training RMSE after tuning MF parameters = 0.228 MPG
Segment Image

Segment the original image using the tuned FIS. To do so, first extract the red, green, and blue pixel
values.

[imgRow,imgCol,imgDepth] = size(cImg);
red = cImg(:,:,1);

green = cImg(:,:,2);

blue = cImg(:,:,3);

colorInput = [red(:) green(:) blue(:)];

Classify each pixel using the tuned FIS.

eoptions = evalfisOptions;

eoptions.EmptyOutputFuzzySetMessage = 'none’;
eoptions.NoRuleFiredMessage = 'none';
eoptions.QutOfRangeInputValueMessage = 'none';

y = evalfis(colorFISOut,colorInput,eoptions);

Segment the image using the getSegmentedImage helper function, which is shown at the end of the
example. This function creates a binary mask from the FIS output values.
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greenSegment = getSegmentedImage(reshape(y, [imgRow,imgCol]),cImg);

View the segmented image. Pixels that the FIS classified as white are shown in black. The remaining
pixels are classified as green.

figure
imshow(greenSegment)

White pixels are partially removed from the border and ball segments. The green segment also
incorrectly includes pixels from the ball. Therefore, the classification process requires another pixel
attribute that can identify the difference between the grass field and the ball.

Segment Image Using Texture

To distinguish between the field and the ball, use gray image gradient data to identify textures of the
field and the ball.

Extract a representative subimage for the ball, and convert the green, white, and ball subimages to
grayscale.

ballImg = exData.ballImg;
grayGrnImg rgb2gray(grnImg);
grayWhtImg rgb2gray(whtImg);
grayBallImg = rgb2gray(ballImg);

Compute the gradient for each subimage and normalize the gradient magnitude for each pixel using
the normMat helper function.

[gX,gY] = imgradientxy(grayGrnImg);
grnGrsTexture = normMat(imgradient(gX,qgY));
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[gX,gY] = imgradientxy(grayWhtImg);
whtGrsTexture = normMat(imgradient(gX,gY));

[gX,9Y] = imgradientxy(grayBallImg);
ballTexture = normMat(imgradient(gX,gY));

View the gradients for each subimage.

figure,
subplot(2,3,1)
imshow(grnImg)
subplot(2,3,2)
imshow(whtImg)
subplot(2,3,3)
imshow(ballImg)
subplot(2,3,4)
imshow(grnGrsTexture)
subplot(2,3,5)
imshow(whtGrsTexture)
subplot(2,3,6)

imshow(ballTexture)
I | ]
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Both the green and white grass segments have similar gradient values, which are different than those
of the ball segment. Therefore, use only the green and ball segment gradient data to train a fuzzy
texture classifier.

Construct FIS
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The normalized gradients for the ball and grass field have different patterns. To learn these patterns,
create a three-input, one-output Sugeno FIS without rules. For each input and output variable,
include two default membership functions (MFs).

textureFISIn = sugfis('NumInputs',3, 'NumInputMFs',?2,
"NumQutputs',1, '"NumOQutputMFs',2, 'AddRules', 'none');

The input variables specify gradient values for three successive pixels. The output value is high if the
third pixel belongs to the grass field; otherwise, it is low.

Train FIS

Create training data from the gradients of the green and ball regions. The getGradientInputData
helper function, which is shown at the end of the example, creates a three-column array of successive
pixel value combinations.

[grsGradRow,grsGradCol] = size(grnGrsTexture);
[ballGradRow, ballGradCol] = size(ballTexture);

[
“©
[

“©

Grass texture size
Ball texture size

trnX = [...
getGradientInputData(grnGrsTexture); ... % gradient values of 3 successive pixels
getGradientInputData(ballTexture) ... % gradient values of 3 successive pixels
1;

trnY = [...
ones(grsGradRow*grsGradCol,1); ... % Output is high (1) for green texture
zeros(ballGradRow*ballGradCol,1) ... % Output is low (1) for ball texture

1;

Input data trnX is has three columns for the gradient values of the three successive pixels. Output
data trnY is a column vector that contains a 1 if the third pixel belongs to field texture and a 0
otherwise.

To learn fuzzy rules, set the OptimizationType to 'learning’.
options.OptimizationType = 'learning';
Train textureFISIn to learn rules using the training data.
if runtunefis
rng(‘'default"')
textureFISOutl = tunefis(textureFISIn,[],trnX,trnY,options); S%#ok<UNRCH>
else
textureFISOutl = exData.textureFISOutl;
end
fprintf('Training RMSE after learning rules = %.3f MPG\n',...
calculateRMSE(textureFISOutl, trnX,trnY));

Training RMSE after learning rules = 0.477 MPG

After learning the new rules, tune the input and output MF parameters. To obtain the tunable
parameters of the FIS, use the getTunableSettings function.

[in,out] = getTunableSettings(textureFISOutl);

To tune the existing FIS parameters without learning new rules, set the OptimizationType to
"tuning’.

options.OptimizationType = 'tuning';
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Tune the FIS parameters using the specified tunable settings, training data, and tuning options.

if runtunefis
rng('default"')
textureFISOut = tunefis(textureFISOutl, [in;out],trnX,trnY,options);
textureFISOut.Name = "textureFISOut";

else
textureFISOut = exData.textureFISOut;

end

fprintf('Training RMSE after tuning MF parameters = %.3f MPG\n',...
calculateRMSE (textureFISOut, trnX,trnY));

Training RMSE after tuning MF parameters = 0.442 MPG
Segment Image

Segment the original image using the tuned FIS. To do so, first compute the image gradient and
extract the successive pixel combinations.

[gX,gY] = imgradientxy(rgb2gray(cImg));

imgTexture = normMat(imgradient(gX,qgY));

gradInput = getGradientInputData(imgTexture);

Classify each pixel using the tuned FIS.

y = evalfis(textureFISOut,gradInput,eoptions);

Segment the image using the getSegmentedImage helper function.

grassField = getSegmentedImage(reshape(y, [imgRow,imgCol]),cImg);

View the segmented image. Pixels that the FIS classified as belonging to the ball are shown in black.
The remaining pixels are classified as field pixels.

figure
imshow(grassField)
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The trained FIS segments the grass field and the ball with few incorrect pixels in the segments.

Segment Image Using Both Color and Texture

To classify pixels based on both color and texture, you can combine colorFISOut and
textureFISOut using a hierarchical fuzzy system, or FIS tree.

To do so, first create a Sugeno FIS with two inputs and three outputs. The first input variable is the
output of colorFISOut and the second input variable is the output of textureFISOut. The output
variables are the degree to which a pixels belongs to each image segment: green field, white border,
and soccer ball.

segFIS = sugfis('Name', 'segFIS', 'NumInputs',2, 'NumInputMFs',2,
"NumOutputs',3, 'NumOutputMFs',2, 'AddRules', 'none');

Name the input variables, output variable, and MFs.

segFIS.Inputs(1l).Name = 'color';

segFIS.Inputs(1l).MembershipFunctions(1l).Name = 'white';
segFIS.Inputs(1l).MembershipFunctions(2).Name = 'green’;
segFIS.Inputs(2).Name = 'texture';
segFIS.Inputs(2).MembershipFunctions(1l).Name = 'ball"’;
segFIS.Inputs(2).MembershipFunctions(2).Name = ‘'grass’;
segFIS.Outputs(1l).Name = 'greenField";
segFIS.Outputs(1l).MembershipFunctions(1).Name = 'low';
segFIS.Outputs(1l).MembershipFunctions(2).Name = 'high';
segFIS.Outputs(2).Name = 'whiteBorder';
segFIS.Outputs(2).MembershipFunctions(1).Name = 'low';
segFIS.Outputs(2).MembershipFunctions(2).Name = 'high';
(

segFIS.Outputs(3).Name = 'soccerBall';
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segFIS.Outputs(3).MembershipFunctions(1).Name
segFIS.Outputs(3).MembershipFunctions(2).Name

"low';
"high';

Add the following rules to the FIS.

» If the pixel has a smooth ball texture, set the soccer ball output to high.
» If the pixel is white and has a grass texture set the white border output to high.
» If the pixel is green and has a grass texture and is green field output to high.
rules = ["texture==ball => greenField=1low, whiteBorder=low, soccerBall=high";
"color==white & texture==grass => greenField=low, whiteBorder=high, soccerBall=low";

"color==green & texture==grass => greenField=high, whiteBorder=1low, soccerBall=low"];
segFIS = addRule(segFIS, rules);

Create a FIS tree by connecting the outputs of colorFISOut and textureFISOut to the inputs of
segFIS.

fis [colorFISOut textureFISOut segFIS];
con = [...
"colorFISOut/outputl" "segFIS/color";
"textureFISOut/outputl" "segFIS/texture"
1;

fisT = fistree(fis,con);

Classify the image pixels using the FIS tree and segment the image. For each segmented image, the
nonblack pixels are classified as part of the segment.

y = evalfis(fisT,[colorInput gradInput],eoptions);

greenField = getSegmentedImage(reshape(y(:,1),[imgRow,imgCol]),cImg);
whiteBorder = getSegmentedImage(reshape(y(:,2),[imgRow,imgCol]),cImg);
soccerBall = getSegmentedImage(reshape(y(:,3),[imgRow,imgCol]),cImg);

View the green field pixels.
figure

imshow(greenField)
xlabel('Green field')
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Green field

View the white border pixels.

figure
imshow(whiteBorder)
xlabel('White border')
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White border

View the soccer ball pixels.
figure

imshow(soccerBall)
xlabel('Soccer ball')
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Soccer ball

Conclusion

The image segments contain incorrect classifications. You can remove many of the misclassified pixels
by post-processing the results using noise reduction algorithms, such as morphological operations
(imdilate, imerode, imopen, imclose). For example, use a morphological close operation to
reduce the noise in the green field segmented image.

greenFieldLowNoise = getSegmentedImageClose(reshape(y(:,1),[imgRow,imgCol]),cImg);

figure
imshow(greenFieldLowNoise)
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To improve fuzzy classifier performance, you can:

* Use more training data.
* Learn color patterns of multiple pixels instead of learning individual pixel color.

* Increase the length of the gradient feature vector, in other words, use gradient values of more
than three successive pixels.

* Add more MFs to the FIS for pixel classification.

* Use type-2 FIS.

* Use a validation tolerance, a larger window size, and higher k-fold values for cross validation.
* Tune the parameters of the constructed FIS tree segFIS.

Local Functions

function data = getColorInputData(img)
% Create RGB input data from an image for training.

[row,col,depth] = size(img);
data = zeros(row*col,depth);
id = 0;

:col
+ 1;

k = 1:depth

data(id, k) = img(i,j, k);
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end

function [rmse,actY] = calculateRMSE(fis,x,y)
% Calculate root mean squared error for FIS output.

% Specify options for FIS evaluation
persistent evalOptions
if isempty(evalOptions)
evalOptions = evalfisOptions("EmptyOutputFuzzySetMessage", "none",
"NoRuleFiredMessage", "none", "OutOfRangeInputValueMessage", "none");
end

% Evaluate FIS
actY = evalfis(fis,x,evalOptions);

% Calculate RMSE

del = actY - y;

rmse = sqrt(mean(del.”2));

end

function cImg = getSegmentedImage(y,cImg)

% Segment an image using classifier output by creating a binary image
% using a 0.5 threshold.

id =y >= 0.5;

y(id) = 1;

y(~id) = 0;

cImg(:,:,1) = cImg(:,:,1).*y;
cImg(:,:,2) = cImg(:,:,2).*%y;
cImg(:,:,3) = cImg(:,:,3).*y;
end

function y = normMat(x)
% Normalize array elements to the range [0 1].

tmp = x(:);
min(tmp);
max (tmp) ;
(mx-mn);

y =y/d;
end
end

function data = getGradientInputData(x)
% Create gradient input data for training.

X = Xx(:);
n = 3; % Three successive gradient values.
data = zeros(length(x),n);

% Specify complete input vectors.
for i = n:length(x)
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data(i,:) = x(i-n+1l:1i)"';
end

% Approximate missing elements in the incomplete input vector.
for i = n-1:-1:1

right = x(1:1)';

m=n - 1i;

left = repmat(right(1),[1 m]);

data(i,:) = [left right];
end

end

function cImg = getSegmentedImageClose(y,cImg)
% Segment an image using classifier output by creating a binary image
% using a 0.5 threshold.

id =y >= 0.5;
y(id) = 1;
y(~id) = 0;

se = strel('disk',1);
y = imclose(y,se);

cImg(:,:,1) = cImg(:,:,1).*y;
cImg(:,:,2) = cImg(:,:,2).*y;
cImg(:,:,3) = cImg(:,:,3).*y;
end

See Also

fistree | getTunableSettings | sugfis | tunefis

More About

. “Tuning Fuzzy Inference Systems” on page 3-2
. “Fuzzy Trees” on page 2-52
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Autonomous Parking Using Fuzzy Inference System

This example shows how to tune a fuzzy inference system (FIS) for an autonomous parking
application with nonholonomic constraints. This example requires Global Optimization Toolbox™
software.

Autonomous parking is an essential capability of intelligent vehicles (autonomous cars).
Nonholonomic kinematics impose additional constraints on autonomous parking, where a car cannot
move sideways and instead using a curving motion.

Kinematic Model

The following figure shows the kinematics of a nonholonomic car with a standard Ackermann steering
mechanism.

i |

<Y

The kinematic model has the following parameters.

* 0 is the current orientation of the car with respect to a global reference frame.
* ¢ is the steering angle with respect to the car orientation.
* Fis the front wheel center, (x¢, yf).

* R is the rear wheel center, (x, y;).
* |RF| is the length of the wheelbase.
* O is the center of curvature for the car.
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* |OR| is the radius of curvature for the car.

In this model, the rear-wheel orientation is fixed and parallel to the car body, that is the rear wheels
have the same orientation as the car, 6. The front wheels are parallel to each other and rotate with
the steering angle, ¢. The steering angle is constrained to an angle of +@®. For this example, & = 30
deg.

The front and rear wheel centers have the following relationship.
Xf = xr = | RF | *cos(6)
Vf = Yr = | RF| *sin(0)

The kinematic equations for the front wheel center velocity and car orientation velocity are as
follows, where s is the speed of the car.

Xf = s*cos(6 + @)
Vf = s*sin(6 + @)

5 _ S*sin(¢)
9= "1rF|

Autonomous Parking

The minimum radius of curvature (OR) for a car depends on the wheelbase length (RF). This
minimum radius constrains the motion of the car during parking maneuvers.

When a human driver parks, they often fail to maintain the required car speed and orientation when
approaching an empty parking space. To successfully park without a collision, they must compensate
by switching between forward and backward motion while adjusting the speed and steering angle of
the car.

Human drivers do not consciously perform geometric computations based on the kinematic model of
their car. Instead, based on their own trial-and-error experience, they use natural rules and reasoning
to understand the constraints of their car within a parking situation. You can use fuzzy systems to
model such rule-based reasoning.

This example uses the following environment for simulating head-on parking of a nonholonomic car.
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Occupied space

ST 7T
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~ s | Empty parking spot
;‘ =— (Car
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Empty road-space

Here:

* The simulation environment is a 45 x 15ft parking lot.
* The hatched area shows occupied parking spots.
* The empty parking spot is of size 6 x 7ft.

* The caris of size 5 X 3ft and the length of the wheelbase (|RF|) is 3ft, providing 1ft offset from
the wheelbase to both the front and rear of the car.

This example assumes the following.

* The caris equipped with an intelligent system that can detect an empty parking spot and then
stop the car near the starting edge of the parking spot.

» The autonomous parking system takes control of the car after it stops. Ideally, at the starting
position, the car is almost vertically centered in the road and parallel to the road (6 = 0 deg or
0 = 180 deg).

* Due to the dynamic nature of a parking lot,the kinematic motion constraints, and physical car
attributes, a car does stop at the exact desired position and orientation. Therefore, the parking
system assumes that the car stops somewhere in front of the empty parking spot with 6 = 0 or
0 = 180 deg and unequal space to the sides of the car.

* For collision-free parking, the car is equipped with range sensors to provide range data for the
front, rear, left, and right sides of the car. The following figure shows an example of the range data
obtained from the sensors in the simulation environment.
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Right

Front Car Rear

Left

* The maximum sensor range is assumed to be 50ft, which covers the entire simulation
environment.

Human Reasoning for Car Parking

Generally, as shown below, human drivers maintain the appropriate speed and steering angle when
approaching an empty head-on parking spot. In this case, they can park without any forward and
backward oscillating motions.

15

10

Y (11)

0 5 10 15 20 25 30 35 40 45

However, sometimes drivers fail to maintain the desired speed and steering angle for oscillation-free
parking. As shown in the following example, the drivers must then compensate using back-and-forth
motions.
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15
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Y (1)
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In this case, the driver:

Turns right and moves forward

2  Fails to enter the parking spot since the front of the car approaches the car in the occupied
space.

3 Turns left and backs up to make enough room to enter the parking spot

Enters the parking spot with forward motion while adjusting the car orientation to align with the
parking direction

5 Stops when the front of the car is a safe minimal distance from the end of the parking spot and
the vehicle is aligned with the parking spot (90 deg orientation within the simulation
environment)

The following section uses these motions patterns to construct fuzzy systems for autonomous parking.
Generate Training Data

For tuning the fuzzy systems, this example artificially generates training data using the kinematic
model of the car and the motion patterns described in the previous section. The data generation
process uses the following discrete form of the kinematic model, where At is 0.1.

xp(k + 1) = x¢(k) + At.s(k + 1).cos(0(k) + ¢(k + 1))
Ve(k + 1) = yp(k) + At.s(k + 1) .sin(0(k) + ¢(k + 1))

s(k+1).sing(k + 1)
|RF|

Ok +1) =

x(k + 1) = x;(k + 1) = |RF| .cos6(k + 1)
yrlk +1) = ys(k + 1) - |RF| .sinf(k + 1)

The steering angle (¢) and speed (s) values are generated based on the typical human driver patterns
discussed previously. The steering angle and speed are constrained to the following limits.

-0=¢p=0,
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@ =30°

-3.S=s=<8§,
S=5

ft
sec

In order to make space for safe turning, the backward motion uses higher speed when the car gets
closer to the occupied space. Alternatively, the car can use the same speed, however, for longer
period in case of backward motion to make adequate space for safe turning.

Load the training data structure.
trainingData = load('trainingData');
Each training data point includes five inputs.

* Angular deviation (A8) between the car orientation and the parking spot orientation

* Minimum distances to the front (dfront), left (dieft), rear (dreqr), and right (dpignt) of the car

Each training data point includes two outputs.

* Steering angle (¢)
* Speed (s) of the car

Since the angular deviation and distance values have different units and scales, the training data is
normalized to the range [0 1]. Doing so removes any sensitivity of the cost function to errors in the
larger magnitude inputs. The training data structure contains both the original input and output
values (x and y) and their normalized values (xn and yn).

During data generation, a successful parking condition is achieved when the car reaches a minimum
safe distance from the end of the parking spot and is aligned with the parking direction.

Construct and Train Initial Fuzzy Systems

This example uses a FIS tree as the fuzzy parking system. The first stage of the tuning process is to
construct and train the initial FISs that you later assemble into a FIS tree. You then improve
performance by fine tuning tune the parameters of the entire FIS tree.

To construct and tune the initial fuzzy systems, this example uses ANFIS, which provides faster
convergence compared to other tuning methods.

The design of the FIS tree and its component fuzzy systems addresses the following considerations.

* The FIS tree has five inputs and two outputs that match the values in the training data set.

* Since ANFIS supports a single output, separate fuzzy subsystems are constructed for steering
angle (¢) and speed (s).

» For better performance, each of these subsystems uses separate FISs for forward and backward
motion.

* The forward and backward motion controllers for each subsystem are combined using an
additional FIS.
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Train the forward motion controller for steering, forwardPhiFIS, using the training input and
output data. To do so, first extract the normalized steering angle training data.

forwardPhi = trainingData.yn(:,1);

Then, since this system is only for forward motion, set the steering angle output values to 0 for
negative speed values.

negSpeedId = trainingData.y(:,2) < 0;
forwardPhi(negSpeedId) = 0;

Create options for ANFIS training.
aoptions = anfisOptions;

Use three MFs for the first input (A0) since it has both positive and negative values. Use two MFs for
the distance inputs.

aoptions.InitialFIS = [3 2 2 2 2];
Display only final training results.

aoptions.DisplayANFISInformation = false;
aoptions.DisplayErrorValues = false;
aoptions.DisplayStepSize = false;

Train forwardPhiFIS.
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forwardPhiFIS = anfis([trainingData.xn forwardPhi],aoptions);

Minimal training RMSE = 0.100129

Replace the default FIS name with forwardPhiFIS.

forwardPhiFIS.Name = 'forwardPhiFIS';

In a similar manner, train the forward motion controller for speed, forwardSpeedFIS.

forwardSpeed = trainingData.yn(:,2);
forwardSpeed(negSpeedId) = 0;

forwardSpeedFIS = anfis([trainingData.xn forwardSpeed],aoptions);
Minimal training RMSE = 0.161479
forwardSpeedFIS.Name = 'forwardSpeedFIS';

Next, tune the backward motion controllers for steering angle and speed, backwardPhiFIS and
backwardSpeedF1IS, respectively. In this case, set the output values to 0 for positive speed values.

Train backwardPhiFIS.

backwardPhi = trainingData.yn(:,1);
backwardPhi(~negSpeedId) = 0;

backwardPhiFIS = anfis([trainingData.xn backwardPhi],aoptions);
Minimal training RMSE = 0.112362

backwardPhiFIS.Name = 'backwardPhiFIS';

Train backwardSpeedFIS.

backwardSpeed = trainingData.yn(:,2);
backwardSpeed(~negSpeedId) = 0;

backwardSpeedFIS = anfis([trainingData.xn backwardSpeed],aoptions);

0.0642125

Minimal training RMSE

backwardSpeedFIS.Name = 'backwardSpeedFIS';

Next, train phiFIS, which combines the forward and backward steering angle values generated by
forwardPhiFIS and backwardPhiFIS. To generate input training data for phiFIS, evaluate
forwardPhiFIS and backwardPhiF1IS using the normalized input training data.

eoptions = evalfisOptions;
eoptions.EmptyOutputFuzzySetMessage ='none';
eoptions.NoRuleFiredMessage = 'none';
eoptions.OQutOfRangeInputValueMessage = 'none';

forwardPhi = evalfis(forwardPhiFIS, trainingData.xn,eoptions);
backwardPhi = evalfis(backwardPhiFIS,trainingData.xn,eoptions);

Use five MFs for each input. In this case, you can use higher number of MFs since phiFIS has only
two inputs.

aoptions.InitialFIS = 5;
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Train phiFIS using the generated input data and the normalized output training data.
phiFIS = anfis([forwardPhi backwardPhi trainingData.yn(:,1)],aoptions);
Minimal training RMSE = 0.120349

phiFIS.Name = 'phiFIS";

Similarly, train speedFIS, which combines the forward and backward speed values generated by
forwardSpeedFIS and backwardSpeedFIS. To generate input training data for speedFIS,
evaluate forwardSpeedFIS and backwardSpeedFIS using the normalized input training data.

forwardSpeed = evalfis(forwardSpeedFIS,trainingData.xn,eoptions);
backwardSpeed = evalfis(backwardSpeedFIS,trainingData.xn,eoptions);

speedFIS = anfis([forwardSpeed backwardSpeed trainingData.yn(:,2)],aoptions);
Minimal training RMSE = 0.0969036
speedFIS.Name = 'speedFIS';

Construct and Tune FIS Tree

The next stage of the tuning process is to construct and tune and fuzzy tree using the previously
tuned component FISs. To create the FIS tree, first define the connections between the component
FISs according to the overall FIS tree design.

connections = [...
"forwardPhiFIS/output" "phiFIS/inputl”; .
"backwardPhiFIS/output” "phiFIS/input2"; .
"forwardSpeedFIS/output" "speedFIS/inputl";
"backwardSpeedFIS/output" "speedFIS/input2"; ...
"forwardPhiFIS/inputl" "backwardPhiFIS/inputl”;
"forwardPhiFIS/inputl" "forwardSpeedFIS/inputl”; .
“forwardPhiFIS/inputl" "backwardSpeedFIS/inputl”;
"forwardPhiFIS/input2" "backwardPhiFIS/input2";
"forwardPhiFIS/input2" "forwardSpeedFIS/input2"; .
“forwardPhiFIS/input2" "backwardSpeedFIS/input2";
"“forwardPhiFIS/input3" "backwardPhiFIS/input3";
"forwardPhiFIS/input3" "forwardSpeedFIS/input3"; ...
"forwardPhiFIS/input3" "backwardSpeedFIS/input3";
"forwardPhiFIS/input4" "backwardPhiFIS/input4";
"forwardPhiFIS/input4" "forwardSpeedFIS/input4"; .
“forwardPhiFIS/input4" "backwardSpeedFIS/input4";
"forwardPhiFIS/input5" "backwardPhiFIS/input5";
"forwardPhiFIS/input5" "forwardSpeedFIS/input5"; .

"forwardPhiFIS/input5" "backwardSpeedFIS/input5";

1;

Construct the FIS tree.

fuzzySystems = [forwardPhiFIS backwardPhiFIS forwardSpeedFIS backwardSpeedFIS phiFIS speedFIS];
fisT = fistree(fuzzySystems,connections);

Next, fine-tune both MF and rule parameter values of fisT. For better performance, tune the fuzzy
system parameters for individual outputs.

» First, tune FIS parameters for steering angle.
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* Second, tune FIS parameters for speed.

To tune FIS tree parameters for one output without considering the other output value, you can
temporarily remove the other output from the FIS tree.

To tune the FIS tree for the steering angle output, remove the second output from fisT and get
tunable settings from forwardPhiFIS, backwardPhiF1IS, and phiFIS.

fisTinl = fisT;

fisTinl.Outputs(2) = [];

[in,out,rule] = getTunableSettings(fisTinl, 'FIS',...
["forwardPhiFIS" "backwardPhiFIS" "phiFIS"]);

Create a tuning option set.
toptions = tunefisOptions;

Use patternsearch method for fine tuning and set the maximum iteration number to 10. If you
have Parallel Computing Toolbox™ software, you can improve the speed of the tuning process by
setting toptions.UseParallel to true. If you do not have Parallel Computing Toolbox software,
set options.UseParallel to false.

toptions.Method = 'patternsearch';
toptions.MethodOptions.MaxIterations = 10;

To improve pattern search results, set method option UseCompletePoll to true.

toptions.MethodOptions.UseCompletePoll = true;

For reproducibility, set the random number generator seed to default.

rng('default')

Training can be computationally intensive and take several hours to complete. To save time, load a
pretrained FIS tree by setting runtunefis to false. To run the tuning, you can set runtunefis to
true.

runtunefis = false;

Tune the FIS tree.

if runtunefis
fisToutl = tunefis(fisTinl, [in;out;rulel, ...
trainingData.xn,trainingData.yn(:,1),toptions);
else
preTunedFIST = load('tunedFIST');
fisToutl = preTunedFIST.fisToutl;
end

Next, tune the other FIS tree output by first removing the speed output and adding steering angle
output. Then get tunable settings from forwardSpeedF1IS, backwardSpeedFIS, and speedFIS.

fisTin2 = fisToutl;

fisTin2.0utputs(1l) = "speedFIS/output";

[in,out,rule] = getTunableSettings(fisTin2, 'FIS', ...
["forwardSpeedFIS" "backwardSpeedFIS" "speedFIS"]);

Tune the FIS tree. After training, reset the outputs of the FIS tree.
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if runtunefis
rng('default"')
fisTout = tunefis(fisTin2, [in;out;rulel],...

trainingData.xn,trainingData.yn(:,2),toptions);

fisTout.Outputs(1) "phiFIS/output";
fisTout.Outputs(2) "speedFIS/output";

else
fisTout = preTunedFIST.fisTout;

end

Check the individual training errors (root-mean-square error) of the outputs.

err = trainingData.yn - evalfis(fisTout,trainingData.xn,eoptions);
err = err.*err;
rmsePhi = sqrt(mean(err(:,1)))

rmsePhi = 0.1186

rmseSpeed sqrt(mean(err(:,2)))

rmseSpeed = 0.0967

The performance is not significantly better compared to the ANFIS-trained fuzzy systems.
Autonomous Parking Simulation

According to the training data, the tuned FIS is valid for the following initial conditions:

* The car front must be initially located in front of the parking spot with 21 = x¢ < 25.

* The car must be closely aligned with the road direction, that is, the initial car orientation must be
0 = 0or6 =180 deg.

* The car must initially be at least 1.5 ft from either road edge, that is djef; > 1.5 ft and
dright >1.51ft

Parking from Right Side
The tuned FIS is trained for head-on parking from right side (6 = 180 deg) of the road.
The following result shows a head-on parking simulation for xy = 24 ft, yr = 4.5 ft, and 6 = 180 deg.

parkFromRight = true;

xf = 24;

yf = 4.5;

theta = 180;

figure
simulateParking(parkFromRight, fisTout, trainingData,xf,yf, theta)

Parked
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Simulate parking for a different initial condition where xf = 22 ft, yr = 5 ft, and 6 = 170 deg.

parkFromRight = true;

xf = 22;

yf =5;

theta = 170;

figure

simulateParking(parkFromRight, fisTout,trainingData,xf,yf, theta)

Parked
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In both cases, the car can autonomously park using the back-and-forth motion pattern. However, the
car does not maintain equal distance values on the left and right sides of the parking space. This
behavior is common for human drivers who do not generally park in the exact middle of a parking
space. Instead, they use a safe distance from each side.

Parking from Left Side

You can use the same fuzzy system for head-on parking from the left side (6 = 0 deg). To do so: with
input digps interchanged with djef. Hence, the input values are changed as follows:

» Switch the sign of the angular deviation input A6.
* Switch the distance inputs for the left (djeft) and right (drignt) sides.

Simulate autonomous parking from left side for xy = 22 ft, yr = 5.5 ft, and 6 = 0 deg.

parkFromRight = false;

xf = 22;

yf =5;

theta = 0;

figure

simulateParking(parkFromRight, fisTout,trainingData,xf,yf,theta)

Parked
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Simulate parking for another initial condition where x¢ = 22 ft, yr = 5.5 ft, and 6 = 0 deg.

parkFromRight = false;

xf = 23.8;

yf = 5.2;

theta = 7;

figure

simulateParking(parkFromRight, fisTout,trainingData,xf,yf, theta)

Parked
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In this case, similar to the right side parking results, the car follows a back-and-forth motion to safely
park the car.

Conclusion

The current fuzzy system design has the following shortcomings:

The generated data only considers two motion patterns for autonomous parking. Therefore, the
autonomous parking system has limited robustness and does not represent all common skills of a
human driver. For example, the following figure shows another common scenario where the driver
moves back and turn right to make space on right from the occupied space.
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* The generated data uses a +30 deg limit for steering angles. Therefore, it is difficult for the car to

park without oscillation due to the higher radius of curvature.

* The sensor model used in this example is a trivial occupancy detection model where the range
values are radially detected from the center of the car. Furthermore, when range data is similar
from each corner of the car, the fuzzy system can produce unexpected results and local optima
within the simulation. A better alternative is to model range data normal to each side of the car as
shown below, where clearance on each side is distinct from each other.

Left
* ANFIS supports only Sugeno FISs, which may not always produce a smooth control surface.

To update the FIS tree design, you can consider the following potential changes.

* Use Mamdani FISs, which support additional tuning methods beyond ANFIS.

* Design the initial rulebase of the fuzzy inference systems using human reasoning and then tune
with the training data.

* Use a custom cost function to automatically generate data and optimize the parking trajectory
using reward-based parking simulation. For an example, see “Tune Fuzzy Robot Obstacle
Avoidance System Using Custom Cost Function” on page 3-70.

See Also
fistree | getTunableSettings | tunefis



Autonomous Parking Using Fuzzy Inference System

More About

. “Tuning Fuzzy Inference Systems” on page 3-2
. “Fuzzy Trees” on page 2-52
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Suppose that you want to apply fuzzy inference to a system for which you already have a collection of
input/output data that you would like to use for modeling, model-following, or some similar scenario.
Also, assume that you do not necessarily have a predetermined model structure based on the
characteristics of variables in your system. In some modeling situations, discerning membership
functions parameters by looking at data can be difficult or impossible. In these cases, rather than
choosing the parameters associated with a given membership function arbitrarily, you can tailor the
membership function parameters to the input/output data. Using Fuzzy Logic Toolbox software, you
can tune Sugeno fuzzy inference systems using neuro-adaptive learning techniques similar to those
used for training neural networks.

Fuzzy Logic Toolbox software provides a command-line function (anfis) and an interactive app
(Neuro-Fuzzy Designer) for training an adaptive neuro-fuzzy inference system (ANFIS).

FIS Structure

Using ANFIS training methods, you can train Sugeno systems with the following properties:

* Single output
* Weighted average defuzzification

» First or zeroth order system; that is, all output membership functions must be the same type,
either 'linear' or 'constant’.

* No rule sharing. Different rules cannot use the same output membership function; that is, the
number of output membership functions must equal the number of rules.

* Unity weight for each rule.
* No custom membership functions or defuzzification methods.

To create such a fuzzy system in the MATLAB workspace, you can:

* Use the genfis function. When using this method, you can create your system using either grid
partitioning or subtractive clustering. Grid partitioning can produce a large number of rules when
the number of inputs reaches four or five. To reduce the number of rules, consider using the
subtractive clustering method.

* Use the Fuzzy Logic Designer app, and export the FIS to the MATLAB workspace.
* Use the sugfis function.
* Load a system from a file using the readfis function.

When training your system using the anfis function, specify the initial structure by creating an
anfisOptions option set and setting the InitialFIS property. If you do not specify this property,
the anfis function derives the FIS structure using grid partitioning.

When using Neuro-Fuzzy Designer, in the Generate FIS section, you can create your FIS by:

* Loading from a file (select Load from file)

* Loading from the MATLAB workspace (select Load from worksp)
* Using grid partitioning (select Grid partition)

» Using subtractive clustering (select Sub. clustering)
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Training Data

To train a fuzzy system using neuro-adaptive methods, you must collect input/output training data
using experiments or simulations of the system you want to model. In general, ANFIS training works
well if the training data is fully representative of the features of the data that the trained FIS is
intended to model.

To specify your training data, you can:

* Create an array in the MATLAB workspace. Each row contains a data point, with the final column
containing the output value and the remaining columns containing input values. You can then pass
this data to the trainingData input argument of the anfis function or load it into the Neuro-
Fuzzy Designer app.

* Load the data from a .dat file. Each line of the file contains a data point with values separated by
white space. The final value on each line is the output, and the remaining values are the inputs.

When using the anfis function, create or load the input data and pass it to the trainingData input
argument.

When using Neuro-Fuzzy Designer, in the Load data section, select Training, and then:

* Toload data from a file, select file.

* To load data from the MATLAB workspace, select worksp.

Training Options

Both anfis and Neuro-Fuzzy Designer allow you to adjust the optimization method, number of
training epochs, and training error goal. However, anfis provides additional training options to
control the training step size.

Option anfisOptions Property Neuro-Fuzzy Designer Setting

Optimization Method OptimizationMethod In the Train FIS section, specify Optim.
Method.

Number of training EpochNumber In the Train FIS section, specify

epochs Epochs.

Training error goal ErrorGoal In the Train FIS section, specify Error
Tolerance.

Initial step size InitialStepSize Not available

Step-size decrease rate |StepSizeDecreaseRate

Step-size increase rate |StepSizelncreaseRate

Optimization Method

To train a fuzzy system using ANFIS, the Fuzzy Logic Toolbox software uses a back-propagation
algorithm either alone or in combination with a least-squares algorithm. This training process tunes
the membership function parameters of a FIS such that the system models your input/output data.

The following table shows the two methods that both anfis and Neuro-Fuzzy Designer use for
updating membership function parameters.
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Optimization Method anfisOptions Setting Neuro-Fuzzy Designer
Setting

Backpropagation for all parameters [OprimizationMethod = In the Train FIS section, under

(a steepest-descent method) 'backpropagation' Optim. Method, select
backpropa.

Hybrid method consisting of OprimizationMethod = In the Train FIS section, under

backpropagation for the parameters | 'hybrid' Optim. Method, select

associated with the input hybrid.

membership functions, and least
squares estimation for the
parameters associated with the

output membership functions

Step Size

When training using the anfis function, you can adjust the training step size options. During
training, the software updates the step-size according to the following rules:

» If the error undergoes four consecutive reductions, increase the step size by multiplying it by a
constant (StepSizeIncreaseRate) greater than one.

+ If the error undergoes two consecutive combinations of one increase and one reduction, decrease
the step size by multiplying it by a constant (StepSizeDecreaseRate) less than one.

Ideally, the step size increases at the start of training, reaches a maximum, and then decreases for
the remainder of the training. To achieve this step size profile, adjust the initial step size
(InitialStepSize), step-size increase rate, and step-size decrease rate.

Display Options

When training using the anfis function, you can specify what training progress information to
display in the MATLAB Command Window. Using an anfisOptions option set, you can set the
following display options.

* DisplayANFISInformation — Display ANFIS information at the start of training

* DisplayErrorValues — Display the training error at each epoch

* DisplayStepSize — Display the step-size each time it changes.

* DisplayFinalResults — Display the final training error and validation error

Neuro-Fuzzy Designer does not provide user-specified display options. Instead, it displays the
training progress as a plot.

Training Validation

Validation data lets you check the generalization capability of your trained fuzzy inference system.
The validation data should fully represent the features of the data the FIS is intended to model, while
also being sufficiently different from the training data to test training generalization. The software
uses this data set to cross-validate the fuzzy inference model by applying the validation data to the
model and seeing how well the model responds to this data.

Model validation is useful in the following situations:
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* Noisy data — In some cases, data is collected using noisy measurements, and the training data is
unable to represent all the features of the data the FIS is intended to model.

* Overfitting — Since the model structure used for ANFIS is fixed with a large number of
parameters, there is a tendency for the model to overfit the data on which it is trained, especially
when using a large number of training epochs. If overfitting does occur, the trained FIS may not
generalize well to other independent data sets.

The idea behind using a checking data set for model validation is that, after a certain point in the
training process, the model begins overfitting the training data set. In principle, the model error for
the checking data set decreases up to the point that overfitting begins. After this point, the model
error for the checking data increases. Overfitting is accounted for by testing the trained FIS against
the checking data, and choosing the membership function parameters to be those associated with the
minimum checking error if these errors indicate model overfitting.

Usually, the training and checking data sets are collected based on observations of the target system
and are then stored in separate files. To specify validation data when using the:

* anfis function, create an anfisOptions object, and set the ValidationData option.
* Neuro-Fuzzy Designer, in the Load data section, select Checking.

The array and file formats for the checking data are the same as those for the training data.

Training Results

When you train your fuzzy system using the anfis function, you can obtain the following trained
fuzzy systems:

* The fis output argument is the fuzzy system for which the training error is minimum. This system
is always returned by the anfis function, and corresponds to the FIS returned by Neuro-Fuzzy
Designer when you do not specify checking data.

* The chkFIS output argument is the fuzzy system for which the validation error is minimum. This
system is returned only when you specify validation data using anfisOptions, and corresponds
to the FIS returned by Neuro-Fuzzy Designer when you specify checking data. This FIS object is
the one that you should use for further calculation if checking data is used for cross-validation.

You can obtain the error associated with each of the trained fuzzy systems. In each case, the returned
error is the root mean squared error (RMSE), and is returned as a vector. Each element of the vector
is the RMSE error value at each training epoch.

» Training error — Difference between the training data output value and the output of the fuzzy
inference system for the corresponding training data input values.

* Validation error — Difference between the checking data output value and the output of the fuzzy
inference system for the corresponding checking data input values. This error is returned only
when you specify validation data using anfisOptions.

During training, the Neuro-Fuzzy Designer app plots the training and checking error for each
training epoch. Exporting training and checking error from the app is not supported. To obtain the
training error, you must retrain the system from the command-line. For an example, see “Save
Training Error Data to MATLAB Workspace” on page 3-130.

To further test your trained fuzzy system, you can use an additional set of testing data that you did
not use for training or validation. To do so:
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*  When training a system at the command-line, use the evalfis function.

*  When using Neuro-Fuzzy Designer, in the Load data section, select Testing, and click Load
Data. To evaluate the trained system for any loaded data set, in the Test FIS section, select a data
set, and click Test Now.

Training Algorithm Differences

The Neuro-Fuzzy Designer app manages training epochs in a manner different from the anfis
function. This difference produces variations in the training results.

To train a system for N epochs at the command line, you call the anfis function one time, specifying
the number of epochs as N. However, the Neuro-Fuzzy Designer app calls the anfis function N
times, specifying the number of epochs as 2 each time.

For a command-line example that demonstrates the Neuro-Fuzzy Designer training algorithm, see
“Save Training Error Data to MATLAB Workspace” on page 3-130.
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This example shows how to create, train, and test Sugeno-type fuzzy systems using the Neuro-Fuzzy
Designer app. For more information on:

* Neuro-adaptive fuzzy systems, see “Neuro-Adaptive Learning and ANFIS” on page 3-114.

* Training neuro-adaptive fuzzy systems at the command line, see anfis.

Load Training Data

Training and validating systems using the Neuro-Fuzzy Designer app requires data. Import the
training data (fuzexltrnData) and validation data (fuzex1lchkData) to the MATLAB workspace.

load fuzexltrnData.dat
load fuzexlchkData.dat

Open the Neuro-Fuzzy Designer app.

neuroFuzzyDesigner

-

4 Neuro-Fuzzy Designer: Untitled E@
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0 02 04 0.6 0.8 1 Clear Plot

Load data [ Generate FIS [ Train FIS ] Test FIS |
Type: From: Optim. Method:
Load from fil i inat:
@ Training TR mnntE hybrid - Plot against:
. @) file Load from worksp. Error Tolerance: @ Training data
Testing 0
@ Grid partiti Tezting dat
Checking wWorksp. el Epochs: e
Sub. clusterin Checking data
Dremo - 3 2
Load Data... Clear Data Generate FIS ... Train No | Test No |
Help | | Close |




Train Adaptive Neuro-Fuzzy Inference Systems

Load the training data set from the workspace. In the Load data section, select Training and
worksp.

Click Load Data. In the Load from workspace dialog box, enter the variable name fuzexltrnData.

4 Loadfr.. [ = | & |

input vanable name:

fuzex1trn Dﬂtﬂl

[ oK H Cancel |

Click OK. Neuro-Fuzzy Designer displays the training data in the plot as a set of circles.

| Meuro-Fuzzy Designer: Untitled EI@
File Edit View
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O581 =0 o 0
4 : . ; . ) fructu
0 5 10 15 20 25 Clear Plot |
data set index
Load data [ Generate FIS — 1 [ Train FIS | TestFIs |
Type: From: Optim. Method:
Load fi file i inzt:
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. file Load from worksp. Error Tolerance: @ Training data
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o Grid part [0 1|| O Testing aat
Checking @ worksp. e Epochs: e
Sub. clusteri Checking dat
Demo ub. clustering 3 ecking data
(HEdEE Y| Clear Data Generate FIS .. | Train Now | Test No |
train data loaded Help | | Close |

Load the checking data from the MATLAB workspace into Neuro-Fuzzy Designer. In the Load data
section, select Checking.

Load the checking data in the same manner as the training data, specifying the variable name

fuzexlchkData. Neuro-Fuzzy Designer displays the checking data using plus signs superimposed
on the training data.
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4| Neuro-Fuzzy Designer: Untitled EI@
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To clear a specific data set from the app, in the Load data area, select the data Type, and click Clear
Data.

Generate or Load FIS Structure

Before you start the FIS training, you must specify an initial FIS model structure. To specify the
model structure, you perform one of the following tasks:

Load a previously saved single-output Sugeno-type FIS object from a file or the MATLAB
workspace.

Generate the initial FIS model using grid partitioning.
Generate the initial FIS model using subtractive clustering.

For this example, generate the initial FIS using grid partitioning. In Neuro-Fuzzy Designer, in the
Generate FIS section, select Grid partition.

Click Generate FIS.

In the Add Membership Functions dialog box:
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In the Input section, in Number of MFs, specify the number of input membership functions. For
this example, use 4 membership functions for all input variables.

In MF Type, select gbellmf as the input membership function type.
In the Output section, in MF Type, select Linear as the output membership function type.

-

“ E=R[EEE =
— INPUT
Mumber of MFz: MF Type:
trimf -
4 trapmf
gbellmf
To assign a different ga”i”';ff
number of MFs to each gguf -
input, use spaces to 3:” f
separate these numbers. 'gm
p=igmf
— OUTRUT
: constant *
MF Type: finear il
oK Cancel

Interactively Specify FIS Structure

Alternatively, you can interactively specify your own FIS structure with specified membership
functions and rules. The system you define must be a Sugeno system with the following properties:

Single output
Weighted average defuzzification

First or zeroth order system; that is, all output membership functions must be the same type,
either 'linear' or 'constant’.

No rule sharing. Different rules cannot use the same output membership function; that is, the
number of output membership functions must equal the number of rules.

Unity weight for each rule.
No custom membership functions or defuzzification methods.

To define the:

Membership functions for each variable, in Neuro-Fuzzy Designer, select Edit > Membership
Functions. Then, in the Membership Function Editor window, define the membership functions.

Rules, in Neuro-Fuzzy Designer, select Edit > Rules. Then, in the Rule Editor window, define
the rules.
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These tools are the same as those used by the Fuzzy Logic Designer app. For more information, see
“Build Fuzzy Systems Using Fuzzy Logic Designer” on page 2-14.

View FIS Structure

After you load or generate the FIS, you can view the model structure. To do so, in Neuro-Fuzzy
Designer, click Structure.

The branches in this graph are color coded. Color coding of branches characterize the rules and
indicate whether or not AND, NOT, or OR are used in the rules. The input is represented by the left-
most node and the output by the right-most node. The node represents a normalization factor for the
rules. To view information about the structure, click on each node.

Also, to view the FIS:

* Membership functions, in Neuro-Fuzzy Designer, select Edit > Membership Functions.
* Rules, in Neuro-Fuzzy Designer, select Edit > Rules.

Train FIS

After loading the training data and generating the initial FIS structure, you can train your FIS. To do
so, in Neuro-Fuzzy Designer, in the Train FIS section, specify the following parameters.
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* Optim. Method — Optimization method. For this example, select the hybrid method, which uses
a combination of backpropagation and least-squares regression to tune the FIS parameters.

* Epochs — Number of training epochs. For this example, specify 40 epochs.

* Error Tolerance — Error tolerance stopping condition. For this example, specify a value of 0,
which indicates that the training will stop when the number of training epochs is reached.

To train the FIS, click Train Now.

4 Meuro-Fuzzy Designer: Untitled EI@
File Edit View
Training Error — ANFSInfo.  —
0.16
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0.14 e, ev®" # of cutputs: 1
* . - .
********* o . # of input mfs:
e * * *
£ 0.12 Fhkg 4
w RET
*
*%
0.1 £
¥
* *
ke |
0.08 : . : : . : ¥ Structure
o 5 10 15 20 25 30 35 40 Clear Plot |
Epochs
Load data [ Generate FIS [ Train FIS ] Test FIS ]
Type: From: Optim. Method:
Training Load from file hybrid - Plot against:
) file Load from worksp. Error Tolerance: @/ Training data
fesing O
@ Grid partit Testing dat
@ Checking @ worksp. L Epochs: e
Sub. clusteri Checking dat
S ub. clustering 40 ecking data
Load Data... |  Clear Data Generate FIS ... || | £oreEin faw TestMow |
Epoch 40:error= 0.083462 | Help | | Close |

The app trains the FIS and plots the training error (as stars) and checking error (as dots) for each

training epoch.

The checking error decreases up to a certain point in the training, and then it increases. This
increase occurs at the point where the training starts overfitting the training data. The app selects
the FIS associated with this overfitting point as the trained ANFIS model.

Validate Trained FIS

After the FIS is trained, validate the model using a Testing or Checking data set that differs from
the training data. For this example, use the previously loaded checking data.
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To test your FIS against the checking data, in the Test FIS section, select Checking data. Then,
click Test Now.

| Meuro-Fuzzy Designer: Untitled EI@
File Edit View
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1 \ \ \ \ \ ) Structure |
0 5 10 15 20 25 30 Clear Plot |
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Load data [ Generate FIS [ Train FIS ] Test FIS |
Type: From: Optim. Method:
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The app plots the output values of the testing data set (using blue +'s) and the output of the trained

FIS for the corresponding testing data input values (using red *'s). The FIS output values correlate
well with the expected output.

Importance of Checking Data

It is important to have checking data that fully represents the features of the data the FIS is intended
to model. If your checking data is significantly different from your training data and does not cover
the same data features to model as the training data, then the training results will be poor.

For example, load new training and checking data into Neuro-Fuzzy Designer. This data has
significantly different training and checking sets.

1 At the MATLAB command line, load the training and checking data.

load fuzex2trnData.dat
load fuzex2chkData.dat

Clear the previously loaded training and checking data. In the Load data section, select each
data type, click Clear Data.
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3 Load the training data (fuzex2trnData) and checking data (fuzex2chkData), as you did
previously.

Generate a FIS structure and train the FIS as you did previously, except now select 60 training
epochs.
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4| Neuro-Fuzzy Designer: Untitled

(= (& ]s)

File Edit WView
Training Error — ANFISInfo.  —
D-E [ '.‘.!"‘iiiil (ILI LTI R LR R AL LR R R LT LR |
..ui". # of inputs: 1
# of outputs: 1
06T # of input mfs:
S 4
L
0.4
0.2 WWW*%%W% Structure |
o 10 30 40 a0 60 Clear Plot |
Epochs
[ Load data - ] Generate FIS -] Train FI= |1 TestFls ]
Type: From: Optim. Method:
Training Load from file hybrid - Plot against:
e file Load from worksp. Error Telerance: Training data
o Grid partii [0 T|| () Testing dat
@ Checking @ worksp. Lelis Lt Epochs: esting data
Demo Sub. clustering &0 @ Checking data
Load Data... Clear Data Generate FIS .. | N o0 T Test Now |
Epoch &0:error= 0.24481 | Help | | Close |

In this case, the checking error is large, with the minimum occurring in the first epoch. Since the app
chooses the trained FIS parameters associated with the minimum checking error, the trained FIS

does not sufficiently capture the features of this data set. It is important to know the features of your
data set well when you select your training and checking data. When you do not know the features of

your data, you can analyze the checking error plots to see whether or not the checking data
performed sufficiently well with the trained model.

In this example, the checking error is sufficiently large to indicate that either you need to select more

data for training or modify your membership function choices (both the number of membership

functions and the type). Otherwise, if you think the training data sufficiently captures the features

you are trying to represent, the system can be retrained without the checking data.

To verify the poor training results, test the trained FIS model against the checking data.
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As expected, there are significant differences between the checking data output values and the FIS
output.

See Also
Neuro-Fuzzy Designer

More About

. “Neuro-Adaptive Learning and ANFIS” on page 3-114
. “Save Training Error Data to MATLAB Workspace” on page 3-130
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When using Neuro-Fuzzy Designer, you can export your initial FIS structure to the MATLAB
workspace and then generate ANFIS training error values. Since exporting the training and

validation error profiles from the Neuro-Fuzzy Designer app is not supported, use this method to

generate such error plots.

The following example shows how to save the training error generated during ANFIS training to the

MATLAB workspace.

1 Load your training data (fuzexltrnData) and validation data (fuzexlchkData) to the MATLAB

workspace.

load fuzexltrnData.dat
load fuzexlchkData.dat

2 Open the Neuro-Fuzzy Designer app.

neuroFuzzyDesigner
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3 Load the training data from the MATLAB workspace into Neuro-Fuzzy Designer.

a Inthe Load data section, select Training.
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b  Select worksp.

¢ Click Load Data. In the Load from workspace dialog box, enter the variable name
fuzexltrnData.

e

< oadfr.. [o ] O

input variable name:
fuzex1itrn Data|

’ OK H Cancel |

d Click OK. Neuro-Fuzzy Designer displays the training data in the plot as a set of circles.
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Load the checking data from the MATLAB workspace into Neuro-Fuzzy Designer. In the Load
data section, select Checking.

Load the checking data in the same manner as the training data, specifying the variable name

fuzexlchkData. Neuro-Fuzzy Designer displays the checking data using plus signs
superimposed on the training data.

3-131



3 Fuzzy Inference System Tuning

:
gAdlata.l| ClearData |||  GenerateFis.. ||| _ TrainNow ||| __ Testiow |

5 Generate an initial FIS.

a In the Generate FIS section, select Grid partition.
b  Click Generate FIS.
¢ Inthe Add Membership Functions dialog box:
* In the Input section, in Number of MFs, specify the number of input membership
functions. For this example use 4 for all input variables.
* In MF Type, select gbellmf as the input membership function type.

* In the Output section, in MF Type, select linear as the output membership function
type.
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. e =]
—INPUT
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d Click OK.
Export the initial FIS to the MATLAB workspace.

a In Neuro-Fuzzy Designer, select File > Export > To Workspace.

This action opens a dialog box where you specify the MATLAB variable name.

b In the Export To Workspace dialog box, in the Workspace variable field, enter initfis as
the variable name.

=)

Save current FIS to workspace

Workspace variable in 'rtfi5|

Ok | Cancel

¢ Click OK. The app exports the FIS object to the MATLAB workspace.

Train the FIS for 40 epochs. Instead of using a single call to the anfis function, call the function
inside a loop using 2 epochs for each call. This training method replicates the training process
used by the Neuro-Fuzzy Designer app.

At each training epoch, save the training and validation errors.
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fis initfis;
opt anfisOptions('EpochNumber',2, 'ValidationData', fuzexlchkData);
trainError = zeros(1,40);
checkError = zeros(1,40);
for ct = 1:40
opt.InitialFIS = fis;

[fis,error,~,~,chkError] = anfis(fuzexltrnData,opt);
trainError(ct) = error(1l);
checkError(ct) = chkError(1l);

end

8 Plot the training and validation errors over the training process. These error values are the root
mean squared errors at each training epoch.

epochNum = 1:40;
plot(epochNum,trainError, 'b*"',epochNum, checkError, 'ro")
xLlabel('Epoch Number')

ylabel('Error')

legend('Training Error', 'Validation Error')
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These error profiles are similar to the error profiles when the same initial FIS structure is trained
in the Neuro-Fuzzy Designer app.

See Also
Neuro-Fuzzy Designer
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More About

. “Neuro-Adaptive Learning and ANFIS” on page 3-114
. “Train Adaptive Neuro-Fuzzy Inference Systems” on page 3-120
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Predict Chaotic Time-Series using ANFIS
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This example shows how to do chaotic time-series prediction using ANFIS.

Time Series Data

This example uses anfis to predict a time series generated by the following Mackey-Glass (MG)
time-delay differential equation.

. 0.2x(t—1)
x(t) = —="+——-0.1x(t

® 1+x1% -1 ®
This time series is chaotic with no clearly defined period. The series does not converge or diverge,
and the trajectory is highly sensitive to initial conditions. This benchmark problem is used in the
neural network and fuzzy modeling research communities.

To obtain the time series value at integer points, the fourth-order Runge-Kutta method was used to
find the numerical solution to the previous MG equation. It was assumed that x(0) =1.2, 1=17, and
x(t) = 0 for t < 0. The result was saved in the file mgdata.dat.

Load and plot the MG time series.

load mgdata.dat

time = mgdata(:,1);

x = mgdata(:, 2);

figure(1l)

plot(time,x)

title('Mackey-Glass Chaotic Time Series')
xlabel('Time (sec)')

ylabel('x(t)")
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Preprocess Data

In time-series prediction, you use known values of the time series up to point in time, t, to predict the
value at some point in the future, t + P. The standard method for this type of prediction is to create a
mapping from D sample data points, sampled every A units in time (x(t — (D — 1)A), ..., x(t — A), x(t)) to
a predicted future value x = (t + P). Following the conventional settings for predicting the MG time
series, set D = 4 and A = P = 6. For each t, the input training data for anfis is a four-column vector
of the following form.

w(t) = [x(t —19),x(t — 12), x(t - 6), x(t)]
The output training data corresponds to the trajectory prediction.
s(t) = x(t + 6)

For each t, ranging in values from 118 to 1117, there are 1000 input/output training samples. For this
example, use the first 500 samples as training data (t rnData) and the second 500 values as checking
data for validation (chkData). Each row of the training and checking data arrays contains one sample
point where the first four columns contain the four-dimensional input w and the fifth column contains
the output s.

Construct the training and checking data arrays.
for t = 118:1117

Data(t-117,:) = [x(t-18) x(t-12) x(t-6) x(t) x(t+6)1;
end
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trnData
chkData

Data(1:500,:);
Data(501:end, :);

Build Initial Fuzzy System

Create an initial Sugeno FIS object for training using the genfis function with grid partitioning.

fis = genfis(trnData(:,1l:end-1),trnData(:,end), ...
genfisOptions('GridPartition'));

The number of FIS inputs and outputs corresponds to the number of columns in the input and output
training data, four and one, respectively.

By default, genfis creates two generalized bell membership functions for each of the four inputs.
The initial membership functions for each variable are equally spaced and cover the whole input
space.

figure

subplot(2,2,1)
plotmf(fis, "input',1)
subplot(2,2,2)
plotmf(fis, "input',2)
subplot(2,2,3)
plotmf(fis, "input',3)
subplot(2,2,4)
plotmf(fis, "input',4)

=h
-
=
=h
-
=

Degree of membership
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The generated FIS object contains 2t =16 fuzzy rules with 104 parameters (24 nonlinear parameters
and 80 linear parameters). To achieve good generalization capability, it is important that the number
of training data points be several times larger than the number parameters being estimated. In this
case, the ratio between data and parameters is approximately five (500/104), which is a good balance
between fitting parameters and training sample points.

Train ANFIS Model

To configure training options, create an anfisOptions option set, specifying the initial FIS and
validation data.

options = anfisOptions('InitialFIS',fis, 'ValidationData',chkData);
Train the FIS using the specified training data and options.
[fisl,errorl,ss,fis2,error2] = anfis(trnData,options);

ANFIS info:
Number of nodes: 55
Number of linear parameters: 80
Number of nonlinear parameters: 24
Total number of parameters: 104
Number of training data pairs: 500
Number of checking data pairs: 500
Number of fuzzy rules: 16

Start training ANFIS ...

1 0.00296046 0.00292488

2 0.00290346 0.0028684

3 0.00285048 0.00281544

4 0.00280117 0.00276566

Step size increases to 0.011000 after epoch 5.
5 0.00275517 0.00271874

6 0.00271214 0.00267438

7 0.00266783 0.00262818

8 0.00262626 0.00258435

Step size increases to 0.012100 after epoch 9.
9 0.00258702 0.00254254

10 0.00254972 0.00250247

Designated epoch number reached. ANFIS training completed at epoch 10.

0.00254972
0.00250247

Minimal training RMSE =
Minimal checking RMSE =
fisl is the trained fuzzy inference system for the training epoch where the training error is smallest.
Since you specified validation data, the fuzzy system with the minimum checking error, fis2, is also
returned. The FIS with the smallest checking error shows the best generalization beyond the training
data.

Plots the membership functions for the trained system.
figure

subplot(2,2,1)
plotmf(fis2, 'input',1)
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subplot(2,2,2)
plotmf(fis2, 'input',2)
subplot(2,2,3)
plotmf(fis2, 'input',3)
subplot(2,2,4)
plotmf(fis2, 'input',4)

Degree of membership
Degree of membership
=
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inputi
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Degree of membership
n
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=
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=
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input3

Plot Errors Curves

Plot the training and checking error signals.

figure

plot([errorl error2])

hold on

plot([errorl error2],'o")
legend('Training error', 'Checking error')
xlabel('Epochs"')

ylabel('Root Mean Squared Error')
title('Error Curves')

in
0.6 0.8 1 1.2
input
1 in
0.6 0.8 1 1.2
inputd
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3 X 102 Error Curves
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The training error is higher than the checking error in all epochs. This phenomenon is not uncommon
in ANFIS learning or nonlinear regression in general; it could indicate that additional training could
produce better training results.

Compare Original and Predicted Series

To check prediction capability of the trained system, evaluate the fuzzy system using the training and
checking data, and plot the result alongside the original

anfis output = evalfis(fis2,[trnData(:,1:4); chkData(:,1:4)]);

figure

index = 125:1124;

plot(time(index), [x(index) anfis output])
xlabel('Time (sec)"')

title('MG Time Series and ANFIS Prediction')
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MG Time Series and ANFIS Prediction
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The predicted series is similar to the original series.

Calculate and plot the prediction error.

diff = x(index) - anfis output;
plot(time(index),diff)
xlabel('Time (sec)"')
title('Prediction Errors')
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The scale of the prediction error plot is about one-hundredth of the scale of the time-series plot. In
this example, you trained the system for only 10 epoch. Training for additional epochs can improve
the training results.

See Also
anfis | evalfis |genfis

More About
. “Neuro-Adaptive Learning and ANFIS” on page 3-114
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This example shows how to use a fuzzy system to model the inverse kinematics in a two-joint robotic
arm.

What Is Inverse Kinematics?

Kinematics is the science of motion. In a two-joint robotic arm, given the angles of the joints, the
kinematics equations give the location of the tip of the arm. Inverse kinematics refers to the reverse
process. Given a desired location for the tip of the robotic arm, what should the angles of the joints be
so as to locate the tip of the arm at the desired location. There is usually more than one solution and
can at times be a difficult problem to solve.

This is a typical problem in robotics that needs to be solved to control a robotic arm to perform tasks
it is designated to do. In a 2-dimensional input space, with a two-joint robotic arm and given the
desired coordinate, the problem reduces to finding the two angles involved. The first angle is between
the first arm and the ground (or whatever it is attached to). The second angle is between the first arm
and the second arm.

(x,y) Desired location

Figure 1: Illustration showing the two-joint robotic arm with the two angles, thetal and theta2
Why Use Fuzzy Logic?

For simple structures like the two-joint robotic arm, it is possible to mathematically deduce the
angles at the joints given the desired location of the tip of the arm. However with more complex
structures (for example: n-joint robotic arms operating in a 3-dimensional input space) deducing a
mathematical solution for the inverse kinematics may prove challenging.

Using fuzzy logic, we can construct a fuzzy inference system that deduces the inverse kinematics if
the forward kinematics of the problem is known, hence sidestepping the need to develop an analytical
solution. Also, the fuzzy solution is easily understandable and does not require special background
knowledge to comprehend and evaluate it.

In the following section, a broad outline for developing such a solution is described, and later, the
detailed steps are elaborated.
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Overview of Fuzzy Solution

Since the forward kinematics formulae for the two-joint robotic arm are known, x and y coordinates
of the tip of the arm are deduced for the entire range of angles of rotation of the two joints. The
coordinates and the angles are saved to be used as training data to train an ANFIS (adaptive neuro-
fuzzy inference system) network.

During training, the ANFIS network learns to map the coordinates (X, y) to the angles (thetal,
theta2). The trained ANFIS network is then used as a part of a larger control system to control the
robotic arm. Knowing the desired location of the robotic arm, the control system uses the trained
ANFIS network to deduce the angular positions of the joints and applies force to the joints of the
robotic arm accordingly to move it to the desired location.

What Is ANFIS?

ANFIS stands for adaptive neuro-fuzzy inference system. It is a hybrid neuro-fuzzy technique that
brings learning capabilities of neural networks to fuzzy inference systems. The learning algorithm
tunes the membership functions of a Sugeno-type fuzzy inference system using the training input/
output data.

In this case, the input/output data refers to the "coordinates/angles" dataset. The coordinates act as
input to the ANFIS and the angles act as the output. The learning algorithm teaches the ANFIS to
map the coordinates to the angles through a process called training. At the end of training, the
trained ANFIS network would have learned the input-output map and be ready to be deployed into
the larger control system solution.

Data Generation

Let thetal be the angle between the first arm and the ground. Let theta2 be the angle between the
second arm and the first arm (Refer to Figure 1 for illustration). Let the length of the first arm be 11
and that of the second arm be 12.

Assume that the first joint has limited freedom to rotate and it can rotate between 0 and 90 degrees.
Similarly, assume that the second joint has limited freedom to rotate and can rotate between 0 and
180 degrees. (This assumption takes away the need to handle some special cases which will confuse
the discourse.) Hence, O<=thetal<=pi/2 and O<=theta2<=pi.
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All possible 8;values
0=8=m

. All possible 8; values

Figure 2: Illustration showing all possible thetal and theta2 values.

Now, for every combination of thetal and theta2 values the x and y coordinates are deduced using
forward kinematics formulae.

The following code snippet shows how data is generated for all combination of thetal and theta2
values and saved into a matrix to be used as training data. The reason for saving the data in two
matrices is explained in the following section.

11 = 10; % length of first arm

12 = 7; % length of second arm

thetal = 0:0.1:pi/2; % all possible thetal values
theta2 = 0:0.1:pi; % all possible theta2 values

[THETAL1l,THETA2] = meshgrid(thetal,theta2); % generate a grid of thetal and theta2 values

X
Y

11 * cos(THETAl) + 12 * cos(THETAl + THETA2);
11 * sin(THETALl) + 12 * sin(THETA1l + THETA2);

compute x coordinates
compute y coordinates

%
%

datal
data2

[X(:) Y(:) THETAL(:)
[X(:) Y(:) THETA2(:)

create x-y-thetal dataset
create x-y-theta2 dataset

o
1; %
o
1; %
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The following plot shows all the X-Y data points generated by cycling through different combinations
of thetal and theta2 and deducing x and y coordinates for each. The plot can be generated by
using the following code. The plot is annotated further for easier understanding.

plot(X(:),Y(:),'r.");

axis equal;

xlabel('X"', 'fontsize',10)
ylabel('Y', 'fontsize',10)
title('X-Y coordinates for all thetal and theta2 combinations', 'fontsize',10)

X-Y coordinates generated for all thetal and theta2 combinations
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Figure 3: X-Y coordinates generated for all thetal and theta2 combinations using forward

kinematics formulae

Building ANFIS Networks

One approach to building an ANFIS solution for this problem, is to build two ANFIS networks, one to
predict thetal and the other to predict theta2.

In order for the ANFIS networks to be able to predict the angles they have to be trained with sample
input-output data. The first ANFIS network will be trained with X and Y coordinates as input and
corresponding thetal values as output. The matrix datal contains the x-y-thetal dataset
required to train the first ANFIS network. Therefore datal will be used as the dataset to train the

first ANFIS network.
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Similarly, the second ANFIS network will be trained with X and Y coordinates as input and
corresponding theta?2 values as output. The matrix data2 contains the x-y-theta2 dataset
required to train the second ANFIS network. Therefore data2 will be used as the dataset to train the
second ANFIS network.

To train an ANFIS network, first specify the training options using the anfisOptions command. For
this example, specify an FIS object with 7 membership functions for each input variable. Train the
system for 150 epochs and suppress the Command Window display of training information.

opt = anfisOptions;
opt.InitialFIS = 7;
opt.EpochNumber = 150;
opt.DisplayANFISInformation = 0;
opt.DisplayErrorValues = 0;
opt.DisplayStepSize = 0;
opt.DisplayFinalResults = 0;

Train an ANFIS system using the first set of training data, datal.
disp('--> Training first ANFIS network.')

--> Training first ANFIS network.

anfisl = anfis(datal,opt);

Change the number of input membership functions and train an ANFIS system using the second set
of training data, data?2.

disp('--> Training second ANFIS network."')
--> Training second ANFIS network.

opt.InitialFIS = 6;
anfis2 = anfis(data2,opt);

For this example, the number of input membership functions and training epochs were selected based
on experimentation with different potential values.

anfisl and anfis2 represent the two trained ANFIS networks that will be deployed in the larger
control system.

Once the training is complete, the two ANFIS networks have learned to approximate the angles
(thetal, theta2) as a function of the coordinates (X, y). One advantage of using the fuzzy approach
is that the ANFIS network can now approximate the angles for coordinates that are similar but not
exactly the same as it was trained with. For example, the trained ANFIS networks are now capable of
approximating the angles for coordinates that lie between two points that were included in the
training dataset. This will allow the final controller to move the arm smoothly in the input space.

We now have two trained ANFIS networks which are ready to be deployed into the larger system that
will utilize these networks to control the robotic arms.

Validating ANFIS Networks

Having trained the networks, an important follow up step is to validate the networks to determine
how well the ANFIS networks would perform inside the larger control system.
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Since this example problem deals with a two-joint robotic arm whose inverse kinematics formulae can
be derived, it is possible to test the answers that the ANFIS networks produce with the answers from
the derived formulae.

Assume that it is important for the ANFIS networks to have low errors within the operating range
0<x<2 and 8<y<10.

% X coordinates for validation

X ’
0; % y coordinates for validation

0:0.1:2
y 1

8:0.1:

The thetal and theta2 values are deduced mathematically from the x and y coordinates using
inverse kinematics formulae.

[X,Y] = meshgrid(x,y);

c2 = (X.72 + Y."2 - 1172 - 1272)/(2*%11*12);
s2 = sqrt(l - c2.72);
THETA2D = atan2(s2,c2); % theta2 is deduced

kl = 11 + 12.*c2;
k2 = 12%*s2;
THETA1D = atan2(Y,X) - atan2(k2,kl); % thetal is deduced

THETA1D and THETA2D are the variables that hold the values of thetal and theta2 deduced using
the inverse kinematics formulae.

thetal and theta2 values predicted by the trained ANFIS networks are obtained by using the
command evalfis which evaluates a FIS for the given inputs.

Here, evalfis is used to find out the FIS outputs for the same x-y values used earlier in the inverse
kinematics formulae.

XY = [X(:) Y(:)];
THETA1P evalfis(anfisl,XY); % thetal predicted by anfisl
THETA2P evalfis(anfis2,XY); % theta2 predicted by anfis2

Now, we can see how close the FIS outputs are with respect to the deduced values.

thetaldiff
theta2diff

THETA1D(:) - THETA1P;
THETA2D(:) - THETA2P;

subplot(2,1,1);

plot(thetaldiff);

ylabel('THETA1D - THETA1P', 'fontsize',10)

title('Deduced thetal - Predicted thetal', 'fontsize',10)

subplot(2,1,2);

plot(theta2diff);

ylabel('THETA2D - THETA2P', 'fontsize',10)

title('Deduced theta2 - Predicted theta2', 'fontsize',10)
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The errors are in the le-3 range which is a fairly good number for the application it is being used in.
However this may not be acceptable for another application, in which case the parameters to the
anfis function may be tweaked until an acceptable solution is arrived at. Also, other techniques like
input selection and alternate ways to model the problem may be explored.

Building a Solution Around the Trained ANFIS Networks

Now given a specific task, such as robots picking up an object in an assembly line, the larger control
system will use the trained ANFIS networks as a reference, much like a lookup table, to determine
what the angles of the arms must be, given a desired location for the tip of the arm. Knowing the
desired angles and the current angles of the joints, the system will apply force appropriately on the
joints of the arms to move them towards the desired location.

The invkine command launches a GUI that shows how the two trained ANFIS networks perform
when asked to trace an ellipse.
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Figure 4: GUI for Inverse Kinematics Modeling.

The two ANFIS networks used in the example have been pretrained and are deployed into a larger
system that controls the tip of the two-joint robot arm to trace an ellipse in the input space.

The ellipse to be traced can be moved around. Move the ellipse to a slightly different location and
observe how the system responds by moving the tip of the robotic arm from its current location to the
closest point on the new location of the ellipse. Also observe that the system responds smoothly as
long as the ellipse to be traced lies within the 'x' marked spots which represent the data grid that was
used to train the networks. Once the ellipse is moved outside the range of data it was trained with,
the ANFIS networks respond unpredictably. This emphasizes the importance of having relevant and
representative data for training. Data must be generated based on the expected range of operation to
avoid such unpredictability and instability issues.

See Also
anfis | evalfis

More About
. “Neuro-Adaptive Learning and ANFIS” on page 3-114
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Adaptive Noise Cancellation Using ANFIS

This example shows how to do adaptive nonlinear noise cancellation using the anfis and genfis
commands.

Signal and Noise

Define a hypothetical information signal, X, sampled at 100Hz over 6 seconds.

time = (0:0.01:6)"';

X = sin(40./(time+0.01));

plot(time,x)

title('Information Signal x', 'fontsize',10)
xlabel('time', 'fontsize',10)

ylabel('x"', 'fontsize',10)

Information Signal x

1 I ﬂ T T T
0.8 T

0.4

time

Assume that x cannot be measured without an interference signal, ny, which is generated from
another noise source, ny, via a certain unknown nonlinear process.

The plot below shows noise source nj.

nl = randn(size(time));

plot(time,nl)

title('Noise Source n 1','fontsize',10)
xlabel('time', 'fontsize',10)
ylabel('n 1', 'fontsize',10)
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Neoise Source n,
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time
Assume that the interference signal, ny, that appears in the measured signal is generated via an

unknown nonlinear equation:

_ 4sin(ny(k)) - ny(k = 1)
1+ ny(k — 1)

ny(k)

Plot this nonlinear characteristic as a surface.

domain = linspace(min(nl),max(nl),20);
[xx,yy] = meshgrid(domain,domain);
2z = 4¥sin(xx).*yy./(1+yy."2);

surf(xx,yy,zz);

xlabel('n 1(k)"', 'fontsize',10);

ylabel('n 1(k-1)"',"'fontsize',10);

zlabel('n 2(k)"','fontsize',10);

title('Unknown Interference Channel Characteristics', 'fontsize',10);
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Unknown Interference Chan_nel Characteristics
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Compute the interference signal, ny, from the noise source, n;, and plot both signals.

nld0® = nl; % nl with delay 0
nldl = [0; nldO(1l:length(nld0)-1)]; % nl with delay 1
n2 = 4*sin(nld0).*nld1l./(1+nl1d1.72); % interference

subplot(2,1,1)

plot(time,nl);

ylabel('noise n 1','fontsize',10);
subplot(2,1,2)

plot(time,n2);

ylabel('interference n 2',"'fontsize',10);
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noise n,
[ )

interference n 2
=

ny is related to nj via the highly nonlinear process shown previously; from the plots, it is hard to see if
these two signals are correlated in any way.

The measured signal, m, is the sum of the original information signal, x, and the interference, nj.
However, we do not know ny. The only signals available to us are the noise signal, n;, and the
measured signal m.

m= X + n2; % measured signal
subplot(1,1,1)

plot(time, m)

title('Measured Signal', 'fontsize',10)
xlabel('time', 'fontsize',10)

ylabel('m', 'fontsize',10)
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time
You can recover the original information signal, x, using adaptive noise cancellation via ANFIS
training.

Build the ANFIS Model

Use the anfis command to identify the nonlinear relationship between n; and ny. While nj is not
directly available, you can assume that m is a "contaminated" version of ny for training. This
assumption treats x as "noise" in this kind of nonlinear fitting.

Assume the order of the nonlinear channel is known (in this case, 2), so you can use a 2-input ANFIS
model for training.

Define the training data. The first two columns of data are the inputs to the ANFIS model, n; and a
delayed version of ni. The final column of data is the measured signal, m.

delayed nl = [0; nl(1l:length(nl)-1)1;
data = [delayed nl nl m];

Generate the initial FIS object. By default, the grid partitioning algorithm uses two membership
functions for each input variable, which produces four fuzzy rules for learning.

genOpt = genfisOptions('GridPartition');
inFIS = genfis(data(:,1l:end-1),data(:,end),genOpt);

Tune the FIS using the anfis command with an initial training step size of 0. 2.
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trainOpt = anfisOptions('InitialFIS',inFIS, 'InitialStepSize',0.2);
outFIS = anfis(data,trainOpt);

ANFIS info:
Number of nodes: 21
Number of linear parameters: 12
Number of nonlinear parameters: 12
Total number of parameters: 24
Number of training data pairs: 601
Number of checking data pairs: 0
Number of fuzzy rules: 4

Start training ANFIS ...

0.761817
0.748426
0.739315
0.733993
tep size increases to 0.220000 after epoch 5.
0.729492
0.725382
0.721269
0.717621
tep size increases to 0.242000 after epoch 9.
0.714474
0 0.71207

HFOWnWooNoOouunmhbhwWNPEF

Designated epoch number reached. ANFIS training completed at epoch 10.
Minimal training RMSE = 0.71207

The tuned FIS, outFIS, models the second-order relationship between n; and ny.
Evaluate Model

Calculate the estimated interference signal, estimated n2, by evaluating the tuned FIS using the
original training data.

estimated n2 = evalfis(outFIS,data(:,1:2));
Plot the and actual ny signal and the estimated version from the ANFIS output.

subplot(2,1,1)
plot(time, n2)
ylabel('n 2 (unknown)');

subplot(2,1,2)

plot(time, estimated n2)
ylabel('Estimated n 2');
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The estimated information signal is equal to the difference between the measured signal, m, and the
estimated interference (ANFIS output).

estimated x = m - estimated n2;
Compare the original information signal, X, and the estimate, estimated x.
figure

plot(time,estimated x,'b',time,x,'r")
legend('Estimated x', 'Actual x (unknown)', 'Location', 'SouthEast')
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Without extensive training, the ANFIS produces a good estimate of the information signal.

See Also
anfis | evalfis | genfis

More About
. “Neuro-Adaptive Learning and ANFIS” on page 3-114
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Nonlinear System Identification
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This example shows how to use anfis command for nonlinear dynamic system identification.

This example requires System Identification Toolbox™, as a comparison is made between a nonlinear
ANFIS and a linear ARX model.

Problem Setup

Exit if System Identification Toolbox is not available.

if ~fuzzychecktoolboxinstalled('ident"')
errordlg('DRYDEMO needs the System Identification Toolbox.');
return;

end

The data set for ANFIS and ARX modeling was obtained from a laboratory device called Feedback's
Process Trainer PT 326, as described in Chapter 17 of Prof. Lennart Ljung's book "System
Identification, Theory for the User", Prentice-Hall, 1987. The device functions like a hair dryer: air is
fanned through a tube and heated at the inlet. The air temperature is measured by a thermocouple at
the outlet. The input u(k) is the voltage over a mesh of resistor wires to heat incoming air; the output
y(k) is the outlet air temperature.

u(k) Hair Dryer jm— y(k)

(Voltage) ¢ (Temperature)

Here are the results of the test.

load drydemodata
data n = length(y2);
output y2;
input = [[0; y2(1l:data n-1)] ...

[0; 0; y2(l:data n-2)] ...

[0; 0; 0; y2(1l:data n-3)] .

[0; O; 0; 0; y2(1l:data n-4)]

[0; u2(l:data n-1)] ...

[0; 0; u2(l:data n-2)] ...

[0; 0; 0; u2(l:data n-3)] ...

[0; O; O; 0; u2(l:data n-4)] ...

[0; ©; O; 0; 0; u2(l:data n-5)] .

[0; O; O; O; O; 0; u2(l:data n-6)11;
data = [input output];
data(1l:6, :) = [];
input name = char('y(k-1)"',"

'u(k-1)",'u(k-2)"','u(k-3

index = 1:100;
subplot(2,1,1)
plot(index,y2(index), '-',index,y2(index),'0")
ylabel('y(k) ", 'fontsize',10)
subplot(2,1,2)
plot(index,u2(index), '-',index,u2(index),'0")
ylabel('u(k) "', 'fontsize',10)
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The data points were collected at a sampling time of 0.08 seconds. One thousand input-output data
points were collected from the process as the input u(k) was chosen to be a binary random signal
shifting between 3.41 and 6.41 V. The probability of shifting the input at each sample was 0.2. The
data set is available from the System Identification Toolbox, and the above plots show the output
temperature y(k) and input voltage u(t) for the first 100 time steps.

ARX Model Identification

A conventional method is to remove the means from the data and assume a linear model of the form:

y(k)+al*y(k-1)+...+am*y(k-m)=bl*u(k-d)+...+bn*u(k-d-n+1)

where ai (i = 1 to m) and bj (j = 1 to n) are linear parameters to be determined by least-squares
methods. This structure is called the ARX model and it is exactly specified by three integers [m, n, d].
To find an ARX model for the dryer device, the data set was divided into a training (k = 1 to 300) and
a checking (k = 301 to 600) set. An exhaustive search was performed to find the best combination of
[m, n, d], where each of the integer is allowed to changed from 1 to 10 independently. The best ARX
model thus found is specified by [m, n, d] =[5, 10, 2], with a training RMSE of 0.1122 and a checking
RMSE of 0.0749. The above figure shows the fitting results of the best ARX model.

trn_data n = 300;
total data n = 600;

z = [y2 u2];

z = dtrend(z);

ave = mean(y2);

ze = z(1l:trn _data n,:);
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v = z(trn data n+l:total data n,:);

z
T =0.08;

% Run through all different models
V = arxstruc(ze,zv,struc(1:10,1:10,1:10));

% Find the best model
nn = selstruc(V,0);

% Time domain plot

th = arx(ze,nn);
th.Ts = 0.08;

u z(:,2);

y z(:,1)+ave;

yp = sim(u, th)+ave;

xlbl = 'Time Steps';

subplot(2,1,1)
index = 1l:trn_data n;
plot(index,

subplot(2,1,2)

index = (trn_data n+1):(total data n);
plot(index,y(index),index,yp(index),"'.")

rmse = norm(y(index)-yp(index))/sqrt(length(index));
title(sprintf(['Checking Data (solid), ARX Prediction (dots)\nRMSE
xlabel(x1bl, 'fontsize',10)

[na nb d] =5 10 2

y(index), index, yp(index),
rmse = norm(y(index)-yp(index))/sqrt(length(index));
title(sprintf(['Training Data (solid), ARX Prediction (dots)\nRMSE
disp(['[na nb d] = ' num2str(nn)])
xlabel(x1lbl, 'fontsize',10)

)

num2str(rmse)]))

num2str(rmse)]))
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ANFIS Model Identification

The ARX model is inherently linear and the most significant advantage is that we can perform model
structure and parameter identification rapidly. The performance in the above plots appears to be
satisfactory. However, if a better performance level is desired, we might want to resort to a nonlinear

model. In particular, we are going to use a neuro-fuzzy modeling approach, ANFIS, to see if we can
push the performance level with a fuzzy inference system.

To use ANFIS for system identification, the first thing we need to do is select the input. That is, to
determine which variables should be the input arguments to an ANFIS model. For simplicity, we
suppose that there are 10 input candidates (y(k-1), y(k-2), y(k-3), y(k-4), u(k-1), u(k-2), u(k-3), u(k-4),
u(k-5), u(k-6)), and the output to be predicted is y(k). A heuristic approach to input selection is called
sequential forward search, in which each input is selected sequentially to optimize the total squared
error. This can be done by the function seqsrch; the result is shown in the above plot, where 3 inputs

(y(k-1), u(k-3), and u(k-4)) are selected with a training RMSE of 0.0609 and checking RMSE of
0.0604.

trn_data n = 300;
trn_data = data(l:trn _data n,:);
chk data = data(trn_data n+l:trn_data n+300,:);

[~,elapsed time] = seqsrch(3,trn _data,chk data,input name); % #ok<*ASGLU>
fprintf('\nElapsed time = %f\n',elapsed time);
winH1l = gcf;

Selecting input 1 ...
ANFIS model 1: y(k-1) --> trn=0.2043, chk=0.1888
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ANFIS model
ANFIS model
ANFIS model
ANFIS model
ANFIS model
ANFIS model
ANFIS model

--> trn=0.3819, chk=0.3541
--> trn=0.5245, chk=0.4903
--> trn=0.6308, chk=0.5977
--> trn=0.8271, chk=0.8434
--> trn=0.7976, chk=0.8087
--> trn=0.7266, chk=0.7349
--> trn=0.6215, chk=0.6346
ANFIS model --> trn=0.5419, chk=0.5650
ANFIS model 10: ) --> trn=0.5304, chk=0.5601
Currently selected inputs: y(k-1)

CcCoCcCcoCcoxk<
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Selecting input 2

ANFIS model 11: y(k-1) y(k-2) --> trn=0.1085, chk=0.
ANFIS model 12: y(k-1) y(k-3) --> trn=0.1339, chk=0.
ANFIS model 13: y(k-1) y(k-4) --> trn=0.1542, chk=0.
ANFIS model 14: y(k-1) u(k-1) --> trn=0.1892, chk=0.
ANFIS model 15: y(k-1) u(k-2) --> trn=0.1663, chk=0.
ANFIS model 16: y(k-1) u(k-3) --> trn=0.1082, chk=0.
ANFIS model 17: y(k-1) u(k-4) --> trn=0.0925, chk=0.
ANFIS model 18: y(k-1) u(k-5) --> trn=0.1533, chk=0.
ANFIS model 19: y(k-1) u(k-6) --> trn=0.1952, chk=0.
Currently selected inputs: y(k-1) u(k-4)

Selecting input 3 ...

ANFIS model 20: y(k-1) u(k-4) y(k-2) --> trn=0.0808,
ANFIS model 21: y(k-1) u(k-4) y(k-3) --> trn=0.0806,
ANFIS model 22: y(k-1) u(k-4) y(k-4) --> trn=0.0817,
ANFIS model 23: y(k-1) u(k-4) u(k-1) --> trn=0.0886,
ANFIS model 24: y(k-1) u(k-4) u(k-2) --> trn=0.0835,
ANFIS model 25: y(k-1) u(k-4) u(k-3) --> trn=0.0609,
ANFIS model 26: y(k-1) u(k-4) u(k-5) --> trn=0.0848,
ANFIS model 27: y(k-1) u(k-4)